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Preface
This guide is your primary source of introductory and reference information for
Oracle9i for Windows for both client and server. Differences between product
versions are noted where appropriate.
This guide describes only the features of Oracle9i for Windows software that apply
to the Windows NT, Windows 2000, Windows XP, and Windows 98 operating
systems. Information on Oracle9i Personal Edition software on Windows 98 is not
covered in this guide.
This preface contains these topics:
■

Audience

■

Organization

■

Related Documentation

■

Conventions

■

Documentation Accessibility
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Audience
Oracle9i Database Getting Started for Windows is intended for:
■

Database administrators

■

Network administrators

■

Security specialists

■

Developers who use the Oracle9i database

To use this document, you need:
■

Oracle-certified Windows operating system software installed and tested

■

Knowledge of object-relational database management concepts

Organization
This document contains:
"What’s New in Oracle9i for Windows"
Oracle9i release 2 (9.2) adds support for very large memory configurations and User
Migration Utility, a new command-line tool. Oracle9i release 1 (9.0.1) added support
for Windows XP Professional Edition, enhanced integration with Windows, and
improvements in Database Configuration Assistant and Oracle Internet Directory
administration. Server Manager and CONNECT INTERNAL were desupported in
Oracle9i release 1 (9.0.1).
Chapter 1, "Introduction"
This chapter explains how different groups of users can use this document together
with Oracle9i Database Administrator’s Guide for Windows and Oracle9i Security and
Network Integration Guide.
Chapter 2, "Oracle9i Windows/UNIX Differences"
This chapter compares features of Oracle9i Database for Windows and UNIX. This
information may be helpful to Oracle developers and database administrators
moving from UNIX to Windows platforms.
Chapter 3, "Using Oracle9i on Windows 2000"
This chapter highlights differences between Windows 2000 and Windows NT, with
emphasis on procedures for common database tasks.

xiv

Chapter 4, "Oracle9i Architecture on Windows"
This chapter describes how Oracle9i architecture takes advantage of some of the
more advanced services in the Windows operating system.
Chapter 5, "Database Tools Overview"
This chapter provides a list of preferred and optional tools you can use to perform
common database administration tasks.
Chapter 6, "Multiple Oracle Homes and Optimal Flexible Architecture"
This chapter describes how to use multiple Oracle homes and an Optimal Flexible
Architecture (OFA) configuration for placement of database files.
Chapter 7, "Oracle9i Services on Windows"
This chapter describes Windows services in general and Oracle9i Database
Windows services in particular.
Chapter 8, "Oracle9i Default Accounts and Passwords"
This chapter describes usernames and passwords included in the starter Oracle9i
Database.
Chapter 9, "Configuration Parameters and the Registry"
This chapter describes the use of the registry for various Oracle components. In
addition, this chapter lists the recommended values and ranges for configuration
parameters.
Chapter 10, "Developing Applications for Windows"
This chapter points to sources of information on developing applications for
Windows and outlines a procedure for building and debugging external
procedures.
Appendix A, "Error Messages"
This appendix lists error messages, causes, and corrective actions that are specific to
the operation of Oracle9i for Windows.
Appendix B, "Getting Started with Your Documentation"
This appendix describes the contents of your Oracle documentation set.
Glossary
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Related Documentation
This guide is part of a set for developers and database administrators using Oracle9i
on Windows. The other guides in the set are:
■

Oracle9i Database Administrator’s Guide for Windows

■

Oracle9i Security and Network Integration Guide

For information on the components available in your Oracle9i installation type, see
your Oracle9i Database Installation Guide for Windows.
For Oracle product information that is applicable to all operating systems, see your
Oracle9i Online Documentation Library CD-ROM for Windows. Many of the
examples in the documentation set use the sample schemas of the seed database,
which is installed by default when you install Oracle. Refer to Oracle9i Sample
Schemas for information on how these schemas were created and how you can use
them yourself.
If you are not familiar with object-relational database management concepts, see
Oracle9i Database Concepts.
In North America, printed documentation is available for sale in the Oracle Store at
http://oraclestore.oracle.com/

Customers in Europe, the Middle East, and Africa (EMEA) can purchase
documentation from
http://www.oraclebookshop.com/

Other customers can contact their Oracle representative to purchase printed
documentation.
To download free release notes, installation documentation, white papers, or other
collateral, please visit the Oracle Technology Network (OTN). You must register
online before using OTN; registration is free and can be done at
http://otn.oracle.com/admin/account/membership.html

If you already have a username and password for OTN, then you can go directly to
the documentation section of the OTN Web site at
http://otn.oracle.com/docs/index.htm

To access the database documentation search engine directly, please visit
http://tahiti.oracle.com
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Conventions
This section describes the conventions used in the text and code examples of this
documentation set. It describes:
■

Conventions in Text

■

Conventions in Code Examples

■

Conventions for Windows Operating Systems

Conventions in Text
We use various conventions in text to help you more quickly identify special terms.
The following table describes those conventions and provides examples of their use.
Convention

Meaning

Bold

Bold typeface indicates terms that are
When you specify this clause, you create an
defined in the text or terms that appear in index-organized table.
a glossary, or both.

Italics

Italic typeface indicates book titles or
emphasis.

Oracle9i Database Concepts

Uppercase monospace typeface indicates
elements supplied by the system. Such
elements include parameters, privileges,
datatypes, RMAN keywords, SQL
keywords, SQL*Plus or utility commands,
packages and methods, as well as
system-supplied column names, database
objects and structures, usernames, and
roles.

You can specify this clause only for a NUMBER
column.

UPPERCASE
monospace
(fixed-width)
font

Example

Ensure that the recovery catalog and target
database do not reside on the same disk.

You can back up the database by using the
BACKUP command.
Query the TABLE_NAME column in the USER_
TABLES data dictionary view.
Use the DBMS_STATS.GENERATE_STATS
procedure.
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Convention

Meaning

Example

lowercase
monospace
(fixed-width)
font

Lowercase monospace typeface indicates
executables, filenames, directory names,
and sample user-supplied elements. Such
elements include computer and database
names, net service names, and connect
identifiers, as well as user-supplied
database objects and structures, column
names, packages and classes, usernames
and roles, program units, and parameter
values.

Enter sqlplus to open SQL*Plus.
The password is specified in the orapwd file.
Back up the datafiles and control files in the
/disk1/oracle/dbs directory.
The department_id, department_name,
and location_id columns are in the
hr.departments table.

Set the QUERY_REWRITE_ENABLED
initialization parameter to true.
Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase.
Connect as oe user.
Enter these elements as shown.
The JRepUtil class implements these
methods.

lowercase
Lowercase italic monospace font
italic
represents placeholders or variables.
monospace
(fixed-width)
font

You can specify the parallel_clause.
Run Uold_release.SQL where old_
release refers to the release you installed
prior to upgrading.

Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line
statements. They are displayed in a monospace (fixed-width) font and separated
from normal text as shown in this example:
SELECT username FROM dba_users WHERE username = ’MIGRATE’;

The following table describes typographic conventions used in code examples and
provides examples of their use.
Convention

Meaning

Example

[ ]

Brackets enclose one or more optional
items. Do not enter the brackets.

DECIMAL (digits [ , precision ])

{ }

Braces enclose two or more items, one of {ENABLE | DISABLE}
which is required. Do not enter the braces.

|

A vertical bar represents a choice of two
{ENABLE | DISABLE}
or more options within brackets or braces. [COMPRESS | NOCOMPRESS]
Enter one of the options. Do not enter the
vertical bar.
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Convention

Meaning

...

Horizontal ellipsis points indicate either:
■

■

.
.
.

That we have omitted parts of the
code that are not directly related to
the example
That you can repeat a portion of the
code

Vertical ellipsis points indicate that we
have omitted several lines of code not
directly related to the example.

Example
CREATE TABLE ... AS subquery;
SELECT col1, col2, ... , coln FROM
employees;

SQL> SELECT NAME FROM V$DATAFILE;
NAME
-----------------------------------/fsl/dbs/tbs_01.dbf
/fs1/dbs/tbs_02.dbf
.
.
.
/fsl/dbs/tbs_09.dbf
9 rows selected.

Other notation

You must enter symbols other than
brackets, braces, vertical bars, and ellipsis
points as shown.

Italics

Italicized text indicates placeholders or
variables for which you must supply
particular values.

CONNECT SYSTEM/system_password
DB_NAME = database_name

UPPERCASE

Uppercase typeface indicates elements
supplied by the system. We show these
terms in uppercase in order to distinguish
them from terms you define. Unless terms
appear in brackets, enter them in the
order and with the spelling shown.
However, because these terms are not
case sensitive, you can enter them in
lowercase.

SELECT last_name, employee_id FROM
employees;
SELECT * FROM USER_TABLES;
DROP TABLE hr.employees;

lowercase

Lowercase typeface indicates
programmatic elements that you supply.
For example, lowercase indicates names
of tables, columns, or files.

SELECT last_name, employee_id FROM
employees;
sqlplus hr/hr
CREATE USER mjones IDENTIFIED BY ty3MU9;

acctbal NUMBER(11,2);
acct
CONSTANT NUMBER(4) := 3;

Note: Some programmatic elements use a
mixture of UPPERCASE and lowercase.
Enter these elements as shown.
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Conventions for Windows Operating Systems
The following table describes conventions for Windows operating systems and
provides examples of their use.
Convention

Meaning

Example

Choose Start >

How to start a program. For example, to
start Database Configuration Assistant,
you must click the Start button on the
taskbar and then choose Programs >
Oracle - HOME_NAME > Configuration
and Migration Tools > Database
Configuration Assistant.

Choose Start > Programs > Oracle - HOME_
NAME > Configuration and Migration Tools >
Database Configuration Assistant

File and Directory File and directory names are not case
c:\winnt"\"system32 is the same as
Names
sensitive. The special characters <, >, :, ", C:\WINNT\SYSTEM32
/, |, and - are not allowed. The special
character \ is treated as an element
separator, even when it appears in quotes.
If the file name begins with \\, Windows
assumes it uses the Universal Naming
Convention.
C:\>

Represents the Windows command
prompt of the current hard disk drive.
The escape character in a command
prompt is "^". Your prompt reflects the
subdirectory in which you are working.
Referred to as the command prompt in
this guide.

Special characters The backslash special character (\) is
sometimes required as an escape
character for the double quote (") special
character at the Windows command
prompt. Parentheses and the single quote
special character (’) do not require an
escape character. See your Windows
operating system documentation for more
information on escape and special
characters.
HOME_NAME

Represents the Oracle home name.
The home name can be up to 16
alphanumeric characters. The only special
character allowed in the home name is the
underscore.
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C:\oracle\oradata>

C:\>exp scott/tiger TABLES=emp
QUERY=\"WHERE job=’SALESMAN’ and
sal<1600\"
C:\>imp SYSTEM/password
FROMUSER=scott TABLES=(emp, dept)

C:\> net start OracleHOME_
NAMETNSListener

Convention

Meaning

Example

ORACLE_HOME
and ORACLE_
BASE

In releases prior to Oracle8i release 8.1.3,
when you installed Oracle components,
all subdirectories were located under a
top level ORACLE_HOME directory that by
default was:

Go to the ORACLE_BASE\ORACLE_
HOME\rdbms\admin directory.

■
■

C:\orant for Windows NT
C:\orawin98 for Windows 98

or whatever you called your Oracle home.
This release complies with Optimal
Flexible Architecture (OFA) guidelines.
All subdirectories are not under a top
level ORACLE_HOME directory. There is a
top level directory called ORACLE_BASE
that by default is C:\oracle. If you
install the latest Oracle release on a
computer with no other Oracle software
installed, then the default setting for the
first Oracle home directory is
C:\oracle\orann where nn is the latest
release number. The Oracle home
directory is located directly under
ORACLE_BASE.
All directory path examples in this guide
follow OFA conventions.
See Chapter 6, "Multiple Oracle Homes
and Optimal Flexible Architecture" for
additional information on OFA
compliance and for information on
installing Oracle products in non-OFA
compliant directories.
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Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.
Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.
Accessibility of Links to External Web Sites in Documentation This
documentation may contain links to Web sites of other companies or organizations
that Oracle Corporation does not own or control. Oracle Corporation neither
evaluates nor makes any representations regarding the accessibility of these Web
sites.

xxii

What’s New in Oracle9i for Windows
This section describes new features of Oracle9i release 2 (9.2) and provides pointers
to additional information. New features information from the previous release is
also retained to help those users migrating to the current release.
The following sections describe new features:
■

Oracle9i Release 2 (9.2) New Features

■

Oracle9i Release 1 (9.0.1) New Features

Oracle9i Release 2 (9.2) New Features
This section contains these topics:
■

Very Large Memory Support

■

User Migration Utility

Very Large Memory Support
Oracle9i release 2 (9.2) for Windows supports Very Large Memory (VLM)
configurations in Windows 2000 and Windows XP, which allows Oracle9i release 2
(9.2) to access more than the 4 gigabyte (GB) of RAM traditionally available to
Windows applications. For more information, see "Oracle9i Scalability on Windows"
on page 4-6.

User Migration Utility
A new command-line tool, User Migration Utility, simplifies conversion of local or
external database users to enterprise users. For more information, see:
■

Chapter 5, "Database Tools Overview"
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■

■

"Manually Migrating Users" in Oracle9i Security and Network Integration Guide for
Windows
"Migrating Local or External Users to Enterprise Users" in Oracle Advanced
Security Administrator’s Guide

Oracle9i Release 1 (9.0.1) New Features
This section contains these topics:
■

Windows XP Support

■

Windows Integration

■

Database Configuration Assistant Improvements

■

Oracle Internet Directory Administration Improvements

■

Using Oracle9i on Windows 2000

■

CONNECT INTERNAL Not Supported

■

Server Manager Not Supported

Windows XP Support
Oracle9i release 1 (9.0.1.1.1) for Windows is certified on the 32-bit version of
Windows XP Professional Edition.
Oracle Corporation provides support information for components on various
platforms, lists compatible client and database versions, and identifies patches and
workaround information. Find the latest certification information at:
http://metalink.oracle.com/

You must register online before using OracleMetaLink. After logging into
OracleMetaLink, select Product Lifecycle from the left-hand column.

Windows Integration
Oracle9i supports enhanced integration with Microsoft Transaction Services and
Internet Information Services. Public key infrastructure and Single Sign-On
capabilities in Oracle9i have also been integrated with Windows 2000, Active
Directory, and Microsoft Certificate Store.
Oracle9i integration with Windows security supports Oracle Wallets in the registry
and Active Directory, and it allows Oracle products to use Microsoft Certificate
Store.
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Synchronization between Active Directory and Oracle Internet Directory facilitates
centralized scheduling and configuration of Oracle and third party meta-directory
components.

Database Configuration Assistant Improvements
Database Configuration Assistant has been redesigned to include database
definitions saved as templates. The templates can generate databases. Users can
define new templates, modify existing templates, or use the ones Oracle provides.
When creating a database with Database Configuration Assistant, users can include
Oracle’s new Sample Schemas.

Oracle Internet Directory Administration Improvements
Administration of Oracle Internet Directory replication server has been improved
with the addition of new replication queue management and reconciliation tools.

Using Oracle9i on Windows 2000
There are some differences between using Oracle9i on Windows 2000 and Windows
NT 4.0. For more information, see Chapter 3, "Using Oracle9i on Windows 2000".

CONNECT INTERNAL Not Supported
CONNECT INTERNAL and CONNECT INTERNAL/PASSWORD are not supported in
Oracle9i. Use the following instead:
CONNECT / AS SYSDBA
CONNECT username/password AS SYSDBA

Server Manager Not Supported
Server Manager is not supported in Oracle9i. Use SQL*Plus instead. Most Server
Manager scripts should work in a SQL*Plus environment, but some scripts may
need to be modified.

xxv
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Introduction
This chapter briefly describes the Oracle9i for Windows documentation set and
shows how the three guides in the set relate to common database administration
tasks.
This chapter contains these topics:
■

Document Plan

■

Task Mapping

Introduction 1-1

Document Plan

Document Plan
Documentation for Oracle9i for Windows is divided into three parts. This guide
contains information with the widest possible relevance. Whatever your database
management role, you will probably find something of interest here. The other two
guides concentrate on tasks usually associated with the different realms of
management required by a large database with many users. The three guides are
titled:
■

Oracle9i Database Getting Started for Windows

■

Oracle9i Database Administrator’s Guide for Windows

■

Oracle9i Security and Network Integration Guide for Windows

Task Mapping
We recognize that this division cannot be perfect for everyone. What one
organization calls database administration, another will call a network problem;
and only parts of this guide or its companions are relevant to particular tasks. So in
this first chapter we provide a table that maps specific tasks to specific chapters and
appendixes in the three guides.
Table 1–1 lists common database tasks, grouped into three categories:
■

Database Administration

■

Network and Security

■

Application Development

For each task, the columns labeled Getting Started, Administrator, and
Network/Security show chapters and appendixes in each of the three guides which
contain information relevant to that task.
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Table 1–1

Where to Find Task Information

Task Category

Getting Started

Administrator

Network/Security

Back Up and Recover

2, 4, 5, 9

6

-

Create or Delete Database

3, 5

1

-

Create Objects

5

-

-

Export, Import, or Load Data

5

1

-

Find Files (Directory Structure)

2, 4, 5, 6, 9

1, 2

-

Install or Configure

2, 5, 6, 9

1, 2, 5, 7

1, 2

Manage Processes

2, 3, 4, 5, 6, 7, 9, A

4

-

Manage Resources

2, 3, 5, 6, A

3, 5, 7, A

-

Manage Services

2, 5, 6, 7, A

1, 3, 5

-

Migrate or Upgrade

5, 6

-

-

Monitor Performance

2, 3, 4, 5, 7, 9, A

4, 5

-

Startup or Shutdown

2, 5, 9, A

1, 3

-

Accounts and Groups

2, 3, 5, 9

-

1, 2, 3

Authenticate Users

2, 4, 5, 9

-

1, 2, 3, 4

Connectivity Information

3, 4, 5, 6, 7, 9, 10, A

3, 5

1, 2, A

Create Users

2, 3, 5

-

1, 2, 3

Application Programmatic Interfaces

4, 5, 10

-

-

External Procedures

10

-

-

Microsoft Transaction Server

2, 4, 10

-

-

Oracle Real Application Clusters

2, 7, 9

A

-

Database Administration

Network and Security

Application Development

Introduction 1-3

Task Mapping

1-4

Oracle9i Database Getting Started

2
Oracle9i Windows/UNIX Differences
This chapter lists major differences between Oracle9i on Windows and UNIX. For
Oracle developers and database administrators moving from a UNIX platform to
Windows, this information can be helpful in understanding Windows features that
are relevant to Oracle9i.
This chapter contains these topics:
■

Automatic Startup and Shutdown

■

Background Processing and Batch Jobs

■

Diagnostic and Tuning Utilities

■

Direct Writes to Disk

■

Dynamic Link Libraries (DLLs)

■

Hot Backups

■

Initialization Parameters: Multiple Database Writers

■

Install Accounts and Groups

■

Installation

■

Memory Resources

■

Microsoft Transaction Server

■

Multiple Oracle Homes and OFA

■

Processes and Threads

■

Raw Partitions

■

Services
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Automatic Startup and Shutdown

Automatic Startup and Shutdown
On UNIX, several files and scripts in different directories are used to start an
instance automatically. Other scripts are run on computer shutdown, allowing
applications such as Oracle to shut down cleanly.
For automatic startup on Windows, set registry parameter ORA_SID_AUTOSTART
to true using an Oracle tool such as ORADIM. Enter the following with
parameters at the command prompt:
C:\> oradim parameters

To start the listener automatically, set services startup type to automatic.
For automatic shutdown on Windows, set registry parameters ORA_SHUTDOWN and
ORA_SID_SHUTDOWN to stop the relevant OracleServiceSID and shut down. Set
registry parameter ORA_SID_SHUTDOWNTYPE to control shutdown mode (default is
i, or immediate).
See Also:
■

■

Oracle9i Database Administrator’s Guide
"Administering a Database" in Oracle9i Database Administrator’s
Guide for Windows

Background Processing and Batch Jobs
UNIX provides sophisticated control mechanisms for background processing and
batch jobs.
For similar functionality on Windows, use the AT command or a GUI version in the
Microsoft Resource Kit.

Diagnostic and Tuning Utilities
On UNIX, utilities such as sar and vmstat are used to monitor Oracle background
and shadow processes. These utilities are not integrated with Oracle.
Performance utilities available on Windows include Oracle Performance Monitor,
Task Manager, Control Panel, Event Viewer, User Manager, and Microsoft
Management Console (included only with Windows 2000).
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Dynamic Link Libraries (DLLs)

Oracle is integrated with several of these tools. For example:
■

■

■

Oracle Performance Monitor displays key Oracle database information. This
tool is the same in appearance and operation as Windows Performance Monitor,
except it has been preloaded with Oracle9i database performance elements.
Event Viewer displays system alert messages, including Oracle
startup/shutdown messages and audit trail.
Task Manager on Windows displays currently running processes and their
resource usage, similar to the UNIX ps -ef command or OpenVMS SHOW
SYSTEM. But Task Manager is easier to interpret and the columns can be
customized.
See Also:
■

■

Chapter 5, "Database Tools Overview"
"Monitoring a Database" in Oracle9i Database Administrator’s
Guide for Windows

Direct Writes to Disk
On both UNIX and Windows platforms, bypassing the file system buffer cache
ensures data is written to disk.
On UNIX, Oracle uses the O_SYNC flag to bypass the file system buffer cache. The
flag name depends on the UNIX port.
On Windows, Oracle bypasses the file system buffer cache completely.
See Also:

Oracle9i Database Concepts

Dynamic Link Libraries (DLLs)
Shared libraries on UNIX are similar to shared DLLs on Windows. Object files and
archive libraries are linked to generate Oracle executables. Relinking is necessary
after certain operations, such as installation of a patch.
On Windows, Oracle DLLs form part of the executable at run time and are therefore
smaller. DLLs can be shared between multiple executables. Relinking by the user is
not supported, but executable images can be modified using ORASTACK utility.
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Hot Backups

Modifying executable images on Windows reduces the chances of running out of
virtual memory when using a large SGA or when supporting thousands of
connections. However, Oracle Corporation recommends doing this only under the
guidance of Oracle Support Services.
See Also:

Oracle9i Database Concepts

Hot Backups
A (manual) hot backup is equivalent to backing up a tablespace that is in offline
backup mode.
Backup strategy on UNIX is as follows: put the tablespace into backup mode, copy
the files to the backup location, and bring the tablespace out of backup mode.
Windows supports the same backup strategy, but you cannot copy files in use with
normal Windows utilities. Use Oracle utility OCOPY to copy open database files to
another disk location. Then use a utility to copy the files to tape.
See Also:
■

Oracle9i Database Administrator’s Guide for Windows

■

Oracle9i Backup and Recovery Concepts

Initialization Parameters: Multiple Database Writers
On UNIX, you can specify more than one database writer process with initialization
parameter DB_WRITERS. Multiple database writers can help, for example, when a
UNIX port does not support asynchronous I/O.
DB_WRITERS is supported but typically unnecessary on Windows, which has its
own asynchronous I/O capabilities.
See Also: "Oracle9i Database Specifications for Windows" in
Oracle9i Database Administrator’s Guide for Windows
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Install Accounts and Groups
UNIX uses the concept of a DBA group. The root account cannot be used to install
Oracle. A separate Oracle account must be created manually.
On Windows, Oracle must be installed by a Windows username in the
Administrators group. The username is automatically added to the Windows local
group ORA_DBA, which receives the SYSDBA privilege. This allows the user to log
in to the database using CONNECT / AS SYSDBA and not be prompted for a
password.
Password files are located in the ORACLE_BASE\ORACLE_HOME\database
directory and are named pwdSID.ora, where SID identifies the Oracle9i database
instance.
See Also: "Administering a Database" in Oracle9i Database
Administrator’s Guide for Windows

Installation
The following manual setup tasks, all required on UNIX, are not required on
Windows:
■

Set environment variables

■

Create a DBA group for database administrators

■

Create a group for users running Oracle Universal Installer

■

Create an account dedicated to installing and upgrading Oracle components
See Also:

Oracle9i Database Installation Guide for Windows

Memory Resources
The resources provided by the UNIX default kernels are often inadequate for a
medium or large Oracle database. The maximum size of a shared memory segment
(SHMMAX) and maximum number of semaphores available (SEMMNS) may be too
low for Oracle recommendations.
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Microsoft Transaction Server

On Windows, fewer resources are needed for interprocess communication (IPC),
because the Oracle relational database management system is thread-based and not
process-based. These resources, including shared memory and semaphores, are not
adjustable by the user.
See Also:

Oracle9i Database Concepts

Microsoft Transaction Server
UNIX does not support Microsoft Transaction Server.
Windows supports Microsoft Transaction Server beginning with Oracle version 8.
Using ORACLEMTSRecoveryService, you can develop and deploy applications
based on COM/COM+. Microsoft Transaction Server coordinates application
transactions for an Oracle database.
See Also: Oracle Services for Microsoft Transaction Server Developer’s
Guide

Multiple Oracle Homes and OFA
The goal of OFA is to place all Oracle software under one ORACLE_BASE directory
and to spread database files across different physical drives as databases increase in
size. OFA is implemented on Windows NT and UNIX in the same way, and main
subdirectory and filenames are the same on both operating systems. Windows NT
and Unix differ, however, in their OFA directory tree top-level names and in the
way variables are set.
On UNIX, ORACLE_BASE is associated with a user’s environment. ORACLE_HOME
and ORACLE_SID must be set in system or user login scripts. Symbolic links are
supported. Although everything seems to be in one directory on the same hard
drive, files may be on different hard drives if they are symbolically linked or have
that directory as a mount point.
On Windows, ORACLE_BASE is defined in the registry (for example, in HKEY_
LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0). ORACLE_HOME and ORACLE_SID
are variables defined in the registry. Symbolic links like those on UNIX are not
supported, although Microsoft has announced the intention to support them in a
future release.
See Also: Chapter 6, "Multiple Oracle Homes and Optimal
Flexible Architecture"

2-6

Oracle9i Database Getting Started

Raw Partitions

Processes and Threads
On UNIX, Oracle uses a process to implement each of such background tasks as
database writer (DBW0), log writer (LGWR), shared server process dispatchers, and
shared servers. Each dedicated connection made to the database causes another
operating system process to be spawned on behalf of that session.
On Windows, each background process is implemented as a thread inside a single,
large process. For each Oracle database instance or system identifier, there is one
corresponding process for Oracle9i database. For example, 100 Oracle processes for
a database instance on UNIX are handled by 100 threads inside one process on
Windows.
All Oracle background, dedicated server, and client processes are threads of the
master ORACLE Windows process, and all threads of the ORACLE process share
resources. This multithreaded architecture is highly efficient, allowing fast context
switches with low overhead.
To view processes or end individual threads, use Oracle Administration Assistant
for Windows NT. Choose Start > Programs > Oracle - HOME_NAME >
Configuration and Migration Tools > Administration Assistant for Windows.
Right-click the SID and choose Process Information.
Note: Microsoft Management Console (MMC) is started when
Oracle Administration Assistant for Windows NT is started on
Windows NT 4.0. Oracle Corporation has integrated several
database administration snap-ins into MMC.

See Also:
■

Oracle Administration Assistant for Windows NT online help

■

Chapter 4, "Oracle9i Architecture on Windows"

Raw Partitions
Datafiles for tablespaces may be stored on a file system or on raw partitions. A raw
partition is a portion of a physical disk that is accessed at the lowest possible level.
UNIX supports raw partitions (logical drives). There is no limitation on the number
of disk drives.
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Services

Windows is limited to using drive letters A-Z, but creating raw partitions lets you
bypass the disk drive limitation and divide disks into smaller sections.
Use Windows NT Disk Administrator to create an extended partition on a physical
drive. An extended partition points to raw space on the disk that can be assigned
multiple logical partitions for database files.
An extended partition avoids the four-partition limit on Windows by allowing you
to define large numbers of logical partitions to accommodate applications using
Oracle9i database. Logical partitions can then be given symbolic link names to free
up drive letters.
Note: Raw partitions are necessary for shared datafiles in an
Oracle Real Application Clusters environment, available on
Windows. Oracle Real Application Clusters, in which Oracle
instances run on all nodes simultaneously, provides clustering and
high availability. Oracle Real Application Clusters is not supported
on Windows XP.

See Also: Chapter 3, "Using Oracle9i on Windows 2000"

Services
Windows services are similar to UNIX daemons.
Oracle registers a database instance as a service (OracleServiceSID). Services
start background processes.
To connect to and use an Oracle instance, an Oracle service is created during
database creation and associated with the Oracle database. Once a service is created
with the Oracle database, the service can run even while no user is logged on.
By default, services run under the SYSTEM account. Choose Start > Settings >
Control Panel > Services to access the Services dialog box.
See Also: "Administering a Database" in Oracle9i Database
Administrator’s Guide for Windows
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Using Oracle9i on Windows 2000
This chapter highlights differences between Windows 2000 and Windows NT, with
emphasis on procedures for common database tasks.
This chapter contains these topics:
■

How to Perform Common Tasks in Windows NT and Windows 2000

■

Other Differences Between Windows NT and Windows 2000

Using Oracle9i on Windows 2000
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How to Perform Common Tasks in Windows NT and Windows 2000
Table 3–1 lists common database administration tasks and tools required to
accomplish those tasks in Windows NT and Windows 2000.
Table 3–1

How to Perform Common Tasks in Windows NT and Windows 2000

Task

Windows NT

Windows 2000

Install a domain controller

Windows setup

Active Directory installation wizard from
Configure Your Server

Manage user accounts

User Manager

Active Directory Users & Computers

Choose Start > Programs >
Administrative Tools > User
Manager

Choose Programs > Administrative Tools >
Active Directory

Manage groups

User Manager

Active Directory Users & Computers

Manage computer accounts

Server Manager

Active Directory Users & Computers

Choose Start > Programs >
Administrative Tools > Server
Manager
Add a computer to a
domain

Server Manager

Active Directory Users & Computers

Create or manage trust
relationships

User Manager

Active Directory Domains & Trusts

Manage account policy

User Manager

Active Directory Users & Computers

Manage user rights

User Manager

Active Directory Users & Computers: Edit the
Group Policy object for the domain or
organizational unit containing the computers to
which the users rights apply.

Manage audit policy

User Manager

Active Directory Users & Computers: Edit the
Group Policy object assigned to the Domain
Controllers organizational unit.

Set policies on users and
computers in a site

System Policy Editor

Group Policy, accessed through Active
Directory Sites & Services

Set policies on users and
computers in a domain

System Policy Editor
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Choose Start > Programs >
Administrative Tools > System
Policy Editor
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Group Policy, accessed through Active
Directory Users & Computers

Other Differences Between Windows NT and Windows 2000

Table 3–1 (Cont.) How to Perform Common Tasks in Windows NT and Windows 2000
Task

Windows NT

Windows 2000

Set policies on users and
computers in an
organizational unit

Not applicable

Group Policy, accessed through Active
Directory Users & Computers

Use Security Groups to filter Not applicable
the scope of policy

Edit the permissions entry for Apply Group
Policy on the security tab of the Group Policy
Object properties sheet

Start Oracle Performance
Monitor for Windows NT

Choose Start > Programs >
Configuration and Migration
Tools > Oracle for Windows
NT Performance Monitor

Choose Start > Programs > Configuration and
Migration Tools > Oracle for Windows NT
Performance Monitor

Access services dialog box

Choose Start > Settings >
Control Panel > Services

Choose Start > Settings > Control Panel >
Administrative Tools > Services

Other Differences Between Windows NT and Windows 2000
This section discusses differences between Windows NT and Windows 2000 that are
not related to common tasks.

DNS Domain Name
If a Windows 2000 computer is not identified with a DNS domain name, then you
will receive the following error message:
Calling query w32RegQueries1.7.0.17.0 RegGetValue
Key = HKEY_LOCAL_MACHINE
SubKey = SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
Value = Domain
Query Exception: GetValueKeyNotFoundException
Query Exception Class: class oracle.sysman.oii.oiil.OiilQueryException
...

Perform the following steps:
1.

Choose Start > Control Panel > System > Network Identification > More >
Primary DNS.

2.

Enter a domain name, for example, us.oracle.com.

Using Oracle9i on Windows 2000
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Microsoft Management Console
Microsoft Management Console, available in Windows NT as a separate item from
Microsoft, is included in Windows 2000.

Enterprise User Authentication
In Windows 2000, enterprise user authentication is enabled by setting registry
parameter OSAUTH_X509_NAME to true on the computer on which Oracle9i
database is running in a Windows 2000 domain. If this parameter is set to false
(the default setting) in a Windows 2000 domain, then Oracle9i database can
authenticate the user as an external user (described in Oracle9i Security and Network
Integration Guide for Windows).
Setting this parameter to true in a Windows NT 4.0 domain does not enable you to
use enterprise users.

Raw Partitions
In Windows NT, use Disk Administrator to create raw partitions required for
Oracle Real Application Clusters.
In Windows 2000, use Computer Management to create basic disks (compatible
with raw partitions on Windows NT). Choose Start > Programs > Administrative
Tools > Computer Management.

Services Autostart
Oracle services autostart on Windows NT 4.0. After upgrading to Windows 2000,
you may find that services start but the database does not start.
The solution is to use ORADIM utility to delete and re-create the services.
To delete an instance using ORADIM, enter:
ORADIM -DELETE -SID SIDA, SIDB, SIDC, ...
ORADIM -DELETE -SVRC SVRCA, SVRCB, SVRC, ...

where:
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■

SIDA, SIDB, SIDC are values of the SIDs to delete.

■

SVRCA, SVRCB, SVRC are values of the services to delete.

Oracle9i Database Getting Started

Other Differences Between Windows NT and Windows 2000

During upgrading, the disk is converted to NTFS 5, and a different access
authorization is used. The new services autostart under the same account, but they
no longer hold the same Windows permissions as before.

Using Oracle9i on Windows 2000
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Oracle9i Architecture on Windows
This chapter describes how Oracle9i architecture takes advantage of some of the
more advanced services in the Windows operating system.
This chapter contains these topics:
■

Oracle9i on Windows Architecture

■

Oracle9i Scalability on Windows

■

Oracle9i Integration with Windows

■

Other Sources of Information
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Oracle9i on Windows Architecture
Oracle9i on Windows is a stable, reliable, and high performing system upon which
to build applications. Each release of the database provides new platform-specific
features for high performance on Windows.
Oracle9i operates the same way on Windows as it does on other platforms. The
architecture offers several advantages on Windows, such as:
■

Thread-Based Architecture

■

File I/O Enhancements

■

Raw File Support

Thread-Based Architecture
The internal process architecture of Oracle9i database is thread-based. Threads are
objects within a process that run program instructions. Threads allow concurrent
operations within a process so that a process can run different parts of its program
simultaneously on different processors. A thread-based architecture provides the
following advantages:
■

■

■

■

Faster context switching
Simpler System Global Area allocation routine, because it does not require use
of shared memory
Faster spawning of new connections, because threads are created more quickly
than processes
Decreased memory usage, because threads share more data structures than
processes

Internally, the code to implement the thread model is compact and separate from
the main body of Oracle code. Exception handlers and routines track and
de-allocate resources. They add robustness, with no downtime because of resource
leaks or an ill-behaved program.
Oracle9i database is not a typical Windows process. On Windows, an Oracle
instance (threads and memory structures) is a Windows service: a background
process registered with the operating system. The service is started by Windows
and requires no user interaction to start. This enables the database to open
automatically at startup.
When running multiple Oracle instances on Windows, each instance runs its own
Windows service with multiple component threads. Each thread may be required
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for the database to be available, or it may be optional and specific to certain
platforms. Examples of optional and required threads on Windows are listed in
Table 4–1.
Table 4–1

Required and Optional Oracle Threads

Oracle Thread

Description

Required/Optional

DBW0

database writer

Required

LGWR

log writer

Required

PMON

process monitor

Required

SMON

system monitor

Required

CKPT

checkpoint process (or thread on Windows) that
runs by default on Windows

Optional

ARCH0

archive process (or thread on Windows)

Optional

RECO

distributed recovery background process

Optional

Note: You can view running background processes by issuing the
following query:
SQL> select * from v$bgprocess where paddr <> ’00’ ;

Oracle9i Architecture on Windows 4-3

Oracle9i on Windows Architecture

Figure 4–1 Oracle architecture on Windows. The background processes read and
write from the various datafiles, depending on your configuration.
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Oracle9i for Windows is supplied as a set of executables and dynamic link libraries
(DLLs). Executable images can be modified using ORASTACK utility to change the
size of the stack used by the threads of the Oracle process. (Oracle Corporation
recommends you use this tool only under the guidance of Oracle Support Services.)

File I/O Enhancements
Oracle9i database supports 64-bit file I/O to allow use of files larger than 4
gigabytes (GB) in size. In addition, physical and logical raw files are supported as
data, log, and control files to support Oracle Real Application Clusters on Windows
and for those cases where performance needs to be maximized.
All Oracle9i file I/O routines support 64-bit file offsets, meaning there are no 2 GB
or 4 GB file size limitations when it comes to data, log, or control files, as there are
on some other platforms. In fact, the limitations that are in place are generic Oracle
limitations across all platforms. These limits include 4 million database blocks for
each file, 16KB maximum block size, and 64K files for each database. If these values
are multiplied, then maximum file size for a database file on Windows is 64 GB, and
maximum total database size supported (with 16KB database blocks) is 4 petabytes.

Raw File Support
Windows supports raw files, similar to UNIX. Using raw files for database or log
files can have a slight performance gain. Raw files are unformatted disk partitions
that can be used as one large file. Raw files have the benefit of no file system
overhead, because they are unformatted partitions. However, standard Windows
commands do not support manipulating or backing up raw files. As a result, raw
files are generally used only by very high-end installations and by Oracle Real
Application Clusters, where they are required.
To Oracle9i, raw files are no different from other Oracle9i database files. They are
treated in the same way by Oracle as any other file and can be backed up and
restored through Recovery Manager or OCOPY.
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Oracle9i Scalability on Windows
New features in Oracle9i and in the Windows operating system work together to
help increase scalability, throughput, and database capacity. These features include:
■

Support for Very Large Memory (VLM) Configurations

■

4 GB RAM Tuning (4GT)

■

Large User Populations

Support for Very Large Memory (VLM) Configurations
Oracle9i release 2 (9.2) for Windows supports Very Large Memory (VLM)
configurations in Windows 2000 and Windows XP, which allows Oracle9i release 2
(9.2) to access more than the 4 gigabyte (GB) of RAM traditionally available to
Windows applications.
Note: This feature is not supported on Windows NT, and it is
available on Windows 2000 and Windows XP only with Intel
Pentium II and Pentium III Xeon 32-bit processors.

Specifically, Oracle9i release 2 (9.2) uses Address Windowing Extensions (AWE)
built into Windows 2000 and Windows XP to access more than 4 GB of RAM.
The requirements for taking advantage of this support are:
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1.

More than 4 GB of RAM must be present in the server on which Oracle9i release
2 (9.2) will run.

2.

The user account under which Oracle9i release 2 (9.2) runs (typically the local
SYSTEM account), must have the "Lock memory pages" Windows 2000 and
Windows XP privilege.

3.

USE_INDIRECT_DATA_BUFFERS=TRUE must be present in the initialization
parameter file for the database instance that will use VLM support. If this
parameter is not set, then Oracle9i release 2 (9.2) behaves in exactly the same
way as previous releases.

4.

Initialization parameters DB_BLOCK_BUFFERS and DB_BLOCK_SIZE must be
set to values you have chosen for Oracle9i database.
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Note: The total number of bytes of database buffers (that is, DB_
BLOCK_BUFFERS multiplied by DB_BLOCK_SIZE) is no longer
limited to 3 GB.
5.

Registry parameter AWE_WINDOW_MEMORY must be created and set in the
appropriate key for your Oracle home. This parameter is specified in bytes and
has a default value of 1 GB. AWE_WINDOW_MEMORY tells Oracle9i release 2 (9.2)
how much of its 3 GB address space to reserve for mapping in database buffers.
This memory comes from the 3 GB virtual address space in Oracle9i release 2
(9.2), so its value must be less than 3 GB. Setting this parameter to a large value
has the effect of using more of the address space for buffers and using less AWE
memory for buffers. However, since accessing AWE buffers is somewhat slower
than accessing virtual address space buffers, Oracle recommends that you tune
these parameters to be as large as possible without adversely limiting database
operations.
In general, the higher AWE_WINDOW_MEMORY is set, the fewer connections and
memory allocations will be possible for Oracle9i release 2 (9.2). The lower AWE_
WINDOW_MEMORY is set, the lower the performance.

6.

Once this parameter is set, Oracle9i release 2 (9.2) database can be started and
will function exactly the same as before except that more database buffers are
available to the instance. In addition, disk I/O may be reduced because more
Oracle data blocks can be cached in the SGA.
Note: Registry parameter VLM_BUFFER_MEMORY, which enabled
VLM configurations in Windows NT in Oracle8i release 2 (8.1.6), is
not supported in Oracle9i release 2 (9.2).

VLM Instance Tuning
VLM configurations improve database performance by caching more database
buffers in memory. This reduces disk I/O compared to configurations without
VLM. VLM support in Oracle9i release 2 (9.2) has been re-written to integrate very
closely with Oracle9i database. Compared to Oracle8i release 2 (8.1.6), VLM users
should see better performance with the newer implementation.
Tuning for VLM is no different than tuning for configurations without VLM. It is an
iterative task that begins by selecting appropriate DB_BLOCK_SIZE and DB_
BLOCK_BUFFER initialization parameters for the application being supported.
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Note: Oracle9i release 2 (9.2) VLM configurations do not support
multiple database block sizes.

AWE_WINDOW_MEMORY, a new registry parameter specific to VLM, defaults to a
value of 1 GB, which should be suitable for most installations. This parameter tells
Oracle9i database how much of its address space to reserve for mapping in database
buffers. Increasing this value will improve performance, but it will also limit the
amount of memory available for other Oracle threads (like foreground threads).
Clients may see "out of memory" errors if this value is set too large.
Having a large cache in a VLM configuration may also slow down database writer
(DBWR) threads. Having more DBWR threads will distribute work required to identify
and write buffers to disk and will distribute I/O loads among threads. Initialization
parameter DB_WRITER_PROCESSES enables you to configure multiple database
writer threads.
A large cache can also introduce contention on the LRU (least recently used) latch.
On symmetric multiprocessor (SMP) systems, Oracle9i sets the number of LRU
latches to a value equal to one half the number of processors on the system. You can
reduce contention on such configurations by increasing the number of LRU latches
to twice (or four times) the number of processors on the system.
See Also: Oracle9i Database Performance Tuning Guide and Reference
for more information on instance tuning

4 GB RAM Tuning (4GT)
Windows NT Server Enterprise and Datacenter Editions (version 4.0) include a
feature called 4 GB RAM Tuning (4GT). This feature allows memory-intensive
applications running on Oracle9i Enterprise Edition to access up to 3 GB of memory,
as opposed to the standard 2 GB in previous operating system versions. 4GT
provides a tremendous benefit: 50 percent more memory is available for database
use, increasing SGA sizes or connection counts. 4GT is also supported on Windows
2000 Advanced Server and Windows 2000 Datacenter Server.
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Large User Populations
New features allow Oracle9i to support an increasingly large number of database
connections on Windows NT and Windows 2000:
■

■

■

Oracle Shared Server Process, which limits the number of threads needed in
the Oracle database process, supports over 10,000 simultaneous connections to
a single database instance.
Oracle Net multiplexing and connection pooling features allow a large
configuration to connect more users to a single database instance.
Oracle Real Application Clusters raises connection counts dramatically by
allowing multiple server computers to access the same database files, increasing
the number of user connections by tens of thousands, as well as increasing
throughput.
Note: Oracle Real Application Clusters is not supported on
Windows XP.

Oracle9i Integration with Windows
Oracle is increasingly integrated with Windows, easing maintenance and improving
enterprise-level deployment in security, directory, and transaction services.
Integration features in Oracle9i include:
■

Oracle PKI Integration

■

Active Directory

■

ORACLEMTSRecoveryService

■

Oracle Fail Safe

■

Oracle Real Application Clusters Guard
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Oracle PKI Integration
Oracle Advanced Security includes Oracle PKI (public key infrastructure)
integration for authentication and single sign-on. You can integrate Oracle-based
applications with the PKI authentication and encryption framework, using the
following tools:
■

■

Oracle Wallet Manager creates an encrypted Oracle Wallet, used for digital
certificates.
Oracle Enterprise Login Assistant creates the obfuscated decrypted Oracle
Wallet, used by Oracle applications for Secure Sockets Layer (SSL) encryption.
The Oracle Wallet is then stored on the file system or Oracle Internet Directory.

Active Directory
Oracle customers with large user populations often require enterprise-level security
and schemas management. Oracle security and administration are integrated with
Windows 2000 through Active Directory, Microsoft’s directory service.
Oracle9i provides native authentication and single sign-on through Windows 2000
authentication mechanisms. Native authentication uses Kerberos security protocols
on Windows 2000 and allows the operating system to perform user identification
for Oracle databases. With native authentication enabled, users can access Oracle
applications simply by logging into Windows. Single sign-on eliminates need for
multiple security credentials and simplifies administration.
Oracle native authentication also supports Oracle9i enterprise users and roles.
Traditionally, administrators must create a database user on every database for each
Windows user. This often equates to thousands of different database users. Oracle
enterprise user mappings allow many Windows users to access a database as a
single global database user. These enterprise user mappings are stored in Active
Directory. For example, entire organizational units in Active Directory can be
mapped to one database user.
Oracle also stores enterprise role mappings in Active Directory. With such roles, a
database privilege can be managed at the domain level through directories. This is
accomplished by assigning Windows 2000 users and groups to Oracle enterprise
roles registered in Active Directory. Enterprise users and roles reduce
administrative overhead while increasing scalability of database solutions.
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Oracle Net Naming with Active Directory
Oracle also uses Active Directory to improve management of database connectivity
information. Traditionally, users reference databases with Oracle Net-style names
resolved through the tnsnames.ora configuration file. This file has to be
administered on each client computer.
Oracle Net Naming with Active Directory stores and resolves names through Active
Directory. By centralizing such information in a directory, Oracle Net Naming with
Active Directory eliminates administrative overhead and relieves users from
configuring their individual client computers.
Various tools in Windows 2000, such as Windows Explorer and Active Directory
Users and Computers, have been enhanced. Users can now connect to databases
and test database connectivity from these tools.
Oracle tools have also been enhanced. Database Configuration Assistant
automatically registers database objects with Active Directory. Oracle Net Manager,
meanwhile, registers net service objects with the directory. These enhancements
further simplify administration.

ORACLEMTSRecoveryService
Microsoft Transaction Server is used in the middle tier as an application server for
COM/COM+ objects and transactions in distributed environments.
ORACLEMTSRecoveryService allows Oracle9i databases to be used as resource
managers in Microsoft Transaction Server-coordinated transactions, providing
strong integration between Oracle solutions and Microsoft Transaction Server.
ORACLEMTSRecoveryService can operate with Oracle9i databases running on any
operating system.
Oracle takes advantage of a native implementation and also stores recovery
information in Oracle9i database itself. ORACLEMTSRecoveryService allows
development in all industry-wide data access interfaces, including Oracle Objects
for OLE (OO4O), Oracle Call Interface (OCI), ActiveX Data Objects (ADO), OLE
DB, and Open Database Connectivity (ODBC). The Oracle APIs, OO4O and OCI,
offer greatest efficiency.
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Oracle Fail Safe
Oracle Fail Safe ensures that Oracle databases (and also other Oracle and
third-party applications) can be configured and managed for high availability on
Windows clusters. An instance runs on only one node at a time.
A cluster is a group of independent computing systems that operates as a single
virtual system, eliminating individual host systems as points of failure. Oracle Fail
Safe works with Microsoft Cluster Server (included with Oracle9i Enterprise
Edition) to ensure that if a failure occurs on one cluster system, then workloads
running on that system fail over quickly and automatically to a surviving system.
Oracle9i combined with Oracle Fail Safe on a Windows cluster ensures protection
from both hardware and software failures.
For well-configured solutions, Oracle Fail Safe ensures a surviving system to be
operational in less than a minute, even for heavily-used databases.
Note: Windows XP does not support the clustering technology
found in Microsoft Cluster Server. Therefore, Oracle Fail Safe
Server, which integrates with Microsoft Cluster Server, is not
supported on Windows XP. Oracle Fail Safe Manager Console is
supported.

See Also: Your Oracle Fail Safe documentation set, available on
separate media in the Oracle CD-ROM package
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Oracle Real Application Clusters Guard
Oracle Real Application Clusters Guard integrates Oracle Real Application Clusters
databases with Microsoft Cluster Server clusters deployed on Windows NT and
Windows 2000. It enhances high availability features of Oracle Real Application
Clusters by offering:
■

Optional automatic restarts of a failed instance or listener in a cluster

■

Detection and resolution of instance hangs

■

■

Elimination of connect-time failover TCP/IP timeout delays for new connection
requests
Use of user-written scripts after database state (online/offline) changes
Note: Oracle Real Application Clusters Guard is not supported on
Windows XP.

Other Sources of Information
See Also:
■

■

■

■

Oracle9i Database Administrator’s Guide for Windows and Oracle9i
Security and Network Integration Guide for Windows, on using
new Oracle9i features described in this chapter
Chapter 2, "Oracle9i Windows/UNIX Differences"
Chapter 5, "Database Tools Overview", for Oracle9i integration
with Windows tools
Chapter 10, "Developing Applications for Windows", for more
Oracle9i integration with Windows features
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Database Tools Overview
Oracle9i for Windows includes various tools to perform database functions. This
chapter describes preferred tools to perform common database administration tasks
and explains how tools can be started.
Unless otherwise noted, features described in this guide are common to Oracle9i
Enterprise Edition, Oracle9i Standard Edition, and Oracle9i Personal Edition.
This chapter contains these topics:
■

Choosing a Database Tool

■

Starting Database Tools

■

Using SQL*Loader

■

Using Windows Tools

■

Optional Windows Diagnostic and Tuning Utilities
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Choosing a Database Tool
Database tools is a collective term for tools, utilities, and assistants that you can use
to perform database administration tasks. Some database tools perform similar
tasks, though no one database tool performs all database administration tasks. The
following sections indicate which database tools can be used on particular
operating systems and preferred tools to use for common database administration
tasks.
Note: Oracle Server Manager is no longer shipped as of this
release. All Server Manager text and examples have been replaced
with SQL*Plus equivalents.

Additionally, connecting to the database as CONNECT INTERNAL is
no longer supported.
SQL> CONNECT INTERNAL/password@tnsalias
has been replaced by:
SQL> CONNECT SYS/password@tnsalias AS SYSDBA

Database Tools and Operating System Compatibility
Table 5–1 lists database tools and the operating system(s) on which each can be
used.
Table 5–1

Database Tools and Operating System Compatibility

Database Tools

Windows NT/2000/XP

Windows 98

SQL*Plus (SQLPLUS)1

Yes

Yes

Pro*C/C++

Yes

Yes

Pro*COBOL

Yes

Yes

Object Type Translator (OTT)

Yes

Yes

ORACLEMTSRecoveryService

Yes

No

Oracle Portal (formerly Oracle WebDB)2

Yes

Yes

Application Development
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Table 5–1 (Cont.) Database Tools and Operating System Compatibility
Database Tools

Windows NT/2000/XP

Windows 98

Oracle Enterprise Manager3

Yes

Yes

SQL*Plus (SQLPLUS)

Yes

Yes

Oracle Administration Assistant for Windows NT

Yes

No

Database Configuration Assistant

Yes

No

Oracle Advanced Security4

Yes

Yes

Oracle Performance Monitor for Windows NT

Yes

No

Oracle Data Upgrade Assistant

Yes

No

Oracle Migration Workbench5

Yes

Yes

Migration Utility (MIG)

Yes

No

DBVERIFY (DBVERF)

Yes

Yes

Export Utility (EXP)

Yes

Yes

Import Utility (IMP)

Yes

Yes

OCOPY

Yes

Yes

Yes

No

Password Utility (ORAPWD)7

Yes

No

Recovery Manager (RMAN)

Yes

Yes

SQL*Loader (SQLLDR)

Yes

Yes

TKPROF

Yes

Yes

OPERFCFG

Yes

Yes

User Migration Utility

Yes

Yes

Oracle Net Manager

Yes

Yes

Oracle Net Configuration Assistant

Yes

Yes

Database Administration

Migration Utilities

Oracle Utilities from the Command Line

ORADIM

6

Network Administration
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Table 5–1 (Cont.) Database Tools and Operating System Compatibility
Database Tools

Windows NT/2000/XP

Windows 98

Task Manager

Yes

Yes

Control Panel

Yes

Yes

Event Viewer

Yes

No

Registry Editor

Yes

Yes

User Manager

Yes8

No

Microsoft Management Console

Yes9

No

Windows Tools

1

2
3

4

5
6
7
8
9

ORADEBUG utility can be used through SQL*Plus to send debug commands to Oracle processes. See "Using
ORADEBUG Utility" in Oracle9i Database Administrator’s Guide for Windows.
Available on a separate CD-ROM.
Oracle Enterprise Manager and its optional management packs have additional integrated tools to assist in
managing databases. See Oracle Enterprise Manager Concepts Guide for more information.
Includes Oracle Enterprise Login Assistant and Oracle Wallet Manager. Available only with Oracle9i
Enterprise Edition and Oracle9i Personal Edition, and not Oracle9i Standard Edition. See your
installActions.log at C:\program files\Oracle\Inventory\logs.
Available on a separate CD-ROM.
ORADIM operates only on local databases.
ORAPWD does not work on password files for remote databases.
Windows NT only.
Must be obtained from Microsoft Corporation for use with Windows NT 4.0; automatically included with
Windows 2000.

Note: The VOLSIZE parameter for Export and Import utilities is
not supported on Windows NT. If you attempt to use the utilities
with the VOLSIZE parameter, then error LRM-00101 occurs. For
example:
D:\> exp system/manager full=y volsize=100m;
LRM-00101: unknown parameter name ’volsize’
EXP-00019: failed to process parameters, type ’EXP HELP=Y’
for help
EXP-00000: Export terminated unsuccessfully
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Preferred Database Tools
Table 5–2 lists various database tools you can use to perform common database
administration tasks. Oracle Corporation recommends you use tools listed in the
"Preferred Database Tool" column of the table. After choosing a tool to perform a
task, go to Table 5–3, " Starting Database Tools from the Start Menu", on page 5-8
for instructions on how to start the tool.
Table 5–2

Preferred Database Tools

Database Administration
Task

Preferred Database Tool

Other Database Tools

Create a database

Database Configuration Assistant

SQL*Plus Worksheet

Delete database services

Database Configuration Assistant

ORADIM

Start a database

Oracle Enterprise Manager Console

SQL*Plus or SQL*Plus Worksheet

Shut down a database

Oracle Enterprise Manager Console

Control Panel
SQL*Plus or SQL*Plus Worksheet

Change database passwords

ORAPWD

ORADIM1

Migrate database users to a
directory

User Migration Utility2

None

Migrate a database

Oracle Data Upgrade Assistant

Migration Utility (MIG)

Upgrade a database

Oracle Data Upgrade Assistant3

Run provided scripts in SQL*Plus4

Export data

Oracle Enterprise Manager Export
Wizard

Export Utility (EXP)

Import data

Oracle Enterprise Manager Import
Wizard

Import Utility (IMP)

Load data

Oracle Enterprise Manager Load Wizard SQL*Loader (SQLLDR)

Back up database

Oracle Enterprise Manager Backup
Wizard5

Recovery Manager (RMAN)

Oracle Enterprise Manager Recovery
Wizard

Recovery Manager (RMAN)

Oracle Enterprise Manager Console

SQL*Plus or SQL*Plus Worksheet

Recover database

Authenticate database
administrators and users

OCOPY

OCOPY

Windows operating system
Oracle Administration Assistant for
Windows NT
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Table 5–2 (Cont.) Preferred Database Tools
Database Administration
Task

Preferred Database Tool

Other Database Tools

Store encrypted and
decrypted Oracle Wallet
(Oracle Advanced Security
and Oracle PKI integration)

Oracle Wallet Manager (OWM) creates
the encrypted Oracle Wallet

None

Grant database roles

Oracle Enterprise Manager Console

Oracle Enterprise Login Assistant
creates the obfuscated decrypted Wallet
User Manager
SQL*Plus

Create database objects6
1

2

3

4
5

6

Oracle Enterprise Manager Console

SQL*Plus

ORADIM can only set a password when none was previously set. If a password has been previously set, then ORADIM
can change it only by deleting and re-creating Oracle9i services.
User Migration Utility can migrate local or external users to enterprise users. For more information, see "Migrating Local
or External Users to Enterprise Users" in Oracle Advanced Security Administrator’s Guide.
Oracle Data Upgrade Assistant can upgrade the following databases to the current release: Oracle7 release 7.3.4, Oracle8
release 8.0.6, Oracle8i releases 8.1.5, 8.1.6, and 8.1.7, and Oracle9i release 1 (9.0.1). It cannot be used to upgrade an earlier
Oracle7 database release to a later Oracle7 database release. See your Oracle7 for Windows NT documentation for
information on how to upgrade from one Oracle7 database to another.
Required when upgrading Oracle Real Application Clusters systems.
If you back up files while you are shutting down the database, then your backup will be invalid. You cannot use an invalid
backup to restore files at a later date.
See Oracle9i Database Administrator’s Guide for guidelines on creating database objects.

Starting Database Tools
This section describes how to start each of the database tools in the following
categories:
■

Starting Database Tools in Multiple Oracle Homes

■

Starting Database Tools from the Start Menu

■

Starting Database Tools from the Command Line

■

Starting Oracle Enterprise Manager Console

■

Starting Windows Tools

You will be referred back to this section for database tool startup procedures as you
use this guide.
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Starting Database Tools in Multiple Oracle Homes
If you have multiple Oracle homes on your computer from previous releases, then
see Chapter 6, "Multiple Oracle Homes and Optimal Flexible Architecture" for a
description of differences between Oracle homes before and after Oracle9i release 2
(9.2).

Starting Tools from Oracle8 Release 8.0.4 and Later 8.0.x Multiple Oracle Homes
If you are using multiple Oracle homes, then the command to start a tool from any
home other than the first includes a HOME_NAME, where HOME_NAME indicates
the name of that Oracle home. The first Oracle home created on your computer does
not have HOME_NAME appended to the group. For example:
To start Oracle Administration Assistant from the first Oracle home, choose:
Start > Programs > Oracle > Configuration and Migration Tools > Administration
Assistant for Windows NT
To start Oracle Administration Assistant from an additional Oracle home, choose:
Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools >
Administration Assistant for Windows NT

Starting Tools from Oracle8i Release 8.1.3 and Later Multiple Oracle Homes
Beginning in Oracle8i release 8.1.3, each Oracle home, including the first Oracle
home you create on your computer, has a unique HOME_NAME. To start Oracle
Administration Assistant from any Oracle home, choose:
Start > Programs > Oracle - HOME_NAME > Configuration and Migration Tools >
Administration Assistant for Windows NT

Starting Database Tools from the Start Menu
Table 5–3 describes how to start assistants and other tools from the Start Menu. It
also tells where to go for further information on using these products.
Note: When you use an assistant, you must have read and write
access to the directory where database files will be moved or
created. To create an Oracle9i database, you must have an
administrative privilege. If you run Database Configuration
Assistant from an account that is not part of the Administrators
group, then the tool exits without completing the operation.
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Table 5–3

Starting Database Tools from the Start Menu

Tool

Start Menu Path

More Information

Oracle
Administration
Assistant for
Windows NT

Start > Programs > Oracle - HOME_NAME > "Administering External Users and Roles" in
Configuration and Migration Tools >
Oracle9i Security and Network Integration
Administration Assistant for Windows NT
Guide for Windows

Oracle Data
Upgrade
Assistant

Start > Programs > Oracle - HOME_NAME > Oracle9i Database Migration
Configuration and Migration Tools > Data
Upgrade Assistant

Database
Configuration
Assistant

Start > Programs > Oracle - HOME_NAME > "Using Database Configuration Assistant" in
Configuration and Migration Tools >
Oracle9i Database Administrator’s Guide for
Database Configuration Assistant
Windows

Oracle Enterprise Start > Programs > Oracle - HOME_NAME > Oracle Advanced Security Administrator’s
Login Assistant
Integrated Management Tools > Enterprise
Guide
Login Assistant
Oracle Enterprise Start > Programs > Oracle - HOME_NAME > Oracle Enterprise Manager Configuration Guide
Manager
Configuration and Migration Tools >
Configuration
Enterprise Manager Configuration Assistant
Assistant
Oracle Enterprise Start > Programs > Oracle - HOME_NAME > Oracle Enterprise Manager Administrator’s
Manager Console Enterprise Manager Console
Guide
Oracle INTYPE
File Assistant

Start > Programs > Oracle - HOME_NAME > Oracle INTYPE File Assistant online help
Application Development > INTYPE File
Assistant

Oracle Locale
Builder

Start > Programs > Oracle - HOME_NAME > Oracle9i Database Globalization Support Guide
Configuration and Migration Tools > Locale
Builder

Microsoft ODBC
Administrator

Start > Programs > Oracle - HOME_NAME > Microsoft ODBC Administration online help
Configuration and Migration Tools >
Microsoft ODBC Administration

Oracle Migration
Workbench

Start > Programs > Oracle - HOME_NAME > Oracle Migration Workbench Release Notes
Configuration and Migration Tools >
Oracle Migration Workbench Reference Guide for
Migration Workbench
Microsoft SQL Server and Sybase Adaptive
Server Migrations
Oracle Migration Workbench Reference Guide for
Microsoft Access 2.0, 95, 97, 2000 Migrations

Oracle Net
Configuration
Assistant
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Table 5–3 (Cont.) Starting Database Tools from the Start Menu
Tool

Start Menu Path

More Information

Oracle Net
Manager

Start > Programs > Oracle - HOME_NAME > Oracle9i Net Services Administrator’s Guide
Configuration and Migration Tools > Net
Manager

Oracle Directory
Manager

Start > Programs > Oracle - HOME_NAME > Oracle Internet Directory Administrator’s Guide
Integrated Management Tools > Oracle
Directory Manager

Oracle for
Windows NT
Performance
Monitor

Start > Programs > Oracle - HOME_NAME > Oracle9i Database Administrator’s Guide for
Configuration and Migration Tools > Oracle Windows
for Windows NT Performance Monitor

Pro*C/C++

Start > Programs > Oracle - HOME_NAME > Pro*C/C++ Precompiler Programmer’s Guide
Application Development > Pro*C/C++

SQL*Plus

Start > Programs > Oracle - HOME_NAME > SQL*Plus User’s Guide and Reference
Application Development > SQL*Plus
"Starting and Shutting Down a Database
with SQL*Plus" in Oracle9i Database
Administrator’s Guide for Windows

SQL*Plus
Worksheet

Start > Programs > Oracle - HOME_NAME > Oracle Enterprise Manager Administrator’s
Application Development > SQL*Plus
Guide
Worksheet
Start > Programs > Oracle - HOME_NAME >
Integrated Management Tools > SQL*Plus
Worksheet

Start HTTP
Server

Start > Programs > Oracle - HOME_NAME > ORACLE_BASE\ORACLE_HOME\
Apache\Apache\htdocs\index.htm
Oracle HTTP Server > Start HTTP Server
powered by Apache

Stop HTTP Server Start > Programs > Oracle - HOME_NAME > ORACLE_BASE\ORACLE_HOME\
Apache\Apache\htdocs\index.htm
Oracle HTTP Server > Stop HTTP Server
powered by Apache
Oracle Wallet
Manager

Start > Programs > Oracle - HOME_NAME > Oracle Advanced Security Administrator’s
Integrated Management Tools > Wallet
Guide
Manager
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Starting Database Tools from the Command Line
Table 5–4 describes how to start Oracle database tools from the command line, and
where to go for further information on using these products.
Table 5–4

Starting Database Tools from the Command Line

Tool

Enter at Prompt

More Information

Oracle Enterprise C:\> oemapp console
Manager Console

Oracle Enterprise Manager Administrator’s
Guide

DBVERIFY

Oracle9i Database Utilities

C:\> dbv
DBVERIFY starts and prompts you for a
filename parameter. To obtain a list of
parameters, enter:
C:\> dbv help=y

Export Utility

C:\> exp username password
EXP starts and prompts you for parameters.
To obtain a list of these parameters, enter:

Import Utility

Oracle9i Database Utilities for instructions on
use of Export Utility

C:\> exp help=y

Oracle9i Database Error Messages for
information on error messages

C:\> imp username password

Oracle9i Database Utilities

IMP starts and prompts you for parameters.
To obtain a list of these parameters, enter:

Oracle9i Database Error Messages

C:\> imp help=y
Migration Utility

C:\> mig

Oracle9i Database Migration

To obtain a list of parameters, enter:
C:\> mig help=y
OCOPY

C:\> ocopy

"Backing Up Files with OCOPY Utility" in
Oracle9i Database Administrator’s Guide for
Windows

OPERFCFG

C:\> operfcfg

"Modifying Oracle Performance Monitor for
Windows NT Parameters" on page 9-22

ORADIM

C:\> oradim parameters

"Using ORADIM Utility to Administer an
Oracle Instance" in Oracle9i Database
Administrator’s Guide for Windows

To get a complete listing of ORADIM
parameters, enter either of the following:
C:\> oradim
C:\> oradim -? | -h | -help
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Table 5–4 (Cont.) Starting Database Tools from the Command Line
Tool

Enter at Prompt

More Information

Password Utility
(ORAPWD)

C:\> orapwd

"Creating Password Files" in Oracle9i
Database Administrator’s Guide for Windows

Recovery
Manager
(RMAN)

C:\> rman parameters

SQL*Plus
(SQLPLUS)

C:\> sqlplus

SQL*Loader
(SQLLDR)

C:\> sqlldr

Oracle9i Database Utilities

SQL*Loader displays a Help screen with
available keywords and default values.

Oracle9i Database Error Messages

TKPROF

C:\> tkprof

Oracle9i Database Performance Tuning Guide
and Reference

User Migration
Utility

C:\> umu parameters

"Migrating Local or External Users to
Enterprise Users" in Oracle Advanced Security
Administrator’s Guide

Password file is hidden. Use Windows
Explorer to see it in a file list. Choose View >
Options > View > Show All Files

Oracle9i Database Administrator’s Guide for
Windows
Oracle9i Recovery Manager User’s Guide
SQL*Plus User’s Guide and Reference
"Starting and Shutting Down a Database
with SQL*Plus" in Oracle9i Database
Administrator’s Guide for Windows

To get a list of parameters, enter:

"Starting Windows Tools" on page 5-16

C:\> umu help=yes

Note: Three special conditions apply when running Export or
Import utilities on Windows. First, default values for BUFFER and
RECORDLENGTH parameters are 4 KB and 2 KB respectively. This
default RECORDLENGTH parameter does not depend on the value of
BUFSIZ defined in the system header file. If you specify a value
larger than USHRT_MAX (64 KB), you will get a warning message.
Second, the VOLSIZE parameter is not supported. Third, to export
an entire database, you must use the EXP_FULL_DATABASE role.
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Starting Oracle Enterprise Manager Console
Oracle Enterprise Manager Console can be started:
■

From the Start Menu or Command Line

■

From a Web Browser

From the Start Menu or Command Line
■

■

Choose Start > Programs > Oracle - HOME_NAME > Enterprise Manager
Console.
At the command line, enter: C:\> oemapp console

You are prompted to choose between logging in to a Management Server or starting
in standalone mode.

Choose standalone when you want to connect directly to your database(s) to
perform administrative tasks. The first time Enterprise Manager is started in
standalone mode, the Add Database To Tree dialog appears, allowing you to add
your database(s) to Enterprise Manager’s navigation tree. For more information, see
"Standalone" in Oracle Enterprise Manager Configuration Guide.
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In Standalone mode you will not have access to functionality typically available
through Management Server and Intelligent Agent, however, because they are not
required in standalone mode. These unavailable features include:
■

Management of several different target types

■

Sharing data among several administrators

■

Advance warning of potential problems

■

Automation of repetitive tasks

■

Backup and data management tools

■

Reports customization, scheduling, and publishing

■

Running the client from a Web browser

These features are all available when you choose to log in to a Management Server,
which is automatically installed and configured during standard Oracle9i Database
installation types. If you performed a custom database installation, however, you
may need to install and configure a Management Server. For installation
instructions, see your Oracle9i Database Installation Guide for Windows. For
configuration instructions, see "Configuring and Controlling the Management
Server" in Oracle Enterprise Manager Configuration Guide.
If this is your first login to a Management Server, you must enter the default
Enterprise Manager administrator name sysman and its password oem_temp. The
Management Server on the node you select or enter must already be configured
with the repository you want to access. For more information, see "Configuring the
Console When Connected to a Management Server" in Oracle Enterprise Manager
Configuration Guide.

From a Web Browser
Enterprise Manager Web site is installed in the ORACLE_HOME\oem_webstage
directory by default. In addition, Enterprise Manager Web site automatically installs
a preconfigured Oracle HTTP server to act as its Web server.
If you want to use a Web server other than the default preconfigured Oracle HTTP
server, you must install and manually configure it. Additional supported Web
servers include:
■

Oracle Internet Application Server, release 1.0 and higher

■

Apache, release 1.3.9 and higher

■

Microsoft Internet Information Server (IIS), release 4.0 and higher
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1.

Start your Web browser and enter the following URL regardless of which Web
server you have installed.
http://webserver_hostname:port number/

where webserver_hostname is the name of the Web server computer, and
port number is whatever the Web server is configured for. The port number
of the default preconfigured Oracle HTTP Server is 3339.
The Enterprise Manager page appears, allowing you to start Oracle Enterprise
Manager Console, view previously published Enterprise Manager reports, or
link to other sites.
2.

To start Oracle Enterprise Manager Console, enter the name of the Oracle
Management Server to which you want to connect and click Launch Console.

3.

If you are logging in to Oracle Enterprise Manager for the first time, then type
in the default credentials (administrator name and password).
Administrator = sysman
Password = oem_temp
These credentials are for the default super administrator account. The first time
you start Enterprise Manager, you must log in as the super administrator. After
other administrator accounts have been created using the super administrator
account, you can log in as a different administrator.
Note: Enterprise Manager must be configured before the reports
access feature will work. See Oracle Enterprise Manager Configuration
Guide for information on:
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■

Configuration tasks

■

How to connect to an Oracle database

■

Installing Oracle Enterprise Manager Web Site

■

Installing the Web server
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Starting Windows Tools
Table 5–5 describes how to start each Windows tool and where to go for more
information on using these products.
Table 5–5

Starting Windows Tools

Tool

Start Procedure

More Information

Event Viewer

Choose Start > Programs >
Administrative Tools > Event
Viewer

"Event Viewer" on page 5-20
Your Microsoft operating system documentation

Microsoft
Management
Console (MMC)1

Choose Start > Programs >
Your Microsoft operating system documentation
Oracle - HOME_NAME >
Configuration and Migration
Tools > Administration Assistant
for Windows NT

Oracle
Performance
Monitor for
Windows NT

Choose Start > Programs >
Oracle - HOME_NAME >
Configuration and Migration
Tools > Oracle for Windows NT
Performance Monitor

"Using Oracle Performance Monitor for Windows NT"
in Oracle9i Database Administrator’s Guide for Windows

Registry Editor

At the command prompt on
Windows NT and 2000, enter:

"Registry Editor" on page 5-22

C:\> regedt32

Your Microsoft operating system documentation

At the command prompt on
Windows 98, enter:

Your Microsoft operating system documentation

Chapter 9, "Configuration Parameters and the Registry"

C:\> regedit
Task Manager

Right-click the Task Bar

"Task Manager" on page 5-22
Your Microsoft operating system documentation

User Manager

Choose Start > Programs >
Administrative Tools > User
Manager

"User Manager" on page 5-23
"Authenticating Database Users with Windows" in
Oracle9i Security and Network Integration Guide for
Windows
Your Microsoft operating system documentation

1

MMC is started whenever Oracle Administration Assistant for Windows NT is started.
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Using SQL*Loader
This section describes Windows-specific information for using SQL*Loader
(SQLLDR).

Windows Processing Options
This section discusses possible values for the Operating System Dependent (OSD)
file processing specifications string option, referred to in "SQL*Loader Control File
Reference" in Oracle9i Database Utilities.

Default (No Processing Option) or "str terminator_string"
Stream record format in which each record is terminated by a record terminator. If
"str terminator_string" is not specified, then the record terminator defaults to either
the Windows NT-style record terminator (the two-character sequence carriage
return, \r, followed by line feed, \n) or the UNIX-style record terminator
(single-character line feed, \n). Maximum record size is 48 KB.
When processing stream format data files, SQL*Loader can usually recognize record
terminators automatically, whether they are Windows NT-style or UNIX-style. So
you usually do not need to specify which record terminator you are using.
For external table loads on NT, however, only Windows NT-style record terminators
are recognized automatically. If your data file contains UNIX-style record
terminators, you must specify the record terminator. If you are using SQL*Loader
(with external_table option), then specify the UNIX-style record terminator by
specifying "str ’\n’" on the INFILE line in the SQL*Loader control file. For
example:
INFILE mydata.dat "str ’\n’"

You can also specify the record terminator in hex, by specifying "str x’0a’"
(assuming an ASCII-based character set). For example:
INFILE mydata.dat "str x’0a’"

Note that the "0" (zero) before the "a" is required. If you are using SQL with an
access parameter list to create the external table, then you must specify ’\n’ in a
RECORDS DELIMITED BY clause. For example:
RECORDS DELIMITED BY ’\n’
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You can also use a hex string in this case. For example:
RECORDS DELIMITED BY 0x’0a’

Note that in this case, the "0" (zero) before the "x" and the "0" (zero) before the "a"
are both required.

"FIX n"
Fixed record format in which each record is exactly n bytes long. Record
terminators are not required with fixed record format. If the record includes a
record terminator, then the record terminator bytes are included in the number of
bytes n.

"VAR n"
Variable record format in which the length of each record in a character field is
included at the beginning of each record in the datafile. Record terminators are not
required with the variable record format. This format provides some added
flexibility over the fixed record format and a performance advantage over the
stream record format. You can specify a datafile that is to be interpreted as being in
variable record format as follows:
INFILE "mydata.dat" "var n"

In this example, n specifies the number of bytes in the record length field. If n is not
specified, SQL*Loader assumes a length of 5 bytes. Specifying n larger than 40 will
result in an error. Lengths are always interpreted in bytes, even if character-length
semantics are in effect for the file. This is necessary because the file could contain a
mix of fields, some processed with character-length semantics and others processed
with byte-length semantics.

Case Study Files
The distribution media for SQL*Loader contains case study files for control files,
datafiles, and setup files in ulcase1,...ulcase11 in the following directory:
Oracle_Home\rdbms\demo.
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Specifying the Bad File
When SQL*Loader executes, it can create a file called a bad file or reject file in which
it places records that were rejected because of formatting errors or because they
caused Oracle errors. If you have specified that a bad file is to be created, it
overwrites any existing file with the same name; ensure that you do not overwrite a
file you wish to retain.

Control File Conventions
When preparing SQL*Loader control files (.ctl), you must follow certain syntax
and notational conventions.
In full path descriptions, backslashes do not require escape characters or other
special treatment. When embedding a single or double quotation mark inside a
string delimited by double quotation marks, place a backslash escape character
before the embedded quotation mark.
When specifying datatypes in the SQL*Loader control file, note that the default
sizes of native datatypes shown in Table 5–6 are specific to Windows. These
datatypes can be loaded with correct results only between systems where they have
the same length in bytes. You cannot override these defaults in the control file. If the
byte order is different between the systems, you can indicate the byte order of the
data with the BYTEORDER parameter, or you can place a byte-order mark (BOM) in
the file.
Table 5–6

Default Sizes of Native Datatypes

Native Datatypes

Default Field Length

DOUBLE

8

FLOAT

4

INTEGER1

4

SMALLINT

2

1

The default listed is correct if INTEGER is specified without
a size. But INTEGER(n) is also allowed. In that case, n
specifies the size of the INTEGER field in bytes.

See Also: Oracle9i Database Utilities for a complete list of options
and instructions on using SQL*Loader
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Using Windows Tools
The following Windows tools can be used to administer an Oracle database:
■

Event Viewer

■

Microsoft Management Console

■

Oracle Performance Monitor for Windows NT

■

Registry Editor

■

Task Manager

■

User Manager

Event Viewer
Event Viewer lets you monitor events in your system. An event is an important
occurrence in the system or application (such as your Oracle database) that requires
user notification. While messages for major events can appear on-screen as you
work at your computer, events not requiring your immediate attention are recorded
by Windows in the Event Viewer log file. You can then view this information at
your convenience.
Event Viewer can be used to monitor Oracle database events, such as:
■

■

■

Initialization of System Global Area for active instance
Initialization of Program Global Area (PGA) for background processes of active
instance
Connection to Oracle9i database using AS SYSDBA

In addition, the operating system audit trail is logged to Event Viewer.
See Also: "Monitoring a Database" in Oracle9i Database
Administrator’s Guide for Windows for specific instructions on
accessing and using Event Viewer to monitor Oracle database
events
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Microsoft Management Console
Microsoft Management Console provides a central location for network
administration. Microsoft Management Console hosts applications (called snap-ins)
that administrators can use to manage their networks. Oracle snap-ins enable
database administrators to:
■

Configure Oracle database administrators, operators, users, and roles so the
Windows operating system can authenticate them

■

Configure OracleServiceSID

■

Modify registry parameters for all Oracle homes on the computer

■

■

Modify the computer hostname, username, and password for the database
being monitored by Oracle Performance Monitor for Windows NT
View and terminate an Oracle thread

Oracle Performance Monitor for Windows NT
Oracle Performance Monitor for Windows NT is integrated into Microsoft’s
Performance Monitor. This tool enables you to view performance of processors,
memory, cache, threads, and processes. Performance information provided includes
device usage, queue lengths, delays, throughput measurements, and internal
congestion measurements. This information is provided as charts, alerts, and
reports.
You can use Oracle Performance Monitor to monitor key Oracle database
information, such as:
■

Library cache

■

Buffer cache

■

Data dictionary cache

■

Redo log buffer cache

■

Thread activity

You can use your findings to improve database performance.
See Also: "Using Oracle Performance Monitor for Windows NT"
in Oracle9i Database Administrator’s Guide for Windows for specific
instructions on accessing and using Oracle Performance Monitor to
monitor Oracle database performance
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Registry Editor
Oracle9i database stores its configuration information in a structure known as the
registry. You can view and modify this configuration information through Registry
Editor. The registry contains configuration information for your computer and must
not be accessible for editing by inexperienced users. Only experienced
administrators should view and change this information.
Registry Editor displays configuration information in a format similar to Windows
Explorer. In the left-hand window is a tree-like format consisting of keys (or
folders). When one of these keys is highlighted, parameters and values assigned to
that key are displayed in the right-hand window.
When you install products from your CD-ROM, configuration parameters are
automatically entered in the registry. These parameters are read each time your
Windows computer is restarted and whenever an Oracle product is started. These
parameters include settings for:
■

Oracle home directory

■

Language

■

Company name

■

Oracle home subdirectories for individual products

■

Individual products such as SQL*Plus

■

Services
See Also: Chapter 9, "Configuration Parameters and the Registry"
for definitions of Oracle database configuration parameters and
specific instructions on using the registry to modify Oracle9i
database configuration parameters

Task Manager
Task Manager has three display options:
■

■

■
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Applications option displays what applications are running. This is useful for
identifying and ending unresponsive tasks. (Oracle does not appear as an
application because it runs as a service.)
Processes option displays details of currently running processes and their
resource usage. Columns are customizable.
Performance option graphically displays real-time CPU and memory usage,
which is useful for spotting sudden changes.
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User Manager
User Manager enables you to manage Windows computer security and create user
accounts on Windows NT. With User Manager, you can:
■

■

■

Grant Oracle database roles
Use operating system authentication for user accounts (For example, you can
grant DBA access to an NT user.)
Create an NT user account that enables you to make secure client connections to
Oracle9i database without a password
See Also: Manually Administering External Users and Roles" in
Oracle9i Security and Network Integration Guide for Windows for
specific instructions on using User Manager to perform Oracle
database administration
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Optional Windows Diagnostic and Tuning Utilities
Windows NT Resource Kit includes several diagnostic and tuning utilities.
QuickSlice provides a quick overview of what is occurring on the system, using a
graphical user interface.
■

Distinguishes between time spent in user mode and kernel mode

■

Imposes low overhead on the system (unlike Performance Monitor)

■

Shows a continuous display, rather than just a snapshot

■

Opens a window with more details when you double-click a process

Process Viewer summarizes resource usage by a process.
Process Explode provides a detailed display of resource usage by a process.
Task List displays resource usage and other details of a process when its processor
identifier or process name is given as an argument. This tool also displays a list of
executables and DLLs associated with a process.
See Also:
■

■

■

■

■

■
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"Administering a Database" in Oracle9i Database Administrator’s
Guide for Windows for OracleServiceSID configuration tasks
"Authenticating Database Users with Windows" in Oracle9i
Security and Network Integration Guide for Windows for
authentication tasks
"Monitoring a Database" in Oracle9i Database Administrator’s
Guide for Windows for thread management tasks
Chapter 3, "Using Oracle9i on Windows 2000"
Chapter 9, "Configuration Parameters and the Registry" and
"Monitoring a Database" in Oracle9i Database Administrator’s
Guide for Windows for Oracle Performance Monitor for
Windows NT tasks
Oracle9i Database Installation Guide for Windows for components
available for installation
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Multiple Oracle Homes and Optimal Flexible
Architecture
This chapter describes multiple Oracle homes and Optimal Flexible Architecture
for Oracle9i for Windows.
This chapter contains these topics:
■

Introduction to Multiple Oracle Homes and OFA

■

Multiple Oracle Homes Overview

■

Changing the Value of PATH

■

Exiting Oracle Universal Installer After Entering Name and PATH

■

Setting Variables in the Environment or the Registry

■

Optimal Flexible Architecture Overview

■

Differences Between Directory Trees by Release

■

OFA Directory Naming Conventions

■

OFA and Multiple Oracle Home Configurations

■

Increasing Reliability and Performance

■

Comparison Between OFA on Windows NT and UNIX
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Introduction to Multiple Oracle Homes and OFA
When you install an Oracle database, you are installing one of the largest
applications that your computer can support. Using multiple Oracle homes and
OFA provides many advantages when administering large databases. The following
advantages are most important:
■

■

■

■

■

■

Structured organization of directories and files and consistent naming used for
database files simplify database administration.
Distribution of I/O across multiple disks prevents performance bottlenecks
caused by multiple read or write commands issued simultaneously to a single
drive.
Distribution of applications across multiple disks safeguards against database
failures.
Login home directories are not at risk when database administrators add, move,
or delete Oracle home directories.
Multiple versions of application software can execute concurrently.
Software upgrades can be tested in an Oracle home in a separate directory from
the Oracle home where your production database is located.

Multiple Oracle Homes Overview
This section includes the following topics:
■

What Is an Oracle Home?

■

Benefit of Using Multiple Oracle Homes

■

Multiple Oracle Home Functionality in Different Releases

■

One-Listener Support of Multiple Oracle Homes

■

Multiple Oracle Home Environments
Note: All Oracle7 products and all Oracle8 release 8.0.3 products
are non-multiple Oracle home products. Oracle9i Database
Installation Guide for Windows has a list of products supporting
single or multiple Oracle homes.
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What Is an Oracle Home?
An Oracle home corresponds to the environment in which Oracle products run.
This environment includes the following:
■

Location of installed product files (for example, C:\orant or
C:\oracle\ora92)

■

PATH variable pointing to binary files of installed products

■

Registry entries

■

Service names

■

Program groups

Oracle homes also have a name associated with them, which you specify along with
their location during installation.

Benefit of Using Multiple Oracle Homes
The main benefit of using multiple Oracle homes is that you can run multiple
releases of the same products concurrently. For example, you can test an Oracle9i
release 2 (9.2) database patch before you run your production database Oracle9i
release 2 (9.2) against it.

Multiple Oracle Home Functionality in Different Releases
Modifications to multiple Oracle home functionality have occurred since it was
introduced in Oracle8 release 8.0.4. This section helps you determine capabilities of
your Oracle home depending on the release you are using.

Oracle8 Releases Before 8.0.4
Releases of Oracle for Windows NT prior to Oracle8 release 8.0.4 support only
single Oracle homes, allowing you to install and run Oracle products in a single
Oracle home. Different releases of Oracle products can be installed in the same
Oracle home provided they have different first or second-digit release numbers. For
example, you can install Oracle7 release 7.2 products and Oracle7 release 7.3
products or Oracle7 release 7.x and Oracle8 release 8.x products in the same Oracle
home. However, you cannot install multiple third-digit releases of the same
products. For example, you cannot install Oracle7 release 7.3.2 and Oracle7 release
7.3.3 products on the same computer; one installation will overwrite the other.
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Oracle8 Releases 8.0.4 to 8.0.6
You can install one or more releases of Oracle products in multiple Oracle homes.
For example, with multiple Oracle homes, you can install Oracle8 release 8.0.x and
Oracle8i release 8.1.3 products or Oracle7 release 7.x and Oracle8 release 8.0.x
products in different Oracle homes on the same computer.
You can also install different releases of Oracle products in the same Oracle home
provided they have different first or second-digit release numbers. For example,
you can install Oracle7 release 7.2 products and Oracle8 release 8.0.x products in the
same Oracle home.

Oracle8i Release 8.1.3 to Oracle9i Release 2 (9.2)
These releases have the same multiple Oracle home functionality as Oracle8 releases
8.0.4 to 8.0.6, but the following restrictions apply:
■

■

■

You cannot install any release from Oracle8i release 8.1.3 to Oracle9i release 2
(9.2) into an Oracle home that was created using the old installer. (The old
installer was called Oracle Installer and was used for installations before
Oracle8i release 8.1.3; the new Java-based installer is called Oracle Universal
Installer.)
You cannot install releases prior to Oracle8i release 8.1.3 into an Oracle home
that was created by any release from Oracle8i release 8.1.3 to Oracle9i release 2
(9.2).
Releases from Oracle8i release 8.1.3 to Oracle9i release 2 (9.2) must be installed
in separate Oracle homes. You cannot have more than one release installed in
each Oracle home.

Oracle8i Release 8.1.5 to Oracle9i Release 2 (9.2)
You can use an Oracle9i release 2 (9.2) listener to spawn a connection to a database
from Oracle9i release 2 (9.2), Oracle8i release 8.1.x, Oracle8 release 8.0.x, or Oracle7
release 7.3.x. Some restrictions apply, however, in using Oracle9i release 2 (9.2)
listeners with earlier releases of the database:
■
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You should enable process mode external procedures for Oracle9i release 2 (9.2)
if you want to spawn a connection to a Oracle8 release 8.0.3 database.

■

You must install Oracle8 release 8.0.4.0.3 (or later) patch for Oracle Net.

■

You cannot enable shared sockets.
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Note: Multiple Oracle homes functionary works only with
Oracle8 releases 8.0.4 and later. For example, if you have Oracle7
release 7.3.3 products already installed on your computer, then it
does not work. You cannot install Oracle7 release 7.3.4 products in a
separate Oracle home.

One-Listener Support of Multiple Oracle Homes
You can use one listener for spawning connections to databases for multiple Oracle
homes. Simply add each system identifier to the SID_LIST section in the ORACLE_
BASE\ORACLE_HOME\network\admin\listener.ora file.
Because the SID is unique to a system across different Oracle homes, the listener can
spawn the database thread for a specific SID in the correct Oracle home, and the
ORACLE_HOME parameter (used in UNIX environments only) is not needed in the
listener.ora file.
Note: There may be multiple listener.ora files on your
computer, one for each Oracle home. To ensure that you use the
correct listener.ora file, check the Oracle home name in the
listener service. See "Managing Oracle Services" in Oracle9i Database
Administrator’s Guide for Windows for information on verifying
service names.

Multiple Oracle Home Environments
This section describes differences among multiple Oracle home environments since
they were first introduced in Oracle8 release 8.0.4.

Oracle Home Environments in Oracle8 Releases 8.0.4 and Later 8.0.x
If you have Oracle8 release 8.0.4 or later 8.0.x Oracle homes on your computer, then
note differences in Table 6–1 between the first Oracle home you installed and more
recent Oracle homes you may install.
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Table 6–1

Oracle Home Environments in Oracle8 Releases 8.0.4 and Later 8.0.x

Element

First Oracle Home

Each Additional Oracle Home

Service Names

OracleTNSListener80

OracleHOME_NAMETNSListener80
Oracle home name included in service names.

Program Groups

Oracle for Windows NT

Oracle for Windows - HOME_NAME
Oracle home name appended to the program group.

Registry Entries

Located in HKEY_LOCAL_
Subkeys for each Oracle home are added under HKEY_
MACHINE\SOFTWARE\ORACLE LOCAL_MACHINE\SOFTWARE\ORACLE subkey (HOME0,
HOME1, HOME2, and so on). For more information on
registry keys and subkeys, see Chapter 9, "Configuration
Parameters and the Registry".

System Identifier
(SID) name for
starter database

Automatically named ORCL

Only the first starter database on your computer is called
ORCL. Additional starter databases use the naming
convention ORCx or ORxx where x is a number appended
to ensure the SID is unique.

Oracle Home Environments in Oracle8i Releases 8.1.3, 8.1.4, and 8.1.5
Oracle8i release 8.1.3, 8.1.4, and 8.1.5 Oracle homes are slightly different from Oracle
homes before Oracle8i release 8.1.3. Table 6–2 displays those differences.
Table 6–2

Oracle Home Environments in Oracle 8i Releases 8.1.3, 8.1.4, and 8.1.5

Element

First Oracle Home

Each Additional Oracle Home

Service Names

OracleHOME_NAMETNSListener

OracleHOME_NAMETNSListener

Program Groups

Oracle - HOME_NAME

Oracle - HOME_NAME

Registry Entries

Located in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\
HOME0

Subkeys for each Oracle home are added in HKEY_
LOCAL_MACHINE\SOFTWARE\ORACLE subkey. For
example, the next subkeys after HOME0 are HOME1,
HOME2, HOME3, and so on. For more information on
registry keys and subkeys, see Chapter 9,
"Configuration Parameters and the Registry".

System Identifier
(SID)1 name and
DB_NAME

Automatically named ORCL for
Oracle8i releases 8.1.3 and 8.1.4.

For Oracle8i releases 8.1.3 and 8.1.4, the second
database you create on your computer has a SID of
ORCL0. For Oracle8i release 8.1.5 and onwards, you
must type in the global database name and SID name
of your choice when prompted during installation.

1

For Oracle8i releases 8.1.3 through 9.0, the SID can be a maximum of 64 alphanumeric characters in length. For all Oracle for
Windows releases prior to 8.1.3, the SID is a maximum of 4 alphanumeric characters.
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Changing the Value of PATH
Unless you specify otherwise at installation time, the Oracle home in which you
installed products most recently is the first directory listed in your PATH (primary
home). As such, it has priority over the other Oracle home entries in your PATH.
If you start a product from the command prompt, then the release of the product
started is the one in the Oracle home listed first in your PATH, unless you
specifically start a different release of the product by one of the following methods:
■

■

■

Specifying the full directory path name to the release of the product you want
to use at the command prompt
Changing to the directory that contains the executable you want to use
Changing your PATH so that the first entry points to binary files for the product
release you want to use

You can change the value of PATH by using one of the following methods:
■

Using Oracle Home Selector

■

At the System Level on Windows NT
You can assign a new value at the system level. The new value exists until you
change the value of PATH again.

■

At the Command Prompt
You can assign a new value at the command prompt. The new value reverts to
its previous value when you quit the session.
Note: The first two methods of changing the value of PATH are
only valid if you are a member of the Administrators group. After
you have changed the value of PATH, you must open a new
command prompt window to make it active. The change is not
reflected in already-opened windows.
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Using Oracle Home Selector
Oracle Home Selector is a graphical user interface tool that enables you to edit your
environment path to make an appropriate Oracle home directory your primary
home. This tool can be used only when you have multiple, active Oracle home
directories on a single computer.
1.

Choose Start > Programs > Oracle Installation Products > Home Selector.
The Oracle Home Selector window appears.

2.

Select the Oracle home that you want as the primary Oracle home from the list.

3.

Click OK.

At the System Level on Windows NT
1.

Choose Start > Settings > Control Panel.
The Control Panel window appears.

2.

Double-click the System icon.
The System Properties window appears.

3.

Click the Environment tab.
The system variables appear.

4.

Edit the value of PATH in the Value field and choose Set.

5.

Click OK.

At the System Level on Windows 98
1.

Open the autoexec.bat file.

2.

Edit the value of the PATH statement.

3.

Restart your computer.

In some cases on Windows 98, Oracle Home Selector fails to switch entries in the
PATH environment variable as desired. This occurs where the PATH is defined in
multiple places in the file autoexec.bat.
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For example, if the following lines exist in autoexec.bat:
PATH C:\windows
PATH D:\oracle\ora817;D:\oracle\ora816;%PATH%

then an attempt to switch the order of D:\oracle\ora817 with
D:\oracle\ora816 in the PATH using Oracle Home Selector fails.
To work around this limitation, modify autoexec.bat so that the PATH is defined
in one location in the file. Using the previous example, modify autoexec.bat to
read:
PATH D:\oracle\ora817;D:\oracle\ora816;C:\windows

If you then attempt to use Oracle Home Selector to switch the order of Oracle
homes in the PATH, it will succeed.

At the Command Prompt
At the command prompt, enter:
C:\> set PATH=PATHNAME;%PATH%

where PATHNAME is the full path to binary files for the products you want to use.
This change is valid for the current session only. If you want to change the value of
your PATH permanently, then use Oracle Home Selector or change the value of
PATH at the system level. Both methods are described earlier in this section.
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Exiting Oracle Universal Installer After Entering Name and PATH
If you have to exit Oracle Universal Installer unexpectedly after you have entered
the name and path for an Oracle home (for example, because there is no more disk
space in the path you specified), then you cannot specify a different path until you
delete the HOMEID key and the IDx key corresponding to that Oracle home from the
registry. To do this:
1.

Read the value of parameter ORACLE_HOME_NAME for each HOMEID subkey in
key HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE until you find the value that
matches the name of the Oracle home you must delete.

2.

Delete subkey HOMEID you just located.

3.

Delete appropriate IDx subkey in key HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\ALL_HOMES, where x has the same value as ID
in HOMEID. For example, if subkey HOMEID for the home name you want to
delete is HOME1, then the appropriate IDx subkey is ID1.
See Also: Chapter 9, "Configuration Parameters and the Registry"
for more information on registry keys and subkeys

Setting Variables in the Environment or the Registry
Variables set in the environment always override the value of equivalent variables
set in the registry. The following section describes consequences of setting two of
the most commonly-used environment variables, ORACLE_HOME and TNS_ADMIN.

ORACLE_HOME
Oracle Corporation recommends that you never set the ORACLE_HOME environment
variable, because it is not required for Oracle products to function properly. If you
set the ORACLE_HOME environment variable, then Oracle Universal Installer will
unset it for you. Oracle products find the value of ORACLE_HOME at the location
specified by the ORACLE_BASE\ORACLE_HOME\bin\oracle.key file. If you
must set ORACLE_HOME in the environment for another reason, then you must take
care to run software only from that Oracle home when the variable is set.
When you run an Oracle application from the command prompt, the first
executable by that name found in the directory path runs. For example, C:\>
sqlplus. Alternately, if you specify a full directory path, then the specified
application runs. For example, C:\oracle\ora82> sqlplus.
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If you modify the value of PATH using any of the four methods described in the
previous section, then you can choose which release of an application is run from
the command prompt. In sum, modifying the value of PATH indicates from which
Oracle home to run executables at the command prompt, when no full directory
path is specified.
Once an Oracle application starts, it looks for all environment variables first in the
current environment and second in the registry key for the Oracle home from which
the application is running.
The application knows where it is running from by calling Windows to obtain the
executable’s path name and then parsing the path name to get the directory from
which it is running. In the ORACLE_BASE\ORACLE_HOME\bin directory where the
executable resides, there is a file called oracle.key. This file specifies where in the
registry to look for variables when applications from that particular Oracle home
are run.
For example, if you run C:\oracle\ora82\bin\sqlplus.exe, then
sqlplus.exe looks in C:\oracle\ora82\bin\oracle.key to find out where
to look for its registry variables. If the oracle.key file does not exist (for version 7
and some version 8 Oracle homes), then Oracle uses HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE to locate the registry variables.
In a typical case, there are no Oracle variables (that is, ORACLE_HOME) set in the
environment. Any applications run from an Oracle8 release 8.0.5 or later Oracle
home look in the oracle.key file in that Oracle home and find their variables
(including ORACLE_HOME) in the correct registry key. Likewise for Oracle9i release 2
(9.2), the Oracle home that gets priority depends on the PATH, but regardless of the
PATH setting, all software works correctly.

Consequences of Setting ORACLE_HOME
If you set ORACLE_HOME in the environment, then software run from another Oracle
home will not work reliably. Conflict occurs when you set ORACLE_HOME to point to
one Oracle home directory, then attempt to run applications from a second Oracle
home. These applications first check for any environment variable settings (such as
ORACLE_HOME), before checking the registry through the oracle.key file.
Because ORACLE_HOME is set, the applications in the second Oracle home attempt to
use files in the first Oracle home, causing a conflict.
For example, suppose you have Oracle8 release 8.0.5 installed in C:\orant and
Oracle9i release 2 (9.2) installed in C:\oracle\ora92. Suppose further that
ORACLE_HOME is set to C:\orant in the environment. If you run an application
from C:\oracle\ora92\bin, then that application first looks in the environment
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for all variables before looking at its oracle.key file. So an application run from
your Oracle9i release 2 (9.2) Oracle home runs with ORACLE_HOME=C:\orant.
Therefore, anything that the application uses ORACLE_HOME for will be looked for
in C:\orant, where it may not exist. Examples include message files (*.msb), SQL
scripts (.sql), and any other files opened by the application and based off
ORACLE_HOME.
Note that the same behavior occurs on UNIX. If you run an application from Oracle
home number 1 with ORACLE_HOME=OracleHome number 2 in the environment,
then the same behavior can be observed.

TNS_ADMIN
Oracle software looks for TNS_ADMIN in one location in the registry (depending
upon the type of Oracle home installed). If you installed software into the default
Oracle home, then any software running from that Oracle home will look in HKEY_
LOCAL_MACHINE\SOFTWARE\ORACLE. If you installed a new-style (8.0.4 or later)
multiple Oracle home, then the Oracle software looks in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOMEID. (Key ALL_HOMES is used by the installer
and plays no role when translating variables.)
The environment always overrides the registry, so if TNS_ADMIN is set in the
environment, then that takes precedence over the TNS_ADMIN setting in the registry.
No variables should be set in the environment by Oracle Home Selector except for
PATH.

Optimal Flexible Architecture Overview
Oracle Optimal Flexible Architecture (OFA) is a set of file naming and placement
guidelines for Oracle software and databases. It can also be thought of as a set of
good habits to adopt when organizing Oracle directories and files on your
computer. All Oracle products on CD-ROM are OFA-compliant; that is, Oracle
Universal Installer places Oracle products in directory locations that follow OFA
guidelines. Although using OFA is not a requirement, Oracle Corporation
recommends that you use it if your database will grow in size, or if you plan to have
multiple databases.
The aim of OFA is to prevent an entire class of problems that can occur when you
have different releases of Oracle software and multiple, growing databases on your
computer. OFA is designed to provide significant benefits:
■
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■

Greater reliability through data spanning multiple physical drives

■

Higher performance through decreased I/O contention for disks

For example, Oracle Universal Installer now separates Oracle software executables
from database files. Previously, database files were placed in ORACLE_
HOME\database, a subdirectory of the Oracle home directory that also contained
Oracle software.
Using OFA, Oracle Universal Installer puts Oracle software in ORACLE_
BASE\ORACLE_HOME and database files in ORACLE_BASE\oradata. Now when
you upgrade a database to the latest release, the new Oracle software executables
will be placed in a different Oracle home directory. After you judge the upgrade
successful, you can easily remove the old Oracle home directory and reclaim space,
because the database does not reside there.

Benefits of an OFA-Compliant Database
An OFA-compliant database has the following benefits:
■

Easier database administration and management of database growth
File system organization simplifies locating specific database files and adding
database files as the database grows.

■

Fewer performance bottlenecks
Disk contention decreases, because Oracle administration files, binary files, and
datafiles that used to be on one disk can now reside in separate directories on
separate disks.

■

Safeguards against disk failures
By spreading files across more than one disk, disk failures impact as little data
as possible.

■

Support for concurrent execution of application software
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Multiple releases of application software can run simultaneously, enabling
testing and use of a new release of an application before abandoning the
previous release. Transferring to a new release after an upgrade is simple for the
database administrator and transparent for the user.

Characteristics of an OFA-Compliant Database
An OFA-compliant database has the following characteristics:
■

Independent subdirectories
Categories of files are separated into independent subdirectories so that files in
one category are minimally affected by operations on files in other categories.

■

Consistent naming conventions for database files
Database files are easily distinguishable from all other files. Files of one
database are easily distinguishable from files of another database. Datafiles,
redo log files, and control files are easily identifiable. Datafiles are clearly
associated with a particular tablespace.

■

Integrity of Oracle home directories
You can add, move, or delete Oracle home directories without having to revise
applications that refer to them.

■

Separation of administrative information for each database
The ability to distinguish administrative information about one database from
that of another ensures a reasonable structure for the organization and storage
of administrative data.

■

Separation of tablespace contents
Tablespace free space fragmentation and I/O request contention are minimized,
while administrative flexibility is maximized.

■

Tuning I/O loads across all disks
I/O loads are tuned across all disks, including disks storing Oracle data in raw
devices, if needed.
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Differences Between Directory Trees by Release
OFA has necessitated changes to the Oracle database directory tree. This section
lists the differences.

Top-Level Oracle Directory
When you install an Oracle8i release 8.1.3 or earlier release, all subdirectories are
located under a top-level ORACLE_HOME directory that by default is C:\orant.
When you install an Oracle8i release 8.1.4 or later OFA-compliant database, all
subdirectories are no longer under a top-level ORACLE_HOME directory. There is
now a new top-level directory called ORACLE_BASE of form X:\oracle, where X
is any hard drive. If you install an OFA-compliant database using Oracle Universal
Installer defaults, then ORACLE_BASE is C:\oracle.

ORACLE_BASE contains \ORACLE_HOME directories, \oradata directories (for
database files), and \admin directories (for database administration files).

Database Filenames
In Oracle8i release 8.1.3 and earlier releases, database files have the SID in the
database filename. For example, the first control file is named ctl1SID.ora.
Beginning with Oracle8i release 8.1.4, database files no longer have the SID in the
database filename. For example, the first control file is named control01.ctl.
There is no need for the presence of the SID in the filename, because all the database
files for a particular database are placed in \oradata under a directory called DB_
NAME that is named for that database.

Database Filename Extensions
In Oracle8i release 8.1.3 and earlier releases, all database files have the same .ORA
extension.
In an OFA-compliant release, the convention of having .ora as the filename
extension for database files is no longer used. Database filenames now have more
meaningful extensions. These are:
■

.ctl for control files,

■

.log for log files

■

.dbf for datafiles.
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OFA Directory Naming Conventions
OFA uses directory naming conventions that make it easy to identify the precise
Oracle home and database name that is associated with a set of files. This section
describes the naming conventions used for top-level directories of an
OFA-compliant database directory tree:
■

ORACLE_BASE Directory

■

ORACLE_HOME Directory

■

ADMIN Directory

■

ORADATA Directory

■

DB_NAME Directory

ORACLE_BASE Directory
ORACLE_BASE is the root of the Oracle directory tree. If you install an
OFA-compliant database using Oracle Universal Installer defaults, then ORACLE_
BASE is X:\oracle where X is any hard drive. For example, C:\oracle.
If you are installing Oracle9i for Windows on a computer with no other Oracle
software installed, then you can change ORACLE_BASE before running Oracle
Universal Installer. Most users will not need or want to do this.
Do not change the value of ORACLE_BASE after you run Oracle Universal Installer
for the first time. If there is an existing ORACLE_BASE and you change it, then there
will be a conflict of Oracle base directories. If you create another ORACLE_BASE
when the original ORACLE_BASE already exists, then certain tools and the database
will not be able to find previously created files. They will look for them in the new
ORACLE_BASE instead of the original ORACLE_BASE.

Changing ORACLE_BASE at the System Level on Windows NT:
1.

Choose Start > Settings > Control Panel.
The Control Panel window appears.

2.

Double-click the System icon.
The System Properties window appears.

3.

Click the Environment tab.
The System Variables appear.
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4.

Select ORACLE_BASE.

5.

Type a new value for ORACLE_BASE in the Value text box, then click OK to exit.

Changing ORACLE_BASE at the System Level on Windows 98:
1.

Open the autoexec.bat file, using a text editor.

2.

Edit the value of the ORACLE_BASE statement.

3.

Restart your computer.
Note: An ORACLE_BASE registry key exists for every Oracle
home. Ideally, the value of the ORACLE_BASE registry key will be
identical for each Oracle home.

ORACLE_HOME Directory
\ORACLE_HOME directory is located beneath X:\ORACLE_BASE and contains
subdirectories for Oracle software executables and network files.
If you install Oracle9i for Windows on a computer with no other Oracle software
installed and you use default settings, then the first Oracle home directory that you
create is called \ora92.

ADMIN Directory
Database administration files are stored in subdirectories of ORACLE_BASE
\admin\DB_NAME. Names and brief descriptions of some of these subdirectories
are:
\bdump
\cdump
\create
\exp
\pfile
\udump

--background process trace files
--core dump files
--database creation files
--database export files
--initialization parameter files
--user SQL trace files

Multiple Oracle Homes and Optimal Flexible Architecture 6-17

OFA and Multiple Oracle Home Configurations

ORADATA Directory
Database files are stored in ORACLE_BASE\ORADATA\DB_NAME. Names and brief
descriptions of these files are:
control01.ctl
control02.ctl
control02.ctl
oemrep03.dbf
system01.dbf
rbs01.dbf
indx01.dbf
temp01.dbf
users01.dbf
redo01.log
redo02.log
redo03.log

--control file 1
--control file 2
--control file 3
--Oracle Enterprise Manager repository tablespace datafile
--SYSTEM tablespace datafile
--RBS tablespace datafile
--INDX tablespace datafile
--TEMP tablespace datafile
--USERS tablespace datafile
--redo log file group one, member one
--redo log file group two, member one
--redo log file group three, member one

Note: This directory structure allows for disk striping only on
UNIX platforms. See "Support for Symbolic Links on Windows NT"
on page 6-25.

DB_NAME Directory
DB_NAME is the unique name for a particular database and has the same value as
parameter DB_NAME in the initialization parameter file (init.ora). When you create
a database, DB_NAME can be no more than eight characters long and can contain
only the following characters:
■

Alphabetic characters

■

Numbers

■

Underscores (_)

■

Pound sign (#)

■

Dollar sign ($)

OFA and Multiple Oracle Home Configurations
The following sections describe various OFA and multiple Oracle homes
configurations.
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Specifying an ORACLE_HOME Directory
To install an OFA-compliant database, you must specify an Oracle home directory
in the Path: field of Oracle Universal Installer. It is of the form:
X:\[PATHNAME]\oracle\HOME_NAME

where:
■

X:\ is any hard drive. For example, C:\

■

[PATHNAME] is an optional directory path name

■

■

\oracle is a mandatory directory path name, unless you changed the value of
registry key ORACLE_BASE before performing the installation

HOME_NAME is the name of the Oracle home

The following are examples of OFA-compliant Oracle home directories:
■

C:\test\oracle\ora92

■

D:\oracle\ora92

Installing a Default OFA Database: Example
1.

Install Oracle8i for Windows release 8.l.6 on a computer with no other Oracle
software installed and accept default Oracle Universal Installer settings for the
first Oracle home (C:\oracle\ora81) in the path: field.

2.

Complete the installation.

3.

Install Oracle9i for Windows release 2 (9.2) and accept default Oracle Universal
Installer settings for the first Oracle home (C:\oracle\ora92) in the path:
field.

Table 6–3 shows the default OFA database settings.
Table 6–3

Default OFA Database Settings

Setting

Value

ORACLE_BASE

C:\oracle (same for all Oracle homes)

Oracle home 1

C:\oracle\ora81

Oracle home 2

C:\oracle\ora92

Multiple Oracle Homes and Optimal Flexible Architecture 6-19

OFA and Multiple Oracle Home Configurations

Installing a Nondefault OFA Database: Example 1
1.

Install Oracle8i for Windows release 8.1.6 and change default Oracle Universal
Installer settings for the first Oracle home from C:\oracle\ora81 in the path:
field to X:\xyz.

2.

Complete the installation.

3.

Install Oracle9i for Windows release 2 (9.2) and change default Oracle Universal
Installer settings for the second Oracle home from C:\oracle\ora92 in the
path: field to Y:\abc.

Table 6–4 shows the nondefault OFA database settings for example 1.
Table 6–4

Nondefault OFA Database Settings: Example 1

Setting

Value

ORACLE_BASE

X:\xyz for first Oracle home;
Y:\abc for second Oracle home

Oracle home 1

X:\xyz

Oracle home 2

Y:\abc

The resulting directory tree would look similar to this:
X:\xyz
\admin
\DB_NAME1
\DB_NAME2
\bin
\network
\oradata
\DB_NAME1
control01.ctl
control02.ctl
control03.ctl
indx01.dbf
rbs01.dbf
system01.dbf
temp01.dbf
users01.dbf
redo01.log
redo02.log
redo03.log
\DB_NAME2
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Y:abc
\admin
\DB_NAME1
\DB_NAME2
\bin
\network
\oradata
\DB_NAME1
control01.ctl
control02.ctl
control03.ctl
indx01.dbf
rbs01.dbf
system01.dbf
temp01.dbf
users01.dbf
redo01.log
redo02.log
redo03.log
\DB_NAME2

Installing a Nondefault OFA Database: Example 2
1.

Install Oracle8i for Windows release 8.1.6 and change default Oracle Universal
Installer settings for the first Oracle home from C:\oracle\ora81 in the path:
field to X:\xyz\oracle\abc.

2.

Complete the installation.

3.

Install Oracle9i for Windows release 2 (9.2) and change default Oracle Universal
Installer settings for the second Oracle home from C:\oracle\ora92 to
X:\pqr.

Table 6–5 shows the nondefault OFA database settings for example 2.
Table 6–5

Nondefault OFA Database Settings: Example 2

Setting

Value

ORACLE_BASE

X:\xyz\oracle
(same for both Oracle homes)

Oracle home 1

X:\xyz\oracle\abc

Oracle home 2

X:\pqr
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The resulting directory tree would look similar to this:
X:\pqr
\bin
\network
X:\xyz
\oracle
\abc
\bin
\network
\admin
\db_name1
\adhoc
\bdump
\cdump
\create
\exp
\pfile
\udump
\DB_NAME2
\...
\oradata
\DB_NAME1
control01.ctl
control02.ctl
control03.ctl
indx01.dbf
rbs01.dbf
system01.dbf
temp01.dbf
users01.dbf
redo01.log
redo02.log
redo03.log
\DB_NAME2
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Increasing Reliability and Performance
One of the basic goals of OFA is to increase reliability and performance by
distributing I/O loads across different physical drives. Two ways to do that are:
■

Disk Mirroring

■

Disk Striping

Disk Mirroring
Oracle log files and database files can be separated and treated with different levels
of hardware reliability. Oracle log files are highly reliable to start with, because they
are stored redundantly. Creating similar reliability for database files may require
you to duplicate all of your data, using disk mirrors.
Disk mirroring usually involves two or more identical drives and either a hardware
controller or Windows Disk Administrator. If one disk fails, then the other disk(s)
can be used to recover data that would otherwise be lost. Using one of the disks to
recover lost data may involve "breaking" the mirror. If the mirror breaks, then you
must build a new mirror.
Disk mirroring is part of some levels of Redundant Array of Independent Disks
(RAID) configurations, provided by the disk controller. The RAID level determines
the amount of redundancy. Some RAID levels can use the "hot swapping" feature,
which means that you can replace a bad disk with a good one without turning off
the computer or losing functionality.

Disk Striping
How you set up disks for use in a database depends on the number of disks and the
type of hard disk controllers available. If the hard disk controllers support both
striping and mirroring, then Oracle Corporation recommends you configure the
controllers to support striping.
Some controllers are configured at system startup time by issuing a keyboard
sequence that brings up configuration programs written by the controller
manufacturer. One goal is to stripe as many drives together as possible by
configuring the controllers. Each stripe shows up as one logical device.
Striping provides significant performance advantages. All the space from the
striped drives appears as a single logical drive. Furthermore, the space is used by
interlacing "stripes" of space from all of the disks in the stripe. This means that a
large file uses some space from the first disk, then some from the second disk and so
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on to the last disk and then starting back at the first disk again. Each file can be
spread over all of the striped disks. Data in such a file may be accessed randomly by
more than one CPU without contention.
Controllers that support striping usually provide caching as well. This means that
data can be written to the controller and cached and saved for a time in storage not
on the disk. Data that is read can be cached on the controller in a similar fashion.
Read caching is not necessary for Oracle databases, because all database reads are
cached already in the System Global Area. The value of the DB_BLOCK_BUFFERS
parameter in the initialization parameter file (init.ora) determines the number of
buffers that can be used in the SGA. This value also configures Oracle9i database on
startup.

Using Raw Partitions for Tablespaces
A raw partition is a portion of a physical disk that is accessed at the lowest possible
level. I/O of a raw partition improves performance by approximately 5% to 10%
compared to I/O of a partition containing a file system. Therefore, Oracle
Corporation encourages you to use raw partitions for your tablespace files.

Comparison Between OFA on Windows NT and UNIX
You implement OFA on Windows NT and UNIX in the same way. However,
differences exist with regard to the following:
■

Directory Naming

■

ORACLE_BASE Directory

■

Support for Symbolic Links on Windows NT
See Also: Your UNIX operating system-specific administrator’s
reference for information about OFA on UNIX

Directory Naming
Top-level names of the OFA directory tree differ between Windows NT and UNIX.
However, main subdirectory and filenames are the same on both operating systems.
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ORACLE_BASE Directory
On Windows, ORACLE_BASE is associated with an Oracle home directory. ORACLE_
BASE is defined in the registry (for example, in HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOME0).
On UNIX, ORACLE_BASE is associated with a UNIX user’s environment.

Support for Symbolic Links on Windows NT
The goal of OFA is to place all Oracle software under one ORACLE_BASE directory
and to spread files across different physical drives as your databases increase in
size.
On UNIX, although everything seems to be in one directory on the same hard drive,
files can be on different hard drives if they are symbolically linked or have that
directory as a mount point.
Windows NT currently does not support symbolic links, so datafiles will not all
show up under a single directory like on UNIX. Instead, you may have oradata
directories on multiple drives, with datafiles in each one. In this way, you still get
OFA benefits, even though datafiles are not all visible in a single directory.
Oracle Corporation recommends that you use one logical drive to store your
database administration files and that you place other files, as needed, on other
logical drives in an oradata\DB_NAME directory.
In the following example, there are four logical drives for a database named prod:
■

■

■

■

C:\ contains an Oracle home and database administration files.
F:\ contains redo log files. (F:\ drive could also represent two physical drives
that have been striped to increase performance.)
G:\ contains one of the control files and all tablespace files. (G:\ drive could
also use a RAID Level-5 configuration to increase reliability.)
H:\ contains the second control file.
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The directory structure would look similar to this:
C:\oracle
\ora92
\bin
\network
\...
\admin
\prod
\adhoc
\adump
\bdump
\cdump
\create
\exp
\pfile
\udump

--First logical drive
--Oracle home
--Subtree for Oracle binaries
--Subtree for Oracle Net

F:\oracle
\oradata
\prod

--Second logical drive (two physical drives, striped)
--Subtree for Oracle database files
--Subtree for prod database files
--Redo log file group one, member one
--Redo log file group two, member one
--Redo log file group three, member one

redo01.log
redo02.log
redo03.log
G:\oracle
\oradata
\prod
control01.ctl
indx01.dbf
rbs01.dbf
system01.dbf
temp01.dbf
users01.dbf
H:\oracle
\oradata
\prod
control02.ctl
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--Subtree for database administration files
--Subtree for prod database administration files
--Ad hoc SQL scripts
--Audit files
--Background process trace files
--Core dump files
--Database creation files
--Database export files
--Initialization parameter file
--User SQL trace files

--Third logical drive (RAID level 5 configuration)
--Subtree for Oracle database files
--Subtree for prod database files
--Control file 1
--Index tablespace datafile
--Rollback tablespace datafile
--System tablespace datafile
--Temporary tablespace datafile
--Users tablespace datafile
--Fourth logical drive
--Subtree for Oracle database files
--Subtree for prod database files
--Control file 2
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Oracle9i Services on Windows
This chapter describes Windows services in general and Oracle9i Database
Windows services in particular.
This chapter contains these topics:
■

Introduction to Oracle9i Services

■

Oracle9i Services Available on Windows

■

Using Oracle9i Services
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Introduction to Oracle9i Services

Introduction to Oracle9i Services
Oracle9i starts each instance as a service on Windows. A service is an executable
process registered in the Windows registry and administered by Windows. The
registry automatically tracks and records security information for each service
created.
Oracle also uses services, similar to Windows services, to provide support for its
operations. Oracle services are created during the database creation process and are
associated with the Oracle database. They are used to create, connect to, and use an
Oracle instance.
Services simplify the process of starting up the database. The database can be
configured to come up automatically when the computer is restarted, with no user
interaction. Another advantage of services is that they can start with a specified
user privilege.
Services start background processes, similar to daemon processes on UNIX. When
the Oracle database service starts, there is no typical Oracle thread running in the
process. Instead, the process waits for the first connection from SQL*Plus. This
causes a foreground thread to start and creates background threads of the System
Global Area.
When Oracle9i database is shut down, all threads that were created are terminated.
But the process itself continues, waiting for the next connection request and startup
command.
Finally, Oracle Net Listener is a service. This service needs to run before users can
connect to Oracle9i database. This process does not affect how clients connect to or
use Oracle9i database.

Oracle9i Services Available on Windows
Services are started manually or they can be set to start automatically when the
computer is restarted. By default, services run under the system user. However,
system is not a user that can create a logon session; rather, it is an operating system
session for running system services.
The following are some of the services available on Windows. You may have
additional services, depending on components you installed.

Oracle Object Service
Used by Oracle Object Link Manager to synchronize symbolic link naming to
logical volume mapping automatically on all nodes in a cluster.
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Oracle OLAP Agent
Back end for Oracle OLAP Instance Manager. Performs tasks specified in Instance
Manager, such as starting and stopping an OLAP service or changing its
configuration settings. Oracle OLAP Agent also returns information from the
operating system, such as success or failure of a startup attempt.

Oracle OLAP 9.0.1.0.0
Default OLAP service. Supports a calculation engine and multidimensional analytic
workspaces for analytical applications. Performs complex statistical, mathematical,
and financial calculations along with predictive analysis functions such as
forecasting, modeling, consolidations, allocations, and scenario management.

OracleCMService9i
Used for Cluster Manager for Oracle Real Application Clusters.

OracleDirectoryService_SID
Responsible for starting and shutting down all Oracle Internet Directory (OID)
servers (oidldapd, oidrepld, and oidmetad). Also monitors all OID servers
once they are up and running. If an OID server goes down, then
OracleDirectoryService_SID restarts it.

OracleEXTPRC
Used for external naming methods (Novell Directory Services and Network
Information Service).

OracleGSDService
Global Services Daemon (GSD) receives requests from SRVCTL to execute an
administrative job task, such as startup or shutdown. The task is executed locally on
all nodes, and results are sent back to SRVCTL. This service is installed with Real
Application Clusters.

OracleHOME_NAMEAgent
Part of Oracle Enterprise Manager product suite. Intelligent Agent is required for
execution of jobs and performance monitoring of Oracle services or targets such as
listeners, databases, Oracle HTTP Server, and Oracle Applications. Intelligent Agent
also collects statistical data for Capacity Planner and Performance Manager, which
are data-collecting applications available in Oracle Diagnostics Pack.
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OracleHOME_NAMEClientCache
Used for Client Cache Service, a networking product.

OracleHOME_NAMECMAdmin
Performs administrative functions, including answering requests sent from Oracle
Connection Manager Control utility, monitoring registered listeners, and
communicating address information to Oracle Names servers.

OracleHOME_NAMECMan
Listens for incoming client connection requests. It also provides session
multiplexing, access control, and protocol conversion functions.

OracleHOME_NAMEHTTPServer
Starts Oracle HTTP Server. Used as Web server with browser-based Oracle
Enterprise Manager.

OracleHOME_NAMEManagementServer
Management Server is the middle tier of Oracle Enterprise Manager. It maintains
centralized intelligence and distributed control between clients and managed nodes.

OracleHOME_NAMEPagingServer
Oracle Enterprise Manager Paging Server allows Enterprise Manager
administrators to receive paging notifications concerning registered events and
scheduled jobs.

OracleHOME_NAMETNSListener
Listens for and accepts incoming connection requests from client applications.
Automatically starts when the Windows computer restarts. If it is not started, then
the following error message appears when attempting to connect with
username/password@net_service_name:
ORA-12541 TNS: no listener

OracleMSCSService
Created and configured during installation of Oracle Fail Safe and Oracle Real
Application Clusters Guard. Required on all Windows clusters nodes where these
components are installed. OracleMSCSService is under the control of Microsoft
Cluster Server and should be set to manual startup.
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OracleMTSRecoveryService
Helps Oracle databases recover in-doubt Oracle transactions that were started on
behalf of Microsoft Transaction Server (MTS) transactions originating from
Windows NT and Windows 2000 computers. There is only one such service for each
Windows NT or Windows 2000 computer having Oracle Services for MTS installed.

Oracle NAMES
Used for the distributed naming service developed for Oracle environments.

OracleServiceSID
Created for the database instance system identifier, where SID is the value you
entered for the database name during Oracle9i installation. This service is
mandatory. If is it not started, then the following ORA-12560 error message
appears when you attempt to use any Oracle9i Utilities, such as SQL*Plus:
ORA-12560 TNS: protocol adapter error

OracleSNMPPeerEncapsulator
See OracleSNMPPeerMasterAgent. Encapsulator is only required when you have
more than one SNMP sub-agent installed and configured on the system.

OracleSNMPPeerMasterAgent
Simple Network Management Protocol (SNMP) is a standard internet protocol
enabling certain nodes in a network to query other network components or
applications for information concerning their status and activities. All requests sent
to a given network node are handled by the same Master Agent, which redirects
requests to appropriate managed elements on the node, in some cases using
subagents.

OraFenceService
A kernel mode service to provide I/O fencing. Restarts a node in case the node
hangs in kernel mode for a defined amount of time. The service is installed on all
nodes with OracleCMService9i.
Note: Oracle Fail Safe and Oracle Real Application Clusters
Guard are not supported on Windows XP.

Oracle9i Services on Windows
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Using Oracle9i Services
Oracle services appear in the Services dialog box of the Control Panel:

All Oracle services begin with "Ora". Use the Services dialog box to start or stop
each of the Oracle services available on the computer.
Services are found in the registry under:
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES.

See Also:
■

■
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Chapter 6, "Multiple Oracle Homes and Optimal Flexible
Architecture" for information on multiple, active Oracle home
directories on a single computer, which affects naming
conventions for Oracle services
"Administering a Database", in Oracle9i Database Administrator’s
Guide for Windows for details on managing Oracle services
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Oracle9i Default Accounts and Passwords
This chapter describes Oracle9i database default accounts and passwords.
This chapter contains these topics:
■

Overview

■

Unlocking and Changing Passwords

■

Granting Limited SYS Database Role Privileges

■

Reviewing Accounts and Passwords
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Overview
Oracle9i installs with a number of default accounts. Database Configuration
Assistant locks and expires all default database accounts upon successful
installation with the following exceptions:
■

SYS

■

SYSTEM

■

SCOTT

■

DBSNMP

You must unlock all other accounts before using them. Oracle Corporation
recommends changing all user passwords immediately after installation.
Note: If installing Oracle Internet Directory, then change
passwords for SYS and SYSTEM only after Oracle Internet Directory
installation is complete.

At a minimum, Database Configuration Assistant creates SYS, SYSTEM, and
DBSNMP accounts in all databases. Additional accounts are created depending on
components installed. Unlock accounts and change passwords before using them.
Table 8–2 describes accounts and passwords.
See Also:
■

■
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Oracle9i Security and Network Integration Guide for Windows and
Oracle Advanced Security Administrator’s Guide for information
on Oracle security procedures and security best practices
Oracle Enterprise Manager Administrator’s Guide for information
on security management
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Unlocking and Changing Passwords
At the end of installation, several configuration assistants automatically start to
create and configure your database and network environments. One such assistant
is Database Configuration Assistant, which automatically prompts you to change
passwords and unlock accounts immediately after installation.
To change a password during database installation and configuration:
1.

From the Database Configuration Assistant window, click Password
Management.
Note: Password Management is not available when using
Database Configuration Assistant as a standalone tool (that is, after
installation and configuration are complete).

2.

Select a username and clear the check mark.

3.

Enter a new password and confirm the new password for each username.
Note: If you unlock a password, but do not specify a new
password, then the password is expired until the next time you
access that account.

Alternatively, use SQL*Plus to unlock accounts and change passwords any time
after installation.
To change a password after installation:
1.

Start SQL*Plus:
C:\> sqlplus /NOLOG

2.

Connect as SYSDBA:
SQL> CONNECT / AS SYSDBA

Oracle9i Default Accounts and Passwords
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3.

Change the password according to SQL commands indicated in Table 8–1:

Table 8–1

SQL Statements for Administering Accounts and Passwords

Action

SQL Statement

Unlock a password

ALTER USER username ACCOUNT UNLOCK;

Lock a password

ALTER USER username ACCOUNT LOCK;

Change password of an unlocked account ALTER USER username IDENTIFIED BY
password;
Change password of a locked account

ALTER USER username IDENTIFIED BY
password ACCOUNT UNLOCK;

Note: For information on Oracle Enterprise Manager accounts
and passwords, see "Parameters for Oracle Performance Monitor
for Windows NT" on page 9-10 and "Modifying Oracle Performance
Monitor for Windows NT Parameters" on page 9-22.

Granting Limited SYS Database Role Privileges
Any database user can be granted a limited SYS database role privilege to use
Oracle Enterprise Manager Diagnostic Pack. Grant users access to these necessary
SYS privileges by granting the OEM_MONITOR role. This role is created when
Oracle9i database is installed and is defined in the SQL script at \ORACLE_
BASE\ORACLE_HOME\rdbms\admin\catsnmp.sql.
See Also: Oracle9i SQL Reference for information on the GRANT
statement

Reviewing Accounts and Passwords
Table 8–2 lists Oracle9i default accounts and passwords. It also briefly describes the
purpose of each username and shows where to find additional information.
Beginning with Oracle9i release 2 (9.2), the CREATE DATABASE statement enables
you to specify passwords for users SYS and SYSTEM. Default values shown in
Table 8–2 apply only if no password is specified. For more information, see
"Protecting Your Database: Specifying Passwords for Users SYS and SYSTEM" in
Oracle9i Database Administrator’s Guide.
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Table 8–2

Oracle9i Default Accounts and Passwords

Username

Password

Description

More Information

SYSTEM1

MANAGER

Used for performing database administration
tasks. SYSTEM includes AQ_
ADMINISTRATOR_ROLE, DBA, and SALES_
HISTORY_ROLE database roles.

Oracle9i Database
Administrator’s Guide

SYS2

CHANGE_ON_
INSTALL3

Used for performing database administration
tasks.

Oracle9i Database
Administrator’s Guide

ANONYMOUS

ANONYMOUS

Allows HTTP access to Oracle XML DB.

Not applicable

CTXSYS

CTXSYS

Oracle Text username with CONNECT, DBA,
and RESOURCE database roles.

Oracle Text Reference

DBSNMP

DBSNMP

Includes CONNECT and SELECT ANY
DICTIONARY database roles. Run
catnsnmp.sql if you want to drop this role
and user.

Oracle Intelligent Agent
User’s Guide

LBACSYS

LBACSYS

Oracle Label Security administrator username. Oracle Label Security
Administrator’s Guide

MDSYS

MDSYS

Oracle Spatial and Oracle Locator
administrator username.

OLAPSYS

MANAGER

Includes CONNECT, OLAP_DBA, and RESOURCE Oracle9i OLAP User’s
database roles
Guide

ORDPLUGINS

ORDPLUGINS

Oracle interMedia Audio and Video username Oracle interMedia User’s
with CONNECT and RESOURCE database roles. Guide and Reference
Allows non-native plug-in formats for one
session.

ORDSYS

ORDSYS

Oracle interMedia Audio, Video, Locator, and Oracle interMedia User’s
Image administrator username with CONNECT, Guide and Reference
JAVAUSERPRIV, and RESOURCE database
roles.

OUTLN

OUTLN

Centrally manages metadata associated with
stored outlines. Supports plan stability, which
maintains the same execution plans for the
same SQL statements. Includes CONNECT and
RESOURCE database roles.

Oracle9i Database
Concepts

Includes CONNECT and RESOURCE database
roles.

Oracle9i Database
Administrator’s Guide for
Windows

SCOTT

TIGER

Oracle Spatial User’s
Guide and Reference

Oracle9i Database
Performance Tuning
Guide and Reference
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Table 8–2 (Cont.) Oracle9i Default Accounts and Passwords (Cont.)
Username

Password

Description

More Information

WKSYS

WKSYS

Used for storing Ultra Search system
dictionaries and PL/SQL packages. WKSYS
includes CONNECT, CTXAPP, DBA,
JAVASYSPRIV, JAVAUSERPRIV, and
RESOURCE database roles.

Oracle Ultra Search
Online Documentation

WMSYS

WMSYS

WMSYS schema is used to store all metadata
information for Oracle Workspace Manager.
WMSYS includes CONNECT, RESOURCE, and
WM_ADMIN_ROLE database roles.

Oracle9i Application
Developer’s Guide Workspace Manager

XDB

CHANGE_ON_
INSTALL

Used for storing Oracle XML DB data and
metadata. Includes CONNECT and RESOURCE
database roles.

Not applicable

1

2

3

If installing Oracle Internet Directory, then change passwords for SYS and SYSTEM only after Oracle Internet Directory
installation is complete.
If installing Oracle Internet Directory, then change passwords for SYS and SYSTEM only after Oracle Internet Directory
installation is complete. SYS includes the following database roles: AQ_ADMINISTRATOR_ROLE, AQ_USER_ROLE,
CONNECT, CTXAPP, DBA, DELETE_CATALOG_ROLE, EXECUTE_CATALOG_ROLE, EXP_FULL_DATABASE, GATHER_
SYSTEM_STATISTICS, HS_ADMIN_ROLE, IMP_FULL_DATABASE, JAVA_ADMIN, JAVADEBUGPRIV, JAVA_DEPLOY,
JAVAIDPRIV, JAVAUSERPRIV, JAVASYSPRIV, LOGSTDBY_ADMINISTRATOR, OEM_MONITOR, OLAP_DBA, RECOVERY_
CATALOG_OWNER, RESOURCE, SELECT_CATALOG_ROLE, and WKUSER
SQL statement must include the privilege AS SYSDBA or AS SYSOPER.

See Also:
■

■
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"The Oracle Database Administrator" in Oracle9i Database
Administrator’s Guide
"Administering External Users and Roles" in Oracle9i Security
and Network Integration Guide for Windows
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Configuration Parameters and the Registry
This chapter describes use of the registry for various Oracle9i for Windows
components. It also lists recommended values and ranges for configuration
parameters.
This chapter contains these topics:
■

About Configuration Parameters

■

Registry Overview

■

Registry Parameters

■

Oracle Real Application Clusters Registry Parameters

■

Modifying a Registry Value with regedt32

■

Adding a Registry Parameter with regedt32

■

■

Adding or Modifying Registry Parameters with Oracle Administration
Assistant for Windows NT
Modifying Oracle Performance Monitor for Windows NT Parameters
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About Configuration Parameters
Oracle9i for Windows uses configuration parameters to locate files and specify
runtime parameters common to all Oracle products. When an Oracle program or
application requires a translation for a particular configuration variable, Oracle9i for
Windows uses the associated parameter. All Oracle parameters are stored in the
registry.

Registry Overview
Oracle9i for Windows stores its configuration information in a repository (the
registry) that is organized in a tree format. The tree format consists of keys in the
registry and parameter values for the keys. Keys and parameter values can be
viewed and modified in Registry Editor.
Keys are folders that appear in the left pane of a Registry Editor window. A key
contains subkeys or parameters.
Caution: Although Registry Editor lets you view and modify
registry keys and parameter values, you normally are not required
to do so. In fact, you can render your system useless if you make
incorrect changes. Therefore, only advanced users should edit the
registry! Back up your system before making any changes in the
registry.

Parameters in Registry Editor appear as a string, consisting of three components:
■

Parameter name

■

Value class or type of entry

■

Value itself

For example, parameter ORACLE_SID can have the following entry in the registry:
ORACLE_SID:reg_sz:orcl1
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Value classes for Oracle9i for Windows parameters are:
■

■

String value with a REG_SZ, REG_EXPAND_SZ (for an expandable string), or a
REG_MULTI_SZ (for multiple strings) prefix to identify a parameter value entry
as a data string
Binary value with a REG_DWORD prefix to identify a value entry as a dword
(hexadecimal data) entry

Most Oracle9i for Windows parameter values are string types. Use Oracle Universal
Installer defaults when a type is not given.

Registry Parameters
This section describes Oracle9i for Windows registry parameters for the following
keys. Other products, such as Oracle Enterprise Manager, have additional keys and
parameters that are not described in this chapter.
■

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID

■

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE

■

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES

■

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services

To modify these registry values, see "Modifying a Registry Value with regedt32" on
page 9-14.
Note: This chapter describes how to use regedt32 to edit your
registry. If you are using Windows 98, then you must use regedit,
which operates slightly differently than regedt32. See your
Windows 98 documentation for instructions.
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HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID
Each time you install Oracle products into a new Oracle home on your computer,
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID is created and ID is
incremented. This subkey contains parameter values for most Oracle products.
Note: See Chapter 6, "Multiple Oracle Homes and Optimal
Flexible Architecture" for details on the PATH variable and registry
values when you are working with multiple Oracle homes.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID includes the following
parameters for an Oracle home directory. Depending on products you install,
additional parameters can also be created. See your Windows development
manuals.

MSHELP_TOOLS
Specifies the location of Windows help files. Default value is ORACLE_
BASE\ORACLE_HOME\mshelp.

NLS_LANG
Specifies supported language, territory, and character set. This parameter specifies
the language in which messages appear, the territory and its conventions for
calculating week and day numbers, and the character set displayed. Oracle
Universal Installer sets this value during installation based on the language setting
of the operating system. See Oracle9i Database Globalization Support Guide for a list of
values.

ORA_CWD
Specifies current working directory. For example, if you set this parameter and then
use ORADIM, a log file called oradim.log is created in this directory. This parameter
must be manually set.

ORA_SID_AUTOSTART
Starts Oracle9i database when OracleServiceSID service is started. Default
value is true.
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ORA_SID_PFILE
Specifies full path to initialization parameter file (init.ora). Default value is
ORACLE_BASE\admin\DB_NAME\pfile\init.ora

ORA_SID_SHUTDOWN
When set to true, the default value, this parameter shuts down the Oracle database
identified by SID when OracleServiceSID is stopped.

ORA_SID_SHUTDOWN_TIMEOUT
Sets maximum time (in seconds) to wait for shutdown to complete before the
service for a particular SID stops. Default value is 30.

ORA_SID_SHUTDOWNTYPE
Specifies mode in which Oracle9i database is shut down when you stop
OracleServiceSID. Valid values are a (abort), i (immediate), and n (normal).
Default value is i.

ORA_TZFILE
Specifies location of time zone file. Each file contains:
■

Valid time zone names

■

Offset from UTC

■

Abbreviation for standard time

■

Abbreviation for daylight savings time

Default is ORACLE_BASE\ORACLE_HOME\oracore\zoneinfo\timezone.dat.
It contains most commonly used time zones and is smaller for better database
performance. The optional file, timezlrg.dat, includes time zones not defined in
the default; but its use may affect database performance. To enable use of the
optional file, the database administrator must:
1.

Shut down Oracle9i database.

2.

Set ORA_TZFILE to the full path name of the location of timezlrg.dat file.

3.

Restart Oracle9i database.

To view time zone names, use SQL*Plus to make the following query:
SELECT * from v$timezone_names
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Once the larger file is used, it must stay in use unless the user is sure that no data
uses one of the added time zones. Also, all databases that share information must
use the same time zone file.

ORACLE_AFFINITY
Specifies Windows NT processor affinity of each thread within the Oracle process.
This parameter must be manually added. Oracle Corporation recommends
consulting Oracle Support Services before changing this parameter. The format is:
name1:cpumask1;name2:cpumask2

Each name setting must be the name of a background thread, user for
non-background (shadow) threads, or def for any thread type not handled
specifically.
The name mask sets the affinity mask of the Oracle process. Valid background
thread names include DBW0, LGWR, PMON, SMON, ARCH, RECO, CKPT, TRWR, SNP0
through SNP9, P000 through P481, and any other name found in the NAME column
of the v$bgprocess data dictionary view.
Each affinity setting must be a valid affinity mask (or its numeric equivalent) for the
corresponding name. Process affinity masks are used only when Oracle services are
first started. Each thread’s affinity is set only when the individual thread is started
(for example, at database startup time for the background threads).

ORACLE_BASE
Specifies the top-level Oracle directory (for example, C:\oracle) that contains
ORACLE_HOME, \admin, and \oradata. Default is ORACLE_BASE.

ORACLE_GROUP_NAME
Specifies the name of the group containing icons of the Oracle products installed.
The parameter is added to your registry when you first install Oracle products,
even if Oracle Universal Installer does not create a program group for Oracle
products you have installed (for example, if you have installed only Oracle Net
software). Default value is Oracle - HOME_NAME.

ORACLE_HOME
Specifies Oracle home directory in which Oracle products are installed. This
directory is immediately beneath the Oracle base directory in the Oracle directory
hierarchy. Default value is drive letter and name that you specify during
installation.
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ORACLE_HOME_KEY
The HKEY_LOCAL_MACHINE location of Oracle parameters. Default value is
software\oracle\HOMEID.

ORACLE_HOME_NAME
Specifies home name of Oracle home directory in which Oracle products are
installed. Default value is name that you specify during installation.

ORACLE_PRIORITY
Determines Windows NT scheduling priorities of threads within the Oracle
database management system process. The format is:
name1:priority1;name2:priority2 . . .

The name class sets the priority class of the Oracle process. Threads can be
assigned priority either collectively or individually. The collective name user
designates non-background (shadow) threads; the collective name def designates
any thread type not handled specifically. Valid individual background thread names
include DBW0, LGWR, PMON, SMON, ARCH0, RECO, CKPT, TRWR, SNP0 through SNP9,
and any other name found in the NAME column of the v$bgprocess data
dictionary view.
Default value is class:normal; def:normal.
Note: ORACLE_PRIORITY is not automatically created for you in
the registry. When it is not defined in the registry, Windows NT
default values are used for thread priorities.

ORACLE_SID
Specifies name of Oracle9i database instance on host computer. The value of this
parameter is the SID for the instance. Default value is specified by entry in the
Database Identification window of Oracle Universal Installer.

RDBMS_ARCHIVE
Specifies location of backup database files. Default value is ORACLE_
BASE\ORACLE_HOME\database\archive.
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OSAUTH_PREFIX_DOMAIN
Enables user authentication. When set to true, enables server to differentiate
between one username and another, whether they are local users, domain users, or
domain users on another domain in your network. When set to false, domain is
ignored, and the local user becomes the default value of the operating system user
returned to server. Default value is false.

OSAUTH_X509_NAME
Enables client users to access Oracle9i database as X.509-compliant enterprise users.
This parameter is required only if you want to use enterprise users and roles in an
Oracle9i database computer running in a Windows 2000 domain. Default value is
false.

RDBMS_CONTROL
Specifies location of backup database control files. Default value is ORACLE_
BASE\ORACLE_HOME\database.

SQLPATH
Specifies location of SQL scripts. Default value is ORACLE_BASE\ORACLE_
HOME\dbs.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
This subkey contains the following parameters:

INST_LOC
Specifies location of Oracle Universal Installer files. Default value is System
Drive:\program files\oracle\inventory.

OO4O
Specifies location of Oracle Objects for OLE message files. Default value is ORACLE_
BASE\ORACLE_HOME\oo4o\mesg.
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HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ALL_HOMES
This subkey provides general information on each Oracle home directory on a
computer.

DEFAULT_HOME
Specifies default Oracle home name (that is, the first Oracle home installed on your
computer). Default value is name that you specify during installation. You can also
use an Oracle tool to change the default home name. See "Using Oracle Home
Selector" on page 6-8.

HOME_COUNTER
Specifies the number of installed Oracle homes. Default value is 1.

LAST_HOME
Displays ID number of most recently installed Oracle home. For example, if HOME0
was most recently installed Oracle home, then number 0 appears. Default value is
0.

IDx
This subkey corresponds to HOMEID of the same number (for example, HOME0 for
the first installation, HOME1 for the second installation, and so on). IDx contains
NAME and PATH parameters. Values that appear are determined by what you enter
during installation in the File Locations window of Oracle Universal Installer.
■

■

NAME specifies home name of the Oracle home for IDx. This is the value that
you specify during installation when prompted for an Oracle home name.
PATH specifies Oracle home directory for IDx. Default value is ORACLE_
BASE\ORACLE_HOME.

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet contains four keys:
■

Control

■

Enum

■

HardwareProfiles

■

Services
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9-9

Registry Parameters

The first three are used by the operating system. You can edit only the Services
subkey, which contains:
■

Parameters for Oracle Performance Monitor for Windows NT

■

Parameters for Oracle Services

Parameters for Oracle Performance Monitor for Windows NT
Oracle Performance Monitor for Windows NT parameters appear in HKEY_LOCAL_
MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES\ORACLE9\PERFORMANCE.
Note: Modify only the hostname, password, and username
values to point to any database. Oracle Corporation recommends
that you use OPERFCFG utility. See "Using OPERFCFG Utility" on
page 9-23.

For Oracle Performance Monitor to display information for Oracle performance
objects, it must log in to the database. Modify the following parameters if the
default information is not applicable or if you want to access another database:
■

Hostname displays the SID of the database that Oracle Performance Monitor
for Windows NT will connect to. Default value is blank, causing Oracle
Performance Monitor to connect to the default database on the computer.
If you specify a different SID, you must also add a connect descriptor for that
SID to your tnsnames.ora file. Oracle Corporation recommends that you use
Oracle Net Configuration Assistant, but you can also copy, paste, and modify
the following example:
SERVICE_NAME =
(DESCRIPTION =
(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP)(HOST = HOST_NAME)(PORT = 1521))
)
(CONNECT_DATA =
(SERVER = DEDICATED)
(SERVICE_NAME = SERVICE_NAME)
)
)
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■

■

Password displays the encrypted password for the username to access the
database. Default value is MANAGER (encrypted).
Username displays the username to access the database. Default value is
SYSTEM.

Oracle Performance Monitor for Windows NT requires the following parameters as
entry points:
■

■

■

■

Close specifies the close entry point for the DLL. Default value is
CloseOracle9PerformanceData.
Collect specifies the collect entry point for the DLL. Default value is
CollectOracle9PerformanceData.
Library specifies the name of the Oracle Performance Monitor DLL. Default
value is oraperf.dll
Open specifies the open entry point for the DLL. Default value is
OpenOracle9PerformanceData.

The following parameters specify Oracle Performance Monitor for Windows NT log
file and object configuration files:
■

■

LOGFILE specifies the name of the Oracle Performance Monitor log file. This
log file reports any errors, such as Oracle objects not appearing or database
access problems. Default value is ORACLE_BASE\ORACLE_
HOME\dbs\operf90.log.
PERF_FILE_NAME specifies the location of the perf.ora file, which contains all
performance objects displayed by Oracle Performance Monitor. Default value is
ORACLE_BASE\ORACLE_HOME\dbs\perf90.ora

Parameters for Oracle Services
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES subkey
contains additional subkeys that correspond to each Oracle service.
Each service subkey contains the following parameters:
■

DisplayName specifies the service name of the instance whose SID is SID.
Default value is the name of the service. For example, OracleServiceORCL1,
where ORCL1 is the SID.
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■

■

ImagePath specifies the fully qualified path name of the executable started by
the service and any command-line arguments passed into the executable at
runtime. Default value is the path to the executable file of the product.
ObjectName specifies the logon user account and computer to which the
service should log on. Default value is LocalSystem.

Oracle Real Application Clusters Registry Parameters
Oracle Real Application Clusters registry values are based on Oracle Corporation’s
Operating System Dependent (OSD) clusterware. If you are not using Oracle OSDs,
then some of this information may not be applicable to your particular cluster
environment.
Note: Oracle Real Application Clusters is not supported on
Windows XP.

Registry values are first listed and described (where necessary). Data types and
default values are displayed in Table 9–1, " Oracle Real Application Clusters
Registry Parameters"

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\OSD9I
This subkey contains the following required and optional values:
■

CMDLL specifies the full path of the Cluster Manager (CM) DLL.

■

IODLL specifies the full path of the I/O DLL.

■

IPCDLL specifies the full path of the Inter-Process Communication (IPC) DLL.

■

STARTDLL specifies the full path of the Startup DLL.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\OSD9I\CM
This subkey contains Cluster Manager registry values. These values are updated
when Oracle OSD clusterware is installed.
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■

ClusterID

■

ClusterName

■

CmDiskFile
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■

■

■

■

■

■

CmHostName is for public host names used by the local Cluster Manager.
Useful in a multihost environment, when more than one network is available on
the node.
DefinedNodes specifies names for the nodes in a private network. Oracle OSD
clusterware uses these addresses for its interconnect traffic.
MissCount defines the number of check-in intervals that can be missed before
a Cluster Manager and its related node are declared down by the cluster.
PollInterval defines the check-in time among Cluster Managers on different
nodes. Each Cluster Manager is expected to send at least one status packet to all
other nodes for each poll interval.
PublicNames specifies public node names in the public network (known as
DNS host names).
ServiceName

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\OSD9I\IPC
This subkey contains Inter-Process Communication (IPC) registry values. These
values are updated when Oracle OSD clusterware is installed.
■

■

DeviceNic is for use with Virtual Interface Architecture (VIA) hardware. Nic
refers to Network Interface Card.
InstanceID contains VIA MAC addresses of all nodes.

Configuration Parameters and the Registry 9-13

Modifying a Registry Value with regedt32

Parameter Data Types and Default Values
Table 9–1

Oracle Real Application Clusters Registry Parameters

Parameter Name

Type

Default Value

CMDLL

REG_SZ

\winnt\system32\osd9i\cm.dll

IODLL

REG_SZ

\winnt\system32\osd9i\io.dll

IPCDLL

REG_SZ

\winnt\system32\osd9i\ipc.dll

STARTDLL

REG_SZ

\winnt\system32\osd9i\start.dll

ClusterID

REG_DWORD

0

ClusterName

REG_SZ

Oracle Cluster Manager 9I

CmDiskFile

REG_SZ

\\. \opsm

CmHostName

REG_SZ

hostname

DefinedNodes

REG_MULTI_SZ

hostname

MissCount

REG_MULTI_SZ

3

PollInterval

REG_DWORD

1000 (milliseconds)

PublicNames

REG_MULTI_SZ

hostname

DeviceNic

REG_SZ

nic0

InstanceID

REG_MULTI_SZ

not applicable

Modifying a Registry Value with regedt32
Caution: Do not edit your registry unless absolutely necessary. If
an error occurs in your registry, then Oracle9i for Windows can stop
functioning, and the registry itself can become unusable.

To edit Oracle-related settings:
1.

Start Registry Editor in one of two ways:
■

From the command prompt, enter:
C:\> regedt32

■
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Choose Start > Run, enter regedt32 in the Open field, and click OK.
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Note: Use regedit to edit the registry on Windows 98. The
dialog boxes for adding a registry parameter using regedit are
slightly different from those for regedt32. See your Windows 98
documentation for specific instructions.

The Registry Editor window appears.
2.

Navigate to the values you want to view or modify by double-clicking
appropriate keys.
The left-hand side of the window shows the hierarchy of registry keys, and the
right-hand side of the window shows various values associated with a key.

3.

Double-click the parameter to edit.
The String Editor dialog box appears:

4.

Make any necessary edits.

5.

Click OK.

6.

Choose Exit from the Registry Editor menu.
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Adding a Registry Parameter with regedt32
To add a parameter to the registry:
1.

Start Registry Editor in one of two ways:
■

From the command prompt, enter:
C:\> regedt32

■

Choose Start > Run, enter regedt32 in the Open field, and click OK.
Note: Use regedit to edit the registry on Windows 98. The
dialog boxes for adding a registry parameter using regedit are
slightly different than those described in the following steps for
regedt32. See your Windows 98 documentation for specific
instructions.

The Registry Editor window appears.
2.

Navigate to the key to which you want to add the new value.

3.

Choose Add Value from the Edit menu.
The Add Value dialog box appears:

4.
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In the Value Name text box, type the name of the value that you want to add to
the currently selected key.
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5.

In the Data Type list, select the data type that you want to assign to the added
value:
■

■

6.

REG_SZ, REG_EXPAND_SZ (for an expandable string), or REG_MULTI_SZ
(for multiple strings) for a data string
Binary value with a REG_DWORD prefix to identify a value entry as a DWORD
(hexadecimal data) entry

Click OK.
The String Editor dialog box appears:

7.

Type the value for the parameter.

8.

Click OK.
Registry Editor adds the parameter.

9.

Choose Exit from the Registry Editor menu.

Adding or Modifying Registry Parameters with Oracle Administration
Assistant for Windows NT
Instead of using regedt32 to add, edit, and delete parameters for an Oracle home,
you can use Oracle Home Configuration snap-in, one of several snap-ins included
as part of Oracle Administration Assistant for Windows NT. You must have
Microsoft Management Console on your computer to use this product. Oracle
home parameters are located in key HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOMEID.
See "HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID" on page 9-4
for more information about Oracle home parameters.
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Starting Oracle Administration Assistant for Windows NT
To start Oracle Administration Assistant for Windows NT:
1.

Choose Start > Programs > Oracle - HOME_NAME > Configuration and
Migration Tools > Administration Assistant for Windows NT.
Oracle Administration Assistant for Windows NT starts.
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2.

Expand Oracle Homes.

3.

Right-click the Oracle home that you want to modify.
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4.

Click Properties. The Properties dialog box appears.
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Adding Oracle Home Parameters
To add an Oracle home parameter:
1.

Click Add in the Properties dialog box.
The Add Value dialog box appears.

2.

Enter the name in the Parameter Name text box.

3.

Enter the value in the Parameter Value text box.

4.

Click OK.

5.

Click Apply.
Note: With Oracle Administration Assistant for Windows NT, you
can add parameters only with a datatype of REG_SZ. Use
regedt32 to add parameters with a datatype of REG_EXPAND_
SZ, REG_MULTI_SZ, or REG_DWORD.
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Editing Oracle Home Parameters
To change the default SID, select the SID from the Default SID list in the Properties
dialog box. To edit one of the other parameters:
1.

Select the parameter in the Other Settings text box in the Properties dialog box.

2.

Click Edit.

Configuration Parameters and the Registry 9-21

Modifying Oracle Performance Monitor for Windows NT Parameters

The Edit Value dialog box appears.

3.

Modify the value.

4.

Click OK.

5.

Click Apply.

Deleting Oracle Home Parameters
To delete an Oracle home parameter:
1.

Select the parameter in the Other Settings text box in the Properties dialog box.

2.

Click Delete.

Modifying Oracle Performance Monitor for Windows NT Parameters
Instead of using regedt32 to modify Oracle Performance Monitor’s Hostname,
Password, and Username parameters, you can use Oracle’s OPERFCFG utility or
Oracle Administration Assistant for Windows NT.
See Also: "Parameters for Oracle Performance Monitor for
Windows NT" on page 9-10 for more information about Hostname,
Password, and Username parameters
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Using OPERFCFG Utility
OPERFCFG utility is an Oracle tool that you run from the command prompt. Use
this syntax:
operfcfg [-U username] [-P password] [-D database_name]

where:
■

■

■

username is the username registry parameter value that Oracle Performance
Monitor uses to log in to the database. You must have a DBA privilege on this
database.
password is the password registry parameter value for username.
database_name is the net service name that Oracle Performance Monitor uses
to connect to the database. It affects the Hostname registry parameter. The net
service name corresponds to the SID of the database that you want to monitor.
The -D command can be specified without providing a database name value.

The -U, -P, and -D commands are all optional.
The following examples illustrate use of OPERFCFG utility. First, to change
username to dba_admin, password to frank, and leave database name at its
current value, you would enter:
C:\> operfcfg -U dba_admin -P frank

To change username to dba_admin, password to frank, and database name to
prod, you would enter:
C:\> operfcfg -U dba_admin -P frank -D prod

To change password to frank for the current username and database name, you
would enter:
C:\> operfcfg -P frank

In the final example, you change Hostname to a blank value, causing Oracle
Performance Monitor to connect to the default database on the computer. The
current username and password must be valid user accounts on this database.
Enter:
C:\> operfcfg -D
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Using Oracle Administration Assistant for Windows NT
Oracle Performance Monitor snap-in is part of Oracle Administration Assistant for
Windows NT. You must have Microsoft Management Console on your computer in
order to use this product.
To use Oracle Performance Monitoring snap-in:
1.

Choose Start > Programs > Oracle - HOME_NAME > Configuration and
Migration Tools > Administration Assistant for Windows NT.
Oracle Administration Assistant for Windows NT starts.

2.

Right-click Performance Monitor.

3.

Click Properties.
The Performance Monitor Properties dialog box appears.
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4.

Modify the text in the Username, Password, or Database text boxes.

5.

Click Apply.
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Developing Applications for Windows
This chapter points to sources of information on developing applications for
Windows and outlines a procedure for building and debugging external
procedures.
This chapter contains these topics:
■

Finding Information on Application Development for Windows

■

Developing Windows Applications

■

Building External Procedures

■

Debugging External Procedures

■

Accessing Web Data with Intercartridge Exchange
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Finding Information on Application Development for Windows
This section describes where to find information on developing applications
specifically for Windows. These products are included on your Oracle Server
CD-ROM.

Java Enhancements
Oracle9i includes an integrated Java Virtual Machine and JServer Accelerator.
Oracle also provides Oracle Java Database Connectivity (JDBC) Drivers. For more
information, see Oracle9i Java Developer’s Guide.

XML Support
Oracle's XML products include XML Developer’s Kit (XDK) and Oracle XML SQL
Utility. For more information:
■

Oracle9i XML Developer’s Kits Guide - XDK

■

Oracle9i XML API Reference - XDK and Oracle XML DB

Support for Internet Applications
Oracle’s support for internet applications includes Oracle Portal, which enables you
to publish your data to the Web, Oracle HTTP Server, and PL/SQL Embedded
Gateway, which offers PL/SQL procedures stored in an Oracle9i database that can
be started through browsers. For more information:
■

Oracle Portal Installation Guide and Tutorial

■

Oracle Enterprise Manager Configuration Guide
Note: Oracle Portal is available on a separate CD-ROM and
included with Oracle9i for Windows.

Application Wizards
Oracle Application Wizards allow developers to create database applications easily
and quickly. They improve ease-of-use and reduce development time by generating
much of the code for database connectivity. For information and downloads:
■
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Oracle COM/COM+ Integration Feature
Oracle’s COM/COM+ integration feature enables Java stored procedure developers
and COM/COM+ developers to load COM+ objects from Oracle9i database. For
more information:
■

Oracle COM Automation Feature Developer’s Guide

■

Oracle Objects for OLE

ORACLEMTSRecoveryService
Oracle9i for Windows permits enhanced deployment of COM/COM+ components
in Microsoft Transaction Server, using an Oracle database as the resource manager.
For more information:
■

Oracle Services for Microsoft Transaction Server Developer’s Guide

Pro*C/C++ and Pro*COBOL Applications
■

Pro*C/C++ Precompiler Getting Started for Windows

■

Pro*COBOL Precompiler Getting Started for Windows

■

Oracle Call Interface Getting Started for Windows

■

Oracle Provider for OLE DB Developer’s Guide

OLE DB

Note: Oracle ODBC Driver is updated on a regular basis. Release
9.0 is included on your CD-ROM. To download the latest release,
visit: http://technet.oracle.com/software/

Select Oracle ODBC Drivers from the Select a Utility or Driver list.
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Developing Windows Applications
Oracle provides a comprehensive set of APIs for Windows application developers
and is well suited for both Java and COM/COM+ development. Oracle is
integrated with Microsoft’s development and deployment components, known as
Windows Distributed interNet Applications Architecture (DNA). Performance and
data access on Windows is enhanced in the following areas:
■

Wide variety of data access methods for Windows and internet applications

■

Wizards and assistants to speed application development

■

COM/COM+/DCOM integration through two APIs: Oracle Objects for OLE or
Oracle Provider for OLE DB

■

Microsoft Transaction Server integration: ORACLEMTSRecoveryService

■

Platform extensions for internet application development

Developers are able to deploy their database applications more quickly by using the
data access method with which they are familiar, rather than having to learn a new
one. An Oracle database server can communicate with Windows clients in a variety
of methods, as described in Table 10–1
Table 10–1

Oracle Data Access Methods

Development
Environment

Data Access Method

Java

JDBC
SQLJ

COM/COM+

Oracle Objects for OLE (OO4O)
Oracle Provider for OLE DB
COM/COM+ Automation Feature

By using Oracle data access interfaces, developers can take advantage of specific
Oracle9i features. These interfaces also offer flexibility and adherence to open
standards.
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Oracle COM/COM+ interfaces include the following features:
■

■

■

OO4O can be used from any programming environment that supports
Microsoft COM/COM+ technology, such as Visual Basic, Visual C++, VBA in
Excel, Active Server Pages, PowerBuilder, Delphi, Internet Information Server
(IIS), and Microsoft Transaction Server. OO4O is developed specifically for use
with Oracle database servers.
Oracle Provider for OLE DB gives ActiveX Data Objects (ADO) developers high
performance and efficient access to Oracle databases. A native OLE DB
provider, it offers data access optimizations and access to Oracle-specific
database features.
COM/COM+ Automation Feature APIs make it easy for PL/SQL developers to
incorporate COM/COM+ objects into their routines. A new extension of this
feature, Oracle COM/COM+ Integration, enables Java stored procedures and
COM/COM+ developers to load COM/COM+ objects through OLE
Automation or custom COM/COM+ interfaces from Oracle9i database.

Developing Internet Applications
Oracle provides Windows extensions for internet development, enabling access
from any client, such as:
■

Any browser

■

Windows or Macintosh client

■

FTP client

■

Database client

■

COM/COM+ client

■

E-mail client

Oracle data access interfaces and development tools, along with Microsoft
Transaction Server integration, can be used to build internet applications, as
illustrated in Figure 10–1, "Microsoft Transaction Server and Oracle Database
Integration".
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Figure 10–1 Microsoft Transaction Server and Oracle Database Integration
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This section describes how to create and use external procedures on Windows. The
following files are located in ORACLE_BASE\ORACLE_HOME\rdbms\extproc:
■

extern.c Code example shown in "Task 2: Writing an External Procedure"

■

make.bat Batch file that builds the dynamic link library

■

extern.sql Automates the instructions described in "Task 4: Registering an
External Procedure" and "Task 5: Executing an External Procedure"

External Procedures Overview
External procedures are functions written in a third-generation language (C, for
example) and callable from within PL/SQL or SQL as if they were a PL/SQL
routine or function. External procedures let you take advantage of strengths and
capabilities of a third-generation programming language in a PL/SQL environment.
Note: Oracle also provides a special purpose interface, the call
specification, that lets you call external procedures from other
languages, as long as they are callable by C.

The main advantages of external procedures are:
■

■

Performance, because some tasks are performed more efficiently in a
third-generation language than in PL/SQL, which is better suited for SQL
transaction processing
Code re-usability, because dynamic link libraries (DLLs) can be called directly
from PL/SQL programs on the server or in client tools such as Oracle Forms

You can use external procedures to perform specific processes:
■

Solving scientific and engineering problems

■

Analyzing data

■

Controlling real-time devices and processes

To create and use an external procedure, perform the following sequential steps:
■

Task 1: Installing and Configuring

■

Task 2: Writing an External Procedure

■

Task 3: Building a DLL
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■

Task 4: Registering an External Procedure

■

Task 5: Executing an External Procedure
Note: You must have a C compiler and linker installed on your
system to build DLLs.

Attention: You can combine the instructions described in the
fourth and fifth tasks into one SQL script that automates the task of
registering and executing your external procedure. For an example
of a SQL script that combines these steps, see

ORACLE_BASE\ORACLE_HOME\rdbms\extproc\extern.sql

Task 1: Installing and Configuring
This section describes installation and configuration of Oracle9i database and
Oracle Net.

Installing Oracle9i Database
Follow the steps in Oracle9i Database Installation Guide for Windows to install these
products on your Windows server:
■

Oracle9i Enterprise Edition, Oracle9i Standard Edition, or Oracle9i Personal
Edition. Each type contains PL/SQL, from which external procedures are called,
and the PL/SQL external procedure program (EXTPROC), which runs external
procedures.

■

Oracle Net Services

■

Oracle Protocol Support

Configuring Oracle Net Services
During database server installation, Oracle Net Configuration Assistant configures
listener.ora and tnsnames.ora files for external procedure calls.
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When an application calls an external procedure, Oracle Net Listener starts an
external procedure agent called EXTPROC. Using a network connection established
by the listener, the application passes the following information to EXTPROC:
■

DLL name

■

External procedure name

■

Parameters (if necessary)

EXTPROC then loads the DLL, runs the external procedure, and passes back any
values returned by the external procedure.
If you overwrite default listener.ora and tnsnames.ora files, then you must
manually configure the following files for the external procedure behavior
described previously to occur:
■

ORACLE_BASE\ORACLE_HOME\network\admin\listener.ora

■

ORACLE_BASE\ORACLE_HOME\network\admin\tnsnames.ora
Caution: Additional security may be required for the listener in a
production environment. See Oracle9i Net Services Administrator’s
Guide for more information.

Task 2: Writing an External Procedure
Using a third-generation programming language, you can write functions to be
built into DLLs and started by EXTPROC. The following is a simple Microsoft
Visual C++ example of an external procedure:
Note: Because external procedures are built into DLLs, they must
be explicitly exported. In this example, the DLLEXPORT storage
class modifier exports the function FIND_MAX from a dynamic link
library.
#include <windows.h>
#define NullValue -1
/*
This function tests if x is at least as big as y.
*/
long __declspec(dllexport) find_max(long x,
short x_indicator,
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long y,
short y_indicator,
short *ret_indicator)
{
/* It can be tricky to debug DLL’s that are being called by a process
that is spawned only when needed, as in this case.
Therefore try using the DebugBreak(); command.
This will start your debugger. Uncomment the line with DebugBreak();
in it and you can step right into your code.
*/
/* DebugBreak(); */
/* First check to see if you have any nulls. */
/* Just return a null if either x or y is null. */
if ( x_indicator==NullValue || y_indicator==NullValue) {
*ret_indicator = NullValue;
return(0);
} else {
*ret_indicator = 0;
/* Signify that return value is not null. */
if (x >= y) return x;
else return y;
}
}

Task 3: Building a DLL
After writing your external procedure(s) in a third-generation programming
language, use the appropriate compiler and linker to build a DLL, making sure to
export the external procedures as noted previously. See your compiler and linker
documentation for instructions on building a DLL and exporting its functions.
After building the DLL, you can move it to any directory on your system. For the
example in Task 2, you can build the external procedure find_max into a DLL
called extern.dll by going to ORACLE_BASE\ORACLE_HOME\rdbms\extproc
and typing make.

10-10 Oracle9i Database Getting Started

Building External Procedures

Task 4: Registering an External Procedure
Once you have built a DLL containing your external procedure(s), you must register
your external procedure(s) with Oracle9i database:
To create a PL/SQL library to map to the DLL:
1.

Start SQL*Plus:
C:\> sqlplus

2.

Connect to the database with appropriate username and password.

3.

Create the PL/SQL library using the CREATE LIBRARY command:
SQL> CREATE LIBRARY externProcedures AS ’C:\oracle\ora92\rdbms\
extproc\extern.dll’;

where externProcedures is an alias library (essentially a schema object in
the database), and C:\oracle\ora92\rdbms\extproc\extern.dll is the
path to the Windows operating system dllextern.dll. This example uses
C:\oracle as your Oracle base and \ora92 as your Oracle home.
Note: The DBA must grant the EXECUTE privilege on the PL/SQL
library to users who want to call the library’s external procedure
from PL/SQL or SQL.
4.

Create a PL/SQL program unit specification.
Do this by writing a PL/SQL subprogram that uses the EXTERNAL clause
instead of declarations and a BEGIN...END block. The EXTERNAL clause is the
interface between PL/SQL and the external procedure. The EXTERNAL clause
identifies the following information about the external procedure:
■

Name

■

DLL alias

■

Programming language in which it was written

■

Calling standard (defaults to C if omitted)
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In the following example, externProcedures is a DLL alias. You need the
EXECUTE privilege for this library. The external procedure to call is find_max.
If enclosed in double quotation marks, it becomes case-sensitive. The
LANGUAGE term specifies the language in which the external procedure was
written.
CREATE OR REPLACE FUNCTION PLS_MAX(
x BINARY_INTEGER,
y BINARY_INTEGER)
RETURN BINARY_INTEGER AS
EXTERNAL LIBRARY externProcedures
NAME "find_max"
LANGUAGE C
PARAMETERS (
x long,
-- stores value of x
x_INDICATOR short,
-- used to determine if x is a NULL value
y long,
-- stores value of y
y_INDICATOR short
-- used to determine if y is a NULL value
RETURN INDICATOR short ); -- need to pass pointer to return value’s
-- indicator variable to determine if NULL
-- This means that my function will be defined as:
-- long max(long x, short x_indicator,
-- long y, short y_indicator, short * ret_indicator)

Task 5: Executing an External Procedure
To run an external procedure, you must call the PL/SQL program unit (that is, the
alias for the external function) that registered the external procedure. These calls can
appear in any of the following:
■

Anonymous blocks

■

Standalone and packaged subprograms

■

Methods of an object type

■

Database triggers

■

SQL statements (calls to packaged functions only)
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In "Task 4: Registering an External Procedure", PL/SQL function PLS_MAX
registered external procedure find_max. Follow these steps to run find_max:
1.

Call PL/SQL function PLS_MAX from a PL/SQL routine named UseIt:

SET SERVER OUTPUT ON
CREATE OR REPLACE PROCEDURE UseIt AS
a integer;
b integer;
c integer;
BEGIN
a := 1;
b := 2;
c := PLS_MAX(a,b);
dbms_output.put_line(’The maximum of ’||a||’ and ’||b||’ is
END;
2.

’||c);

Run the routine:

SQL> EXECUTE UseIt;

Debugging External Procedures
Usually, when an external procedure fails, its C prototype is faulty. That is, the
prototype does not match the one generated internally by PL/SQL. This can happen
if you specify an incompatible C datatype. For example, to pass an OUT parameter
of type REAL, you must specify float *. Specifying float, double *, or any other
C datatype will result in a mismatch.
In such cases, you might get a lost RPC connection to external procedure
agent error, which means that agent extproc terminated abnormally because the
external procedure caused a core dump. To avoid errors when declaring C
prototype parameters, refer to Oracle9i Data Cartridge Developer’s Guide.

Using Package DEBUG_EXTPROC
To help you debug external procedures, PL/SQL provides utility package DEBUG_
EXTPROC. To install the package, run script dbgextp.sql, which you can find in
the PL/SQL demo directory.
To use the package, follow instructions in dbgextp.sql. Your Oracle account must
have EXECUTE privileges on the package and CREATE LIBRARY privileges.
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To debug external procedures:
1.

From Windows Task Manager, in the Processes dialog, select ExtProc.exe.

2.

Right click, and select Debug.

3.

Select OK in the message box.
If you have built your DLL in a debug fashion with Microsoft Visual C++, then
Visual C++ is activated.

4.

In the Visual C++ window, select Edit > Breakpoints.
Use the breakpoint identified in dbgextp.sql in the PL/SQL demo directory.
See Also:
■

ORACLE_BASE\ORACLE_HOME\rdbms\extproc\readme.doc
(explains how to run the sample and provides debugging advice)

■

PL/SQL User’s Guide and Reference

■

Oracle9i Java Developer’s Guide

■

■

"Calling External Procedures" in Oracle9i Application Developer’s
Guide - Fundamentals
Oracle9i Data Cartridge Developer’s Guide

Accessing Web Data with Intercartridge Exchange
This section discusses the following topics:
■

Configuring Intercartridge Exchange

■

Using Intercartridge Exchange

■

UTL_HTTP Exception Conditions

■

Exception Conditions and Error Messages
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Configuring Intercartridge Exchange
You must add a parameter to the registry before using Intercartridge Exchange.
1.

Start Registry Editor from the command prompt:
C:\> regedt32

The Registry Editor window appears.
Note: For another way to configure your registry, see "Modifying
a Registry Value with regedt32" on page 9-14
2.

Add HTTP_PROXY to the registry subkey of the Oracle home directory that you
are using. The location of this parameter is determined by how many Oracle
home directories are on your computer. If you have only one home directory,
add HTTP_PROXY to
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0.

If you have more than one home directory, add it to
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID

where ID is incremented for each additional Oracle home directory on your
computer.
3.

Choose Add Value from the Edit menu.
The Add Value dialog box appears.
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4.

Type HTTP_PROXY in the Value Name text box and REG_SZ in the Data Type
text box.

5.

Click OK.

6.

Type www-proxy.your-site in the String text box,

In this example, the Web site is marketing.com. You will enter the domain
name of your actual Web site.

Using Intercartridge Exchange
Intercartridge Exchange enables you to use a stored package called UTL_HTTP to
make Hypertext Transfer Protocol (HTTP) calls from PL/SQL, SQL, and SQL*Plus
statements.
UTL_HTTP can do both of the following:
■

Access data on the Internet

■

Call Oracle Web Application Server cartridges

UTL_HTTP contains two similar entry points, known as packaged functions, that
turn PL/SQL and SQL statements into HTTP callouts:
■

UTL_HTTP.REQUEST

■

UTL_HTTP.REQUEST_PIECES

Both packaged functions perform the following tasks:
■

Take a string universal resource locator (URL) of a site

■

Contact that site

■

Return data (typically HTML) obtained from that site

Declarations to use with both packaged functions are described in the following
subsections.
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Packaged Function UTL_HTTP.REQUEST
UTL_HTTP.REQUEST uses a URL as its argument and returns up to the first 2000
bytes of data retrieved from that URL. Specify UTL_HTTP.REQUEST as follows:
FUNCTION REQUEST (URL IN VARCHAR2) RETURN VARCHAR2;

To use UTL_HTTP.REQUEST from SQL*Plus, enter:
SQL> SELECT UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’) FROM DUAL;

which returns:
UTL_HTTP.REQUEST(’HTTP://WWW.ORACLE.COM/’)
-----------------------------------------------------<html>
<head><title>Oracle Corporation Home Page</title>
<!--changed Jan. 16, 19
1 row selected.

Packaged Function UTL_HTTP.REQUEST_PIECES
UTL_HTTP.REQUEST_PIECES uses a URL as its argument and returns a PL/SQL
table of 2000 bytes of data retrieved from the given URL. The final element can be
shorter than 2000 characters. The UTL_HTTP.REQUEST_PIECES return type is a
PL/SQL table of type UTL_HTTP.HTML_PIECES.
UTL_HTTP.REQUEST_PIECES, which uses type UTL_HTTP.HTML_PIECES, is
specified as:
type html_pieces is table of varchar2(2000) index by binary_integer;
function request_pieces (url in varchar2,
max_pieces natural default 32767)
return html_pieces;

A call to REQUEST_PIECES can look like this example. Note the use of PL/SQL
table method COUNT to discover the number of pieces returned; it can be zero or
more:
declare pieces utl_http.html_pieces;
begin
pieces := utl_http.request_pieces(’http://www.oracle.com/’);
for i in 1 .. pieces.count loop
.... -- process each piece
end loop;
end;
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The second argument to UTL_HTTP.REQUEST_PIECES (MAX_PIECES) is optional.
MAX_PIECES is the maximum number of pieces (each 2000 characters in length,
except for the last, which can be shorter) that UTL_HTTP.REQUEST_PIECES
returns. If provided, that argument is usually a positive integer.
For example, the following block retrieves up to 100 pieces of data (each 2000 bytes,
except perhaps the last) from the URL. The block prints the number of pieces
retrieved and the total length, in bytes, of the data retrieved.
set serveroutput on
declare
x utl_http.html_pieces;
begin
x := utl_http.request_pieces(’http://www.oracle.com/’, 100);
dbms_output.put_line(x.count || ’ pieces were retrieved.’);
dbms_output.put_line(’with total length ’);
if x.count < 1
then dbms_output.put_line(’0’);
else dbms_output.put_line
((2000 * (x.count - 1)) + length(x(x.count)));
end if;
end;
which displays:
Statement processed.
4 pieces were retrieved.
with total length
7687

Elements of the PL/SQL table returned by UTL_HTTP.REQUEST_PIECES are
successive pieces of data obtained from the HTTP request to that URL.

UTL_HTTP Exception Conditions
This subsection describes exceptions (errors) that can be raised by packaged
functions UTL_HTTP.REQUEST and UTL_HTTP.REQUEST_PIECES.
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UTL_HTTP.REQUEST
PRAGMA RESTRICT_REFERENCES enables display of exceptions:
create or replace package utl_http is
function request (url in varchar2) return varchar2;
pragma restrict_references (request, wnds, rnds, wnps, rnps);

UTL_HTTP.REQUEST_PIECES
PRAGMA RESTRICT_REFERENCES enables display of exceptions:
create or replace package utl_http is
type html_pieces is table of varchar2(2000) index by binary_integer;
function request_pieces (url in varchar2,
max_pieces natural default 32767)
return html_pieces;
pragma restrict_references (request_pieces, wnds, rnds, wnps, rnps);

Exception Conditions and Error Messages
If initialization of the HTTP callout subsystem fails for environmental reasons (such
as lack of available memory), then exception UTL_HTTP.INIT_FAILED is raised:
init_failed exception;

If the HTTP call fails due to failure of the HTTP daemon or because the argument to
REQUEST or REQUEST_PIECES cannot be interpreted as a URL (because it is NULL
or has non-HTTP syntax), then exception UTL_HTTP.REQUEST_FAILED is raised:
request_failed exception;

Unless explicitly caught by an exception handler, these first two exceptions are
reported by a generic message that shows them as "user-defined" exceptions, even
though they are defined in this system package:
ORA-06510: PL/SQL: unhandled user-defined exception

If any other exception is raised during processing of the HTTP request (for example,
an out-of-memory error), then function UTL_HTTP.REQUEST or UTL_
HTTP.REQUEST_PIECES reraises that exception.
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If no response is received from a request to the given URL, because the function
made no contact with a site corresponding to that URL, then a formatted HTML
error message may be returned:
<HTML>
<HEAD>
<TITLE>Error Message</TITLE>
</HEAD>
<BODY>
<H1>Fatal Error 500</H1>
Can’t Access Document: http://home.nothing.comm.
<P>
<B>Reason:</B> Can’t locate remote host: home.nothing.comm.
<P>
<P><HR>
<ADDRESS><A HREF="http://www.w3.org">
CERN-HTTPD3.0A</A></ADDRESS>
</BODY>
</HTML>

If UTL_HTTP.REQUEST or UTL_HTTP.REQUEST_PIECES raises an exception or
returns an HTML-formatted error message, yet you believe that the URL argument
is correct, try contacting that same URL with a browser to verify network
availability from your computer.
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A
Error Messages
This appendix lists error messages, causes, and corrective actions that are specific to
operation of Oracle9i for Windows. This appendix also includes database
connection issues.
This appendix contains these topics:
■

Logging Error Messages

■

ORA-09275: CONNECT INTERNAL No Longer Supported

■

OSD-04000 to OSD-04599: Windows NT-Specific Oracle Messages

■

DIM-00000 to DIM-00039: ORADIM Command Syntax Errors

■

Database Connection Issues
Note: The ora.hlp file, which was shipped in previous releases,
is no longer available. See this Appendix, Oracle9i Database Error
Messages, and Oracle Enterprise Manager Messages Manualfor
information on error messages.
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Logging Error Messages

Logging Error Messages
Keep a log of error messages you receive by redirecting messages to a file. You can
record the contents of normal utility messages by using the LOGFILE parameter
discussed in Oracle9i Database Utilities. You can separately record the error message
portion by using standard Windows NT file redirection. For example, use the
following syntax to redirect the output from Export utility:
C:\> exp USERNAME/PASSWORD parfile=FILENAME >file1.log 2>file2.err

With this command line, file1.log receives standard output from Export utility,
while file2.err receives standard error messages.

ORA-09275: CONNECT INTERNAL No Longer Supported
ORA-09275
Connect internal is no longer supported
Cause: CONNECT INTERNAL is no longer supported.
Action: Connect to the database as CONNECT / AS SYSDBA or an existing
user with appropriate password.

OSD-04000 to OSD-04599: Windows NT-Specific Oracle Messages
Error messages in this section are Oracle operating system-dependent (OSD)
messages displayed in response to an error condition in Windows NT. Each
message in this section triggers an Oracle9i database error message.
Error messages appear first in summary tables consisting of error numbers and the
corresponding error message. Following the tables is a more detailed discussion of
errors, including causes and corrective actions.
■

File I/O Errors: OSD-04000 to OSD-04099

■

Memory Errors: OSD-04100 to OSD-04199

■

Process Errors: OSD-04200 to OSD-04299

■

Loader Errors: OSD-04300 to OSD-04399

■

Semaphore Errors: OSD-04400 to OSD-04499

■

Miscellaneous Errors: OSD-04500 to OSD-04599
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File I/O Errors:

OSD-04000 to OSD-04099

4000

Logical block size mismatch

4001

Invalid logical block size

4002

Unable to open file

4003

Unable to read file header block

4004

Invalid file header

4005

SetFilePointer() failure, unable to read from file

4006

ReadFile() failure, unable to read from file

4007

Truncated read

4008

WriteFile() failure, unable to write to file

4009

Truncated write

4010

<create> option specified, file already exists

4011

GetFileInformationByHandle() failure, unable to obtain file info

4012

File size mismatch

4013

Unable to read line from file

4014

Unable to close file

4015

An asynchronous I/O request returned an error

4016

Error queuing an asynchronous I/O request

4017

Unable to open the specified RAW device

4018

Unable to access the specified directory or device

4019

Unable to set file pointer

4020

Unable to set eof file marker

4021

Unable to read file

4022

Unable to write file

4023

SleepEx() failure, unable to Sleep

4024

Unable to delete file

4025

Invalid question asked

4026

Invalid parameter passed
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Memory Errors:

OSD-04100 to OSD-04199

4100

malloc() failure, unable to allocate memory

4101

Invalid SGA: SGA not initialized

4102

Unable to open/create file for shared memory object

4103

Unable to attach to SGA: SGA does not exist

4104

Unable to map shared memory (SGA) into the address space

4105

Shared memory (SGA) mapped to wrong address

4106

Unable to allocate memory with VirtualAlloc

4107

Unable to deallocate memory with VirtualFree

4108

Unable to protect memory with VirtualProtect

Process Errors:

OSD-04200 to OSD-04299

4200

Unable to begin another thread

4201

No pid structure supplied to spdcr()

4202

DosSetPriority() failure, unable to set process priority

4203

DosKillProcess() failure, unable to kill process

4204

Invalid pid

4205

CreateProcess() failure, unable to spawn process

4207

Invalid priority specified in CONFIG parameter ORACLE_PRIORITY

4208

OpenProcess() failure, unable to open process handle

4209

Incorrect or unknown backgound image name given to spdcr()

4210

Timeout waiting for thread semaphore

4211

Thread information not found

4212

Maximum number of ORACLE threads reached

4213

ORACLE thread unable to DuplicateHandle()

4214

ORACLE thread unable to CreateEvent()

4215

Bad function code supplied to ssthreadop

4216

Unable to find file handle for that thread

4217

Unable to retrieve system username for current user

4218

Cannot post thread
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Process Errors:

OSD-04200 to OSD-04299

4219

Bad thread list semaphore

4221

Target thread is currently busy

4222

Unable to get the threads context

4223

Unable to set the threads context

4224

Unable to suspend the target thread

4225

Unable to resume the target thread

Loader Errors:

OSD-04300 to OSD-04399

4300

Unable to read complete record from datafile

4301

Record size too large

4302

Invalid record type, load options, or both

Semaphore Errors:

OSD-04400 to OSD-04499

4400

Unable to acquire internal semaphore for process

4401

WaitForSingleObject() failure, unable to obtain semaphore

Miscellaneous Errors:

OSD-04500 to OSD-04599

4500

Illegal option specified

4501

Internal buffer overflow

4502

Translations nested too deep

4503

Text contains no translatable elements

4505

stdin not responding

4506

Unable to spawn process via system()

4510

Operating system roles are not supported

4511

Unable to get date and time from the operating system

4512

Unable to translate the ’USERNAME’ config.ora variable on server

4513

’remote_os_authent’ init.ora variable not set to true

4514

The Windows Group name is too long for internal buffer

4515

This command is not implemented at this time
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File I/O Errors: OSD-04000 to OSD-04099
OSD-04000
Logical block size mismatch
Cause: Database block size specified in initialization parameter file (init.ora)
does not match block size of actual database files.
Action: Use matching logical block sizes.
OSD-04001
Invalid logical block size
Cause: Logical block size is not a multiple of 512 bytes, or it is too large.
Action: Change the value of DB_BLOCK_SIZE in the initialization parameter
file.
OSD-04002
Unable to open file
Cause: Specified path or filename is invalid, or destination device is full. This
error can also be caused by insufficient Windows NT file handles.
Action: Make sure path and file exist, and device has free space. If this fails,
then increase number of Windows NT file handles.
OSD-04003
Unable to read file header block
Cause: Media has been damaged.
Action: Recover file, if necessary, and verify that Windows NT is functioning
correctly.
OSD-04004
Invalid file header
Cause: File is damaged.
Action: Recover file.
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OSD-04005
SetFilePointer() failure, unable to read from file
Cause: There was an unexpected return from Windows NT system service
SetFilePointer().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04006
ReadFile() failure, unable to read from file
Cause: There was an unexpected return from Windows NT system service
ReadFile().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04007
Truncated read
Cause: System encountered an unexpected end-of-file, which is due to
damaged media.
Action: Verify that file is not damaged.
OSD-04008
WriteFile() failure, unable to write to file
Cause: There was an unexpected return from Windows NT system service
WriteFile().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04009
Truncated write
Cause: Destination device is full, or media is damaged.
Action: Verify that device has free space and that file is not damaged.
OSD-04010
<create> option specified, file already exists
Cause: File you attempted to create already exists.
Action: Delete existing file or use REUSE option in SQL statement.
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OSD-04011
GetFileInformationByHandle() failure, unable to obtain file info
Cause: There was an unexpected return from Windows NT system service
GetFileInformationByHandle().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04012
File size mismatch
Cause: File to be re-used is either too large or too small.
Action: Specify correct file size or delete existing file.
OSD-04013
Unable to read line from file
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and consult Windows
NT documentation. If no operating system error code is presented, then verify
that media is not damaged.
OSD-04014
Unable to close file
Cause: Media has been damaged.
Action: Recover file, if necessary, and verify that Windows NT is functioning
correctly.
OSD-04015
Asynchronous I/O request returned an error
Cause: There was an unexpected return from Windows NT system service.
Action: Check operating system error code and consult Windows NT documentation.
OSD-04016
Error queuing an asynchronous I/O request
Cause: There was an unexpected return from Windows NT system service.
Action: Check operating system error code and consult Windows NT documentation.
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OSD-04017
Unable to open the specified RAW device
Cause: An invalid path or filename was specified, or device is full.
Action: Make sure file exists and device is not full; verify that operating system is functioning correctly.
OSD-04018
Unable to access the specified directory or device
Cause: An invalid path name was specified.
Action: Make sure directory or device exists and is accessible.
OSD-04019
Unable to set file pointer
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and consult Windows
NT documentation. If no operating system error code is presented, then verify
that media is not damaged.
OSD-04020
Unable to set eof file marker
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and consult Windows
NT documentation. If no operating system error code is presented, then verify
that media is not damaged.
OSD-04021
Unable to read file
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and consult Windows
NT documentation. If no operating system error code is presented, then verify
that media is not damaged.
OSD-04022
Unable to write file
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and consult Windows
NT documentation. If no operating system error code is presented, then verify
that media is not damaged.
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OSD-04023
SleepEx() failure, unable to Sleep
Cause: There was an unexpected return from Windows NT system service.
Action: Check operating system error code and consult Windows NT documentation.
OSD-04024
Unable to delete file
Cause: This error is caused by an operating system error or by damaged media.
Action: Check operating system error code (if available) and consult Windows
NT documentation. If no operating system error code is presented, then verify
that media is not damaged.
OSD-04025
Invalid question asked
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04026
Invalid parameter passed
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.

Memory Errors: OSD-04100 to OSD-04199
OSD-04100
Malloc() failure, unable to allocate memory
Cause: Program is out of memory.
Action: Shut down all unnecessary processes or install more memory in the
computer.
OSD-04101
Invalid SGA: SGA not initialized
Cause: System Global Area (SGA) has been allocated but not initialized.
Action: Wait until STARTUP has completed before attempting to connect.
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OSD-04102
Unable to open/create file for shared memory object
Cause: There was an unexpected return from Windows NT system service
CreateFile().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04103
Unable to attach to SGA: SGA does not exist
Cause: SGA does not exist.
Action: Start up an Oracle instance.
OSD-04104
Unable to map shared memory (SGA) into the address space
Cause: There was an unexpected return from Windows NT system service
MapViewOfFileEx().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04105
Shared memory (SGA) mapped to wrong address
Cause: There was an unexpected return from Windows NT system service
MapViewOfFileEx().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04106
Unable to allocate memory with VirtualAlloc
Cause: Program is out of memory.
Action: Shut down all unnecessary processes or install more memory in the
computer.
OSD-04107
Unable to deallocate memory with VirtualFree
Cause: There was an unexpected return from Windows NT system service
VirtualFree().
Action: Check operating system error code and consult Windows NT documentation.

Error Messages
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OSD-04108
Unable to protect memory with VirtualProtect
Cause: There was an unexpected return from Windows NT system service
VirtualProtect().
Action: Check operating system error code and consult Windows NT documentation.

Process Errors: OSD-04200 to OSD-04299
OSD-04200
Unable to begin another thread
Cause: Program has run out of system resources.
Action: Shut down all unnecessary processes; install more memory in the computer.
OSD-04201
No pid structure supplied to spdcr()
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04202
DosSetPriority() failure, unable to set process priority
Cause: There was an unexpected return from Windows NT system service
DosSetPriority().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04203
DosKillProcess() failure, unable to kill process
Cause: There was an unexpected return from Windows NT system service
DosKillProcess().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04204
Invalid pid
Cause: Process ID not recognized by system; process previously terminated.
Action: Verify that process ID is correct and that process is active.
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OSD-04205
CreateProcess() failure, unable to spawn process
Cause: There was an unexpected return from Windows NT system service
CreateProcess().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04207
Invalid priority specified in CONFIG parameter ORACLE_PRIORITY
Cause: Priority specified is invalid or out of range.
Action: Specify a valid setting for ORACLE_PRIORITY.
OSD-04208
OpenProcess() failure, unable to open process handle
Cause: There was an unexpected return from Windows NT system service
OpenProcess().
Action: Check operating system error code and consult Windows NT documentation.
OSD-04209
Incorrect or unknown background image name given to spdcr()
Cause: There was an unexpected background name given to spdcr().
Action: Contact Oracle Support Services.
OSD-04210
Timeout waiting for thread semaphore
Cause: An Oracle database thread died holding the semaphore.
Action: Restart Oracle database instance.
OSD-04211
Thread information not found
Cause: An Oracle database thread died without deleting its information.
Action: Restart Oracle database instance.

Error Messages
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OSD-04212
Maximum number of Oracle threads reached
Cause: Maximum number of Oracle database threads for the instance is
reached.
Action: Wait until some connections exit before trying again.
OSD-04213
Oracle thread unable to DuplicateHandle()
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04214
Oracle thread unable to CreateEvent()
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04215
Bad function code supplied to ssthreadop
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04216
Unable to find file handle for that thread
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04217
Unable to retrieve system username for current user
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04218
Cannot post thread
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
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OSD-04219
Bad thread list semaphore
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04221
Target thread is currently busy
Cause: Target thread is processing an oradebug command.
Action: Wait and resend command.
OSD-04222
Unable to get the threads context
Cause: Check operating system error code.
Action: Remedy operating system error.
OSD-04223
Unable to set the threads context
Cause: Check operating system error code.
Action: Remedy operating system error.
OSD-04224
Unable to suspend the target thread
Cause: Check operating system error code.
Action: Remedy operating system error.
OSD-04225
Unable to resume the target thread
Cause: Check operating system error code.
Action: Remedy operating system error.

Error Messages
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Loader Errors: OSD-04300 to OSD-04399
OSD-04300
Unable to read complete record from datafile
Cause: Datafile ended in the middle of a record. This error occurs when
loading files with a fixed record length.
Action: Verify that datafile is of correct length and contains complete records.
OSD-04301
Record size too large
Cause: Specified record size is too large to load.
Action: Reduce record size and reload data.
OSD-04302
Invalid record type, load options, or both
Cause: Control file’s Windows NT file processing options string contains an
invalid option or keyword.
Action: Set Windows NT file processing options string to an acceptable value.

Semaphore Errors: OSD-04400 to OSD-04499
OSD-04400
Unable to acquire internal semaphore for process
Cause: Oracle database has exceeded the maximum number of connections.
Action: Delete any unused connections and try again.
OSD-04401
WaitForSingleObject() failure, unable to obtain semaphore
Cause: There was an unexpected return from Windows NT system service
WaitForSingleObject().
Action: Check operating system error code and consult Windows NT documentation.
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Miscellaneous Errors: OSD-04500 to OSD-04599
OSD-04500
Illegal option specified
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04501
Internal buffer overflow
Cause: This is an internal error, not normally expected to occur.
Action: Contact Oracle Support Services.
OSD-04502
Translations nested too deep
Cause: Program encountered too many intermediate translations while
attempting to translate a configuration variable.
Action: Simplify values of configuration parameters to include fewer intermediate translations.
OSD-04503
Text contains no translatable elements
Cause: Program cannot recognize variables in text to be translated.
Action: Check and, if necessary, correct text to be translated.
OSD-04505
stdin not responding
Cause: System is unable to receive input from standard input stream.
Action: Verify that process has access to an input device.
OSD-04506
Unable to spawn process via system()
Cause: System is out of memory or executable is invalid.
Action: Shut down unnecessary processes; install more memory in the computer. Verify name of executable.
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OSD-04510
Operating system roles are not supported
Cause: An attempt was made to use an operating system role.
Action: Only use roles that were created ’IDENTIFIED BY PASSWORD’ as
opposed to ’IDENTIFIED EXTERNALLY’.
OSD-04511
Unable to get date and time from the operating system
Cause: There was an unexpected return from GetLocalTime() call.
Action: Verify that system time is correct on the computer.
OSD-04512
Unable to translate the ’ USERNAME’ config.ora variable on server
Cause: ’USERNAME’ configuration parameter variable on host is not properly
set.
Action: Verify ’USERNAME’ variable is set.
OSD-04513
’remote_os_authent’ init.ora variable not set to TRUE
Cause: For remote operating system logon to function, ’REMOTE_OS_AUTHENT’
parameter must be set to TRUE.
Action: Shut down and start up instance with ’REMOTE_OS_AUTHENT =
TRUE’ in initialization parameter file.
OSD-04514
The Windows NT Group name is too long for internal buffer
Cause: Windows NT Group name is too long.
Action: Use a shorter Windows NT group name.
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DIM-00000 to DIM-00039: ORADIM Command Syntax Errors
ORADIM is a command-line utility for starting and stopping database instances that
is only available on Oracle for Windows. It is not available on any other platform.

Oradim Errors

DIM-0000 to DIM-0039

00000

ORADIM completed with no errors

00001

ORADIM: <command> [options]. Please refer to the manual.

00002

Valid commands are: -DELETE, -EDIT, -NEW, -STARTUP, and -SHUTDOWN

00003

An argument is missing for the parameter

00004

Either a SID or service name is mandatory. Please enter a valid SID or service name

00005

You have entered a SID with more than 64 characters

00006

You have entered an empty SID

00007

Missing or invalid -STARTMODE parameter. Valid -STARTMODE parameter is
AUTO or MANUAL

00008

A valid service name is OracleService appended with a SID

00009

SID name is mandatory. Please enter a valid SID name

00010

SYSTEM\CurrentControlSet\Services\OracleService key does not exist

00011

The service does not exist

00012

You did not enter a pfile for autostart capability

00013

The service start mode could not be set in the registry

00014

Cannot open the Windows NT Service Control Manager

00015

Cannot start already-running ORACLE - shut it down first

00016

Missing or invalid -SHUTTYPE parameter. A valid -SHUTTYPE parameter is SRVC
or INST

00017

Instance shutdown mode must be one of the following: a for abort, i for immediate
or n for normal

00018

Failed to stop Oracle Service

00019

Create Service Error

00020

A service for this SID is already created. Please enter a different SID name. No action
has been taken

00021

RegOpenkeyEx failed

00022

Please enter one of the following commands

00023

Create an instance by specifying the following parameters:

Error Messages
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Oradim Errors

DIM-0000 to DIM-0039

00024

-NEW -SID sid | -SRVC service [-INTPWD password] [-MAXUSERS number]
[-STARTMODE a|m] [-PFILE file] [-TIMEOUT secs]

00025

Edit an instance by specifying the following parameters:

00026

-EDIT -SID sid [-NEWSID sid] [-INTPWD passwd] [-STARTMODE a|m] [-PFILE
file] [-SHUTMODE a|i|n] [-SHUTTYPE srvc|inst]

00027

Delete instances by specifying the following:

00028

-DELETE -SID sid | -SRVC service name

00029

Startup services and instance by specifying the following parameters:

00030

-STARTUP -SID sid [-USRPWD password] [-STARTTYPE srvc|inst|srvc,inst]
[-PFILE filename]

00031

Shutdown services and instance by specifying the following parameters:

00032

-SHUTDOWN -SID sid [-USRPWD password] [-SHUTTYPE srvc|inst|srvc,inst]
[-SHUTMODE a | i | n]

00033

Query for help by specifying the following parameters: -? | -h | -help

00034

You have entered an invalid option for the -NEW command

00035

You have entered an invalid option for the -EDIT command

00036

You have entered an invalid option for the -DELETE command

00037

You have entered an invalid option for the -STARTUP command

00038

You have entered an invalid option for the -SHUTDOWN command

00039

Internal logic error in ORADIM

DIM-00000
ORADIM completed with no errors
Cause: ORADIM has completed without any errors.
Action: None.
DIM-00001
ORADIM: <command> [options]. Please refer to the manual.
Cause: Command-line arguments could not be recognized.
Action: Usage: ORADIM <command> [options]
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Use the following commands:
To create an instance:
-NEW -SID sid | -SRVC service name [-INTPWD password][-MAXUSERS number]
[-STARTMODE auto [-PFILE filename]| manual]

To edit an instance:
-EDIT -SID sid [-NEWSID sid][-INTPWD password][-STARTMODE auto
[-PFILE filename]| manual]

To delete an instance:
-DELETE -SID sid | -SRVC service name

To startup a service and instance:
-STARTUP -SID sid [-USRPWD password][-STARTTYPE srvc | inst | srvc,inst]
[-PFILE filename]

To shutdown a service and instance:
-SHUTDOWN -SID sid [-USRPWD password][-SHUTTYPE srvc | inst | srvc,inst]
[-SHUTMODE a | i | n]

To query for help
-? | -h | -help

DIM-00002
Valid commands are: -DELETE, -EDIT, -NEW, -STARTUP, and -SHUTDOWN
Cause: You have not entered one of the referenced commands.
Action: Use valid commands.
DIM-00003
An argument is missing for the parameter
Cause: You have entered an invalid argument.
Action: Use a valid argument and start program again.
DIM-00004
Either a SID or service name is mandatory. Please enter a valid SID or service name
Cause: You have not entered the SID following -SID.
Action: Enter a valid SID of 64 characters and try again.
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DIM-00005
You have entered SID with more than 64 characters
Cause: You have entered a SID with more than 64 characters.
Action: Change it to 64 or fewer characters and make sure that there is no other
service with this name.
DIM-00006
You have entered an empty SID
Cause: Enter a SID with 64 characters and make sure that there is no service
with this SID on your system.
Action: Fill in the SID and rerun program.
DIM-00007
Missing or invalid -STARTMODE parameter. Valid -STARTMODE parameter is
AUTO or MANUAL
Cause: You have not entered valid start mode (AUTO or MANUAL).
Action: Enter valid start mode and try again.
DIM-00008
A valid service name is OracleService appended with a SID
Cause: You have entered a service name other than OracleService(SID).
Action: Correct name of service and try again.
DIM-00009
SID name is mandatory. Please enter a valid SID name
Cause: You did not enter a SID.
Action: Enter the SID and try again.
DIM-00010
SYSTEM\CurrentControlSet\Services\OracleService key does not exist
Cause: Referenced key is not in the registry.
Action: Try reinstalling. If problem persists, then contact Oracle Support Services.
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DIM-00011
The service does not exist
Cause: You have tried to edit a service which does not exist, or there is an error
trying to access the registry.
Action: Verify service/SID name used and try again. Restart if necessary or
contact Oracle Support Services.
DIM-00012
You did not enter a pfile for autostart capability
Cause: You did not provide the parameter file for starting the database.
Action: Enter the parameter file used to start the database and retry.
DIM-00013
The service start mode could not be set in the registry
Cause: Start mode entry in the registry for the service could not be set.
Action: Try again later, restart, or call Oracle Support Services.
DIM-00014
Cannot open the Windows NT Service Control Manager
Cause: Service Control Manager could not be opened.
Action: Restart or call Oracle Support Services.
DIM-00015
Cannot start already-running ORACLE - shut it down first
Cause: Instance is already started; shut it down first.
Action: Stop database before restarting.
DIM-00016
Missing or invalid -SHUTTYPE parameter. A valid -SHUTTYPE parameter is SRVC
or INST
Cause: You did not enter a valid shuttype parameter (Service or Instance).
Action: Enter parameter to shut down instance or service and try again.
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DIM-00017
Instance shutdown mode must be one of the following: a for abort, i for immediate or n
for normal
Cause: You did not enter the correct mode for shutting down the database.
Action: Enter correct mode and try again.
DIM-00018
Failed to stop Oracle Service
Cause: Failed to stop Oracle Service.
Action: Retry. If error persists, then look at system error or call Oracle Support
Services.
DIM-00019
Create Service Error
Cause: Service could not be created.
Action: Look at detail error.
DIM-00020
A service for this SID is already created. Please enter a different SID name. No action
has been taken
Cause: Service with this name already exists.
Action: Retry with a different SID.
DIM-00021
RegOpenkeyEx failed
Cause: This is a system error due to service not existing or Windows error.
Action: Retry, restart, or call Oracle Support Services.
DIM-00022
Please enter one of the following commands:
DIM-00023
Create an instance by specifying the following parameters:
DIM-00024
-NEW -SID sid | -SRVC service [-INTPWD password] [-MAXUSERS number]
[-STARTMODE a|m] [-PFILE file] [-TIMEOUT secs]
DIM-00025
Edit an instance by specifying the following parameters:
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DIM-00026
-EDIT -SID sid [-NEWSID sid] [-INTPWD passwd] [-STARTMODE a|m] [-PFILE
file] [-SHUTMODE a|i|n] [-SHUTTYPE srvc|inst]
DIM00027
Delete instances by specifying the following:
DIM-00028
-DELETE -SID sid | -SRVC service name
DIM-00029
Startup services and instance by specifying the following parameters:
DIM-00030
-STARTUP -SID sid [-USRPWD password] [-STARTTYPE srvc|inst|srvc,inst]
[-PFILE filename]
DIM-00031
Shutdown services and instance by specifying the following parameters:
DIM-00032
-SHUTDOWN -SID sid [-USRPWD password] [-SHUTTYPE srvc|inst|srvc,inst]
[-SHUTMODE a | i | n]
DIM-00033
Query for help by specifying the following parameters: -? | -h |-help
DIM-00034
You have entered an invalid option for the -NEW command
DIM-00035
You have entered an invalid option for the -EDIT command
DIM-00036
You have entered an invalid option for the -DELETE command
DIM-00037
You have entered an invalid option for the -STARTUP command
DIM-00038
You have entered an invalid option for the -SHUTDOWN command
DIM-00039
Internal logic error in ORADIM
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Database Connection Issues
The following are common Oracle9i database connection error codes, their causes,
and suggested remedies.
TNS-12203
TNS: unable to connect to destination
Cause: OracleServiceSID service, OracleHome_NameTNSListener
service, or both are not running.
Action: Ensure that both services are started.
ORA-12560
TNS: lost contact
Cause: OracleServiceSID service, OracleHome_NameTNSListener
service, or both are not running. You receive this error if you attempt to use any
Oracle9i Utilities, such as SQL*Plus. This error is analogous to the following
Oracle7 error: ORA-09352: Windows 32-bit Two-Task driver unable to
spawn new ORACLE task.
Action: Ensure that both services are started.
ORA-28575
unable to open RPC connection to external procedure agent
Cause: tnsnames.ora and listener.ora files have not been correctly
configured to use external procedures.
Action: Reconfigure services.
ORA-06512
at "APPLICATIONS.OSEXEC", line 0
Cause: tnsnames.ora and listener.ora files have not been correctly
configured to use external procedures.
Action: Reconfigure services.
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ORA-06512
at "APPLICATIONS.TEST", line 4
Cause: tnsnames.ora and listener.ora files have not been correctly
configured to use external procedures.
Action: Reconfigure services.
ORA-06512
at line 2
Cause: tnsnames.ora and listener.ora files have not been correctly
configured to use external procedures.
Action: Reconfigure services.
ORA-01031 and LCC-00161
Both codes appear at startup
Cause: Parameter file (init.ora) or Windows services are damaged. These errors
usually appear when the parameter file cannot be read by Oracle at database
startup.
Action: Delete and re-create the SID and services. Make sure you are logged on
as the user Administrator, or a user within the Windows Administrator’s Group
with full administrative rights. At the command prompt, enter: oradim
-delete -sid sid where: sid is the name of your database (for example,
orcl). Re-create the sid and services by entering: oradim -new -sid sid
-intpwd password -startmode auto -pfile full path to
init.ora
See Also: Oracle9i Net Services Administrator’s Guide
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Getting Started with Your Documentation
Your Oracle documentation set is provided in both HTML and PDF formats on two
CDs, both included in your CD Pack and labeled as follows:
■

■

Oracle9i Online Documentation Library CD-ROM for Windows
Oracle9i Online Documentation Library CD-ROM for Windows Installation CD

Use the first CD-ROM to browse the library from the CD or copy files directly to a
local system. Use the second CD-ROM to install the documentation library with
Oracle Universal Installer. The contents of the library are the same on both discs.
The library includes a Web-based search tool that enables you to search for
information about a particular product, parameter, file name, procedure, error
message, or other area of interest. The search tool also makes it possible to construct
a "virtual book" drawn from the complete documentation library, but consisting
only of topics and procedures relevant to your needs. The library also includes a
comprehensive Master Index, as well as lists of SQL and PL/SQL keywords,
initialization parameters, catalog views, and data dictionary views.
Instructions for installing the library and viewing its contents are in three README
files at the root level of the documentation CD-ROMs:
■

README.htm

■

README.pdf

■

README.txt

The contents of the three files are identical; only the format differs.
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The following guides are not included on Oracle9i Online Documentation Library
CD-ROM for Windows:
■

Oracle9i Database Installation Guide for Windows and Oracle9i Database Release
Notes for Windows
To access these documents before installation, open start_here.htm in the
\doc directory on the component CD-ROM. To access these documents after
installation, choose Start > Programs > Oracle - HOME_NAME > Release
Documentation or open start_here.htm in the ORACLE_BASE\ORACLE_
HOME\doc directory on your hard drive.

■

Oracle Migration Workbench documentation
The latest version can be viewed at: http://otn.oracle.com/.

■

Oracle Fail Safe and Oracle Real Application Clusters Guard documentation
These documents are on the Oracle Fail Safe and Oracle Real Application
Clusters Guard product CD-ROM.
Note: Oracle Fail Safe and Oracle Real Application Clusters
Guard are not supported on Windows XP.
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Active Directory
Oracle security and administration are integrated with Windows 2000 through
Active Directory, Microsoft’s directory service. Oracle uses Active Directory for
enterprise-level security and schema management.
authenticate
To verify the identity of a user, device, or other entity in a computer system, often as
a prerequisite for allowing access to resources in a system.
authorization
Permission given to a user, application, or process to access an Oracle database or
operating system.
backup
A representative copy of data. This copy includes important parts of your database
such as control files, redo log files, and datafiles.
A backup is a safeguard against unexpected data loss; if you lose your original data,
then you can use the backup to make the data available again. A backup is also a
safeguard against an application error; if an application makes incorrect changes,
then you can restore the backup.
COM/COM+
Microsoft’s Component Object Model is an object-oriented programming
architecture and a set of operating system services. These services notify running
application components of significant events and ensure that they are authorized to
run. COM/COM+ is intended to make it relatively easy to create business
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applications that work well with Microsoft Transaction Server in Windows NT and
Windows 2000.
connect string
See net service name.
control files
Files that record the physical structure of a database and contain the database name,
the names and locations of associated databases and online redo log files, the time
stamp of the database creation, the current log sequence number, and checkpoint
information.
data dictionary
A set of read-only tables that provide information about a database.
DLL
See dynamic link library.
downgrade
To convert the data in an Oracle database into an earlier release. See upgrade and
migrate.
dynamic link library
An executable file that a Windows application can load when needed.
external procedures
Functions written in a third-generation language (C, for example) and callable from
within PL/SQL or SQL as if they were PL/SQL functions or procedures.
external user
The Windows operating system can authenticate a user, who can then access the
Oracle database without being prompted for a password. External users are
typically regular database users (non-database administrators) to whom you assign
standard database roles (such as CONNECT and RESOURCE), but do not want to
assign the SYSDBA (database administrator) or SYSOPER (database operator)
privilege.
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Globalization Support
The Oracle architecture that ensures that database utilities, error messages, sort
order, date, time, monetary, numeric, and calendar conventions automatically adapt
to the native language and locale.
HOMEID
Represents a unique registry subkey for each Oracle home directory in which you
install products. A new HOMEID is created and the ID counter incremented each
time you install products to a different Oracle home directory on one computer.
Each HOMEID contains its own configuration parameter settings for installed Oracle
products.

HOME_NAME
Represents the name of an Oracle home. In Oracle9i release 2 (9.2), all Oracle homes
have a unique HOME_NAME.
initialization parameter file (init.ora)
An ASCII text file that contains information needed to initialize a database and
instance.
instance
Every running Oracle database is associated with an Oracle instance. When a
database is started on a database server (regardless of the type of computer), Oracle
allocates a memory area called the System Global Area and starts one or more
Oracle processes. This combination of the System Global Area and Oracle processes
is called an instance. The memory and processes of an instance manage the
associated database’s data efficiently and serve the users of the database.
latch
A simple, low-level serialization mechanism to protect shared data structures in the
System Global Area.
listener
The Oracle server process that listens for and accepts incoming connection requests
from client applications. The listener process starts up Oracle database processes to
handle subsequent communications with the client; then it goes back to listening for
new connection requests.
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listener.ora
A configuration file that describes one or more Transparent Network Substrate
(TNS) listeners on a server.
Microsoft Management Console
An application that serves as a host for administrative tools called snap-ins. By
itself, Microsoft Management Console does not provide any functionality.
Microsoft Transaction Server
A transaction processing system based on COM/COM+ that runs on an Internet or
network server.
migrate
To upgrade or downgrade an Oracle database or convert the data in a non-Oracle
database into an Oracle database.
mount
To associate a database with an instance that has been started.
MTS
See Microsoft Transaction Server
multiple Oracle homes
The capability of having more than one Oracle home on a computer.
net service name
The name used by clients to identify an Oracle Net server and the specific system
identifier or database for the Oracle Net connection. A net service name is mapped
to a port number and protocol. Also known as a connect string, database alias, host
string, or service name.
This also identifies the specific SID or database to which the connection is attaching,
not just the Oracle Net server.
network listener
A listener on a server that listens for connection requests for one or more databases
on one or more protocols. See listener.
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network service
In an Oracle application network, a service performs tasks for its service consumers.
For example, a Names Server provides name resolution services for clients.
obfuscated
Protected by a process often used by companies for intellectual property written in
the form of Java programs. The obfuscation process mixes up Java symbols found in
the code. It leaves the original program structure intact, allowing the program to
run correctly, while changing the names of the classes, methods, and variables in
order to hide the intended behavior. Although it is possible to decompile and read
non-obfuscated Java code, obfuscated Java code is sufficiently difficult to decompile
to satisfy U.S. government export controls.
OCI
See Oracle Call Interface.
OFA
See Optimal Flexible Architecture.
OID
See Oracle Internet Directory.
Optimal Flexible Architecture
A set of file naming and placement guidelines for Oracle software and databases.
Oracle Call Interface
An application programming interface that enables you to manipulate data and
schemas in an Oracle database. You compile and link an Oracle Call Interface
application in the same way that you compile and link a non-database application.
There is no need for a separate preprocessing or precompilation step.
Oracle Internet Directory
An Oracle database-based LDAP V3 directory server, used for centralizing database
user, Oracle Net network connector, and database listener parameters.
Oracle Net
The Oracle network interface that enables Oracle tools running on network
workstations and servers to access, modify, share, and store data on other servers.
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Oracle Net Naming
Oracle Net Naming with Active Directory stores and resolves names through
Active Directory.
Oracle PKI
Oracle Advanced Security includes Oracle PKI (public key infrastructure)
integration for authentication and single sign-on. Oracle-based applications are
integrated with the PKI authentication and encryption framework, using Oracle
Wallet Manager and Oracle Enterprise Login Assistant.
Oracle Protocol Support
A product that maps the functions of a given network protocol into Oracle
Transparent Network Substrate (TNS) architecture. This process translates TNS
function calls into requests to the underlying network protocol. This allows TNS to
act as an interface among all protocols. Oracle Net requires Oracle Protocol
Support.
Oracle services
Windows services that are associated with particular Oracle components.

ORACLE_BASE
ORACLE_BASE is the root of the Oracle directory tree. If you install an
OFA-compliant database using Oracle Universal Installer defaults, then ORACLE_
BASE is X:\oracle where X is any hard drive (for example, C:\oracle).

ORACLE_HOME
Corresponds to the environment in which Oracle products run. This environment
includes the location of installed product files, the PATH variable pointing to the
binary files of installed products, registry entries, net service names, and program
groups.
If you install an OFA-compliant database, using Oracle Universal Installer defaults,
then Oracle home (known as \ORACLE_HOME in this guide) is located beneath
X:\ORACLE_BASE. It contains subdirectories for Oracle software executables and
network files.
PL/SQL
Oracle Corporation’s procedural language extension to SQL.
PL/SQL enables you to mix SQL statements with procedural constructs. You can
define and run PL/SQL program units such as procedures, functions, and packages.
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precompiler
A programming tool that enables you to embed SQL statements in a high-level
source program.
privilege
A right to run a particular type of SQL statement or to access another user’s object.
process
A mechanism in an operating system that can run an executable. (Some operating
systems use the terms job or task.) A process normally has its own private memory
area in which it runs. On Windows a process is created when an application runs
(such as Oracle or Microsoft Word). In addition to an executable program, all
processes consist of at least one thread. The Oracle master process contains
hundreds of threads.
raw partitions
Portions of a physical disk that are accessed at the lowest possible disk (block) level.
recovery
To restore a physical backup is to reconstruct it and make it available to the Oracle
server. To recover a restored backup is to update it using redo records (that is,
records of changes made to the database after the backup was taken). Recovering a
backup involves two distinct operations: rolling back all changes made in
uncommitted transactions to their original state, and rolling forward to a more
current time by applying redo data.
redo log buffer
A circular buffer in the System Global Area that contains information about
changes made to the database.
redo log files
Files that contain a record of all changes made to data in the database buffer cache.
If an instance failure occurs, then the redo log files are used to recover the modified
data that was in memory.
registry
A Windows repository that stores configuration information for a computer.
remote database
A database on a computer other than the local database.
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replication
The process of copying and maintaining database objects in multiple databases that
make up a distributed database system.
roles
Named groups of related privileges. You can grant roles to users or other roles.
schemas
Named collections of objects, such as tables, views, clusters, procedures, and
packages, associated with particular users.
services
Executable processes installed in the Windows registry and administered by
Windows. Once services are created and started, they can run even when no user is
logged on to the computer.
service name
See net service name.
SGA
See System Global Area.
Shared Server Process
A server configuration which allows many user processes to share very few server
processes. The user processes connect to a dispatcher background process, which
routes client requests to the next available shared server process.
SID
See system identifier.
snap-ins
Administrative tools that run within Microsoft Management Console.
snapshot
(1) Information stored in rollback segments to provide transaction recovery and
read consistency. Rollback segment information can be used to re-create a snapshot
of a row before an update.
(2) A point-in-time copy of a master table located on a remote site. Read-only
snapshots can be queried, but not updated. Updateable snapshots can be queried
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and updated. They are periodically refreshed to reflect changes made to the master
table, and at the snapshot site.
starter database
A preconfigured, ready-to-use database that requires minimal user input to create.
SYSDBA
A special database administration role that contains all system privileges with the
ADMIN OPTION, and the SYSOPER system privilege. SYSDBA also permits CREATE
DATABASE actions and time-based recovery.
SYSOPER
A special database administration role that permits a database administrator to
perform STARTUP, SHUTDOWN, ALTER DATABASE OPEN/MOUNT, ALTER DATABASE
BACKUP, ARCHIVE LOG, and RECOVER, and includes the RESTRICTED SESSION
privilege.
System Global Area
A group of shared memory structures that contain data and control information for
an Oracle instance.
system identifier
A unique name for an Oracle instance. To switch between Oracle databases, users
must specify the desired system identifier. The system identifier is included in the
CONNECT DATA parts of the connect descriptors in a tnsnames.ora file, and in the
definition of the network listener in a tnsnames.ora file.
SYSTEM
One of two standard database administrator usernames automatically created with
each database. (The other username is SYS.). The SYSTEM username is the preferred
username for database administrators to use for database maintenance.
tablespace
A database is divided into one or more logical storage units called tablespaces.
Tablespaces are divided into logical units of storage called segments, which are
further divided into extents.
thread
An individual path of execution within a process. Threads are objects within a
process that run program instructions. Threads allow concurrent operations within
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a process so that a process can run different parts of its program simultaneously on
different processors. A thread is the most fundamental component that can be
scheduled on Windows.
tnsnames.ora
A file that contains connect descriptors mapped to net service names. The file can be
maintained centrally or locally, for use by all or individual clients.
trace file
Each server and background process can write to an associated trace file. When a
process detects an internal error, it dumps information about the error to its trace
file. Some of the information written to a trace file is intended for the database
administrator, while other information is intended for Oracle Support Services.
Trace file information is also used to tune applications and instances.
upgrade
To convert the data in an Oracle database into a later release. See downgrade and
migrate.
username
A name that can connect to and access objects in a database.
view
A selective presentation of the structure and data of one or more tables. Views can
also be based on other views.
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DBVERIFY
operating system compatibility, 5-3
starting, 5-10
debugging external procedures, 10-13
developing applications
for Windows, 10-2
diagnostic and tuning utilities
for Windows, 5-24
disk striping, 6-23
DLLs
compared to UNIX shared libraries, 2-3
displaying with Task List, 5-24
external procedures, 10-10
Oracle Performance Monitor, 9-11

B
background processes
querying, 4-3
backup
control files, 9-8
tools, 5-5
Backup Wizard
preferred tools, 5-5

C
configuration parameters
defined, 9-2
registry, defined, 9-2
CONNECT INTERNAL
replacement, 5-2
CREATE LIBRARY
command, 10-11
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Oracle Real Application Clusters, 9-12

E
environment variables
ORACLE_HOME, 6-10
TNS_ADMIN, 6-12
error messages
DIM-00000 to DIM-00039, A-19
Intercartridge Exchange, 10-19
logging, A-2
ORA-12547 TNS, 7-4
ORA-12560, A-26
OSD-04000 to OSD-04099, A-6
OSD-04100 to OSD-04199, A-10
OSD-04200 to OSD-04299, A-12
OSD-04300 to OSD-04399, A-16
OSD-04400 to OSD-04499, A-16
OSD-04500 to OSD-04599, A-17
OSD-09275, A-2
Event Viewer
defined, 5-20
integration with Oracle9i database, 5-20
logging operating system audit trail, 5-20
operating system compatibility, 5-4
exception conditions, Intercartridge
Exchange, 10-18
executable images
modifying, 4-5
EXECUTE privileges, on a PL/SQL library, 10-11
Export Utility
operating system compatibility, 5-3
preferred tools, 5-5
redirecting output, A-2
starting, 5-10
Export Wizard
preferred tools, 5-5
EXTERNAL clause, 10-11
external procedures
building a DLL, 10-10
creating a PL/SQL library, 10-11
debugging, 10-13
EXTERNAL clause, 10-11
granting EXECUTE privileges, 10-11
registering with Oracle database, 10-11
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using EXTPROC, 10-9
writing, 10-9
EXTPROC
example, 10-9
explained, 10-8
responsibilities, 10-9

F
features
4GT tuning, 4-8
large user populations, 4-9
Oracle PKI, 4-10
file I/O enhancements, 4-5
files
oracle.key, 6-10
size limitations, 4-5

I
ICX. See Intercartridge Exchange
Import Utility
operating system compatibility,
preferred tools, 5-5
Import Wizard
preferred tools, 5-5
initialization parameters
path in registry, 9-5
instance
Oracle, 4-2
integration with Windows
4GT tuning, 4-8
Active Directory, 4-10
Oracle Fail Safe, 4-12
Oracle Net Naming, 4-11
Oracle PKI, 4-10
Oracle Services for MTS, 4-11
Intercartridge Exchange
accessing Web data, 10-14
configuring, 10-15
error messages, 10-19
exception conditions, 10-18
packaged functions, 10-16
stored packages, 10-16
using, 10-16

5-3

internet applications
developing, 10-5
IPC
DeviceNic registry value, 9-13
InstanceID registry value, 9-13

K
keys
defined,

9-2

L
Load Wizard
preferred tools, 5-5
logging error messages,

A-2

M
Microsoft Management Console
defined, 5-21
integration with Oracle9i database, 5-21
starting, 5-16
Microsoft ODBC Administration
starting, 5-8
Migration Utility
operating system compatibility, 5-3
preferred tools, 5-5
starting, 5-10
MMC. See Microsoft Management Console
monitoring
Oracle events, 5-21
multiple Oracle homes
ALL_HOMES registry subkey, 9-9
benefits, 6-3
environment, 6-5
functionality in different releases, 6-3
introduction, 6-2
overview, 6-2
program groups, 6-6
registry entries, 6-6
service names, 6-6
system identifier, 6-6
use of one listener for spawning, 6-5

O
Object Type Translator
operating system compatibility, 5-2
OCOPY
and raw files, 4-5
operating system compatibility, 5-3
preferred tools, 5-5
starting, 5-10
operating systems
audit trail, 5-20
OPERFCFG
operating system compatibility, 5-3
starting, 5-10
syntax examples, 9-23
Optimal Flexible Architecture
benefits, 6-13
characteristics of a database, 6-14
default OFA database, 6-19
differences since previous releases, 6-15
introduction, 6-2
nondefault OFA database 1, 6-20
nondefault OFA database 2, 6-21
overview, 6-12
Windows and UNIX differences, 6-24
ORA-12560 TNS, 7-5
Oracle Administration Assistant for Windows NT
operating system compatibility, 5-3
starting, 5-8
using, 9-17, 9-24
using the Oracle Home Configuration
snap-in, 9-17
using the Performance Monitoring snap-in, 9-24
Oracle Advanced Security
operating system compatibility, 5-3
Oracle Data Upgrade Assistant
operating system compatibility, 5-3
preferred tools, 5-5
starting, 5-8
Oracle Directory Manager
starting, 5-9
Oracle Enterprise Login Assistant
preferred tools, 5-5
security, 4-10
starting, 5-8
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Oracle Enterprise Manager Configuration Assistant
starting, 5-8
Oracle Enterprise Manager Console
operating system compatibility, 5-3
preferred tools, 5-5
starting, 5-8
starting from a Web browser, 5-13
starting tools, 5-12
Oracle home
new-style, defined, 6-12
Oracle Home Configuration snap-in
using, 9-17
Oracle Home Selector
changing PATH value, 6-8
Oracle INTYPE File Assistant
starting, 5-8
Oracle Locale Builder
starting, 5-8
Oracle Migration Workbench
operating system compatibility, 5-3
starting, 5-8
Oracle Net
configuring for external procedures, 10-8
Oracle Net Configuration Assistant
operating system compatibility, 5-3
starting, 5-8
Oracle Net Manager
operating system compatibility, 5-3
starting, 5-9
Oracle Net Naming
with Active Directory, 4-11
Oracle Performance Monitor
defined, 5-21
integration with Oracle9i database, 5-21
integration with Windows, 2-3
monitoring specific Oracle events, 5-21
operating system compatibility, 5-3
parameters, 9-10
starting, 3-3, 5-9, 5-16
using, 9-24
Oracle Portal
operating system compatibility, 5-2
Oracle Real Application Clusters
registry values, 9-12
Oracle Wallet Manager, 4-10
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preferred tools, 5-5
starting, 5-9
ORACLE_BASE
explained, 6-16
ORACLE_HOME
directory structure, 6-17
environment variable, 6-10, 6-11
specifying, 6-19
oracle.key file, 6-10, 6-11
ORACLEMTSrecoveryservice
operating system compatibility, 5-2
ORADATA directory, explained, 6-18
ORADIM
command syntax errors, A-19
operating system compatibility, 5-3
preferred tools, 5-5
starting, 5-10
ORAPWD
operating system compatibility, 5-3
preferred tools, 5-5
starting, 5-11

P
packaged functions
Intercartridge Exchange, 10-16
UTL_HTTP.REQUEST, 10-17
UTL_HTTP.REQUEST_PIECES, 10-17
parameters
DEFAULT_HOME, 9-9
DisplayName, 9-11
HOME_COUNTER, 9-9
Hostname, 9-10
ImagePath, 9-12
INST_LOC, 9-8
LAST_HOME, 9-9
LOGFILE, 9-11
MSHELP_TOOLS, 9-4
NAME, 9-9
NLS_LANG, 9-4
ObjectName, 9-12
OO4O, 9-8
ORA_AFFINITY, 9-6
ORA_CWD, 9-4
ORA_SID_AUTOSTART, 9-4

ORA_SID_PFILE, 9-5
ORA_SID_SHUTDOWN, 9-5
ORA_SID_SHUTDOWN_TIMEOUT, 9-5
ORA_SID_SHUTDOWNTYPE, 9-5
Oracle Performance Monitor, 9-22
ORACLE_BASE, 9-6
ORACLE_GROUP_NAME, 9-6
ORACLE_HOME, 9-6
ORACLE_HOME_KEY, 9-7
ORACLE_HOME_NAME, 9-7
ORACLE_PRIORITY, 9-7
ORACLE_SID, 9-7
OSAUTH_PREFIX_DOMAIN, 9-8
OSAUTH_X509_NAME, 9-8
PATH, 9-9
PERF_FILE_NAME, 9-11
RDBMS_ARCHIVE, 9-7
RDBMS_CONTROL, 9-8
SQLPATH, 9-8
TNS_ADMIN, 6-12
Username, 9-11
PARFILE, using, A-2
partition
raw, 6-24
Password parameter, 9-11
Password Utility
operating system compatibility, 5-3
passwords
changing, 8-2, 8-3
for default accounts, 8-5
PATH, changing the value of, 6-7
PERFORMANCE key, 9-10
performance, increasing, 6-23
PL/SQL Embedded Gateway, 10-2
PRAGMA RESTRICT_REFERENCES, with
Intercartridge Exchange, 10-18
Pro C-C++
starting, 5-9
Pro*C/C++
operating system compatibility, 5-2
Pro*COBOL
operating system compatibility, 5-2
Process Explode, 5-24
Process Viewer, 5-24
program groups

multiple Oracle homes,

6-6

Q
QuickSlice, 5-24

R
RAID. See Redundant Array of Independent Disks
raw files
using, 4-5
raw partitions
defined, 6-24
Recovery Manager
operating system compatibility, 5-3
preferred tools, 5-5
Recovery Wizard
preferred tools, 5-5
Redundant Array of Independent Disks, 6-23
registering an external procedure, 10-11
registry
adding parameters, 9-16
ALL_HOMES subkey, 9-9
and multiple Oracle homes, 6-6
and Oracle Real Application Clusters, 9-12
Cluster Manager, 9-12
ClusterID, 9-12
ClusterName, 9-12
CmDiskFile, 9-12
CMDLL, 9-12
CmHostName, 9-13
configuration parameters, defined, 9-2
DEFAULT_HOME, 9-9
DefinedNodes, 9-13
DeviceNic, 9-13
DisplayName, 9-11
editor, 9-2
editor, starting, 5-16
HOME_COUNTER, 9-9
Hostname, 9-10
ImagePath, 9-12
INST_LOC, 9-8
InstanceID, 9-13
Inter-Process Communication, 9-13
IODLL, 9-12
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IPCDLL, 9-12
keys, defined, 9-2
LAST_HOME, 9-9
LOGFILE, 9-11
MissCount, 9-13
modifying values, 9-14
MSHELP_TOOLS, 9-4
NAME, 9-9
NLS_LANG, 9-4
ObjectName, 9-12
OO4O, 9-8
ORA_AFFINITY, 9-6
ORA_CWD, 9-4
ORA_SID_AUTOSTART, 9-4
ORA_SID_PFILE, 9-5
ORA_SID_SHUTDOWN, 9-5
ORA_SID_SHUTDOWN_TIMEOUT,
ORA_SID_SHUTDOWNTYPE, 9-5
ORACLE_BASE, 9-6
ORACLE_GROUP_NAME, 9-6
ORACLE_HOME, 9-6
ORACLE_HOME_KEY, 9-7
ORACLE_HOME_NAME, 9-7
ORACLE_PRIORITY, 9-7
ORACLE_SID, 9-7
OSAUTH_PREFIX_DOMAIN, 9-8
OSAUTH_X509_NAME, 9-8
Password, 9-11
PATH, 9-9
PERF_FILE_NAME, 9-11
PERFORMANCE key, 9-10
PollInterval, 9-13
PublicNames, 9-13
RDBMS_ARCHIVE, 9-7
RDBMS_CONTROL, 9-8
REG_DWORD, 9-3, 9-17
REG_EXPAND_SZ, 9-3, 9-17
REG_MULTI_SZ, 9-3, 9-17
REG_SZ, 9-3, 9-17
REGEDT32, 9-14, 9-16
ServiceName, 9-13
SQLPATH, 9-8
STARTDLL, 9-12
Username, 9-11
using OPERFCFG, 9-23
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reliability, increasing, 6-23
roles
of default accounts, 8-5

S

9-5

Server Manager
replacement, 5-2
service names
multiple Oracle homes, 6-6
services
defined, 7-2
Oracle Object Service, 7-2
Oracle OLAP Agent, 7-3
Oracle OLAP Services 9.0.1.1.0, 7-3
OracleCMan, 7-4
OracleCMService, 7-3
OracleDirectoryService_SID, 7-3
OracleEXTPRC, 7-3
OracleGSDService, 7-3
OracleHOME_NAMEAgent, 7-3
OracleHOME_NAMEClientCache, 7-4
OracleHOME_NAMEManagementServer, 7-4
OracleHOME_NAMEPaging Server, 7-4
OracleHOME_NAMEServer, 7-4
OracleMSCSService, 7-4
OracleMTSRecoveryService, 7-5
OracleNAMES, 7-5
OracleORACLE_HOMECMAdmin, 7-4
OracleORACLE_HOMETNSListener, 7-4
OracleServiceSID, 7-5
OracleSNMPPeerEncapsulator, 7-5
OracleSNMPPeerMasterAgent, 7-5
OraFenceService, 7-5
using, 7-6
Shared server process, 4-9
snap-ins
Oracle Home Configuration, 9-17
Oracle Performance Monitoring, 9-24
SQL*Loader
control file conventions, 5-19
direct path option, 5-18
operating system compatibility, 5-3
preferred tools, 5-5
starting, 5-11

SQL*Plus
operating system compatibility, 5-2, 5-3
preferred tools, 5-5
starting, 5-9, 5-11
SQL*Plus Worksheet
preferred tools, 5-5
starting, 5-9
Start HTTP Server
starting, 5-9
Stop HTTP Server
starting, 5-9
stored packages, Intercartridge Exchange, 10-16
striping disks, 6-23
symbolic links, 6-25
system identifier
multiple Oracle homes, 6-6

T
Task List, 5-24
Task Manager
starting, 5-16
using, 5-22
threads
and Microsoft Management Console, 5-21
and multiple Oracle instances, 4-2
and Oracle services, 7-2
and ORASTACK, 4-5
and shared server process, 4-9
and UNIX processes, 2-7
defined, 4-2
optional and required, 4-3
process errors, A-4
processor affinity, 9-6
scheduling priority, 9-7
TKPROF
operating system compatibility, 5-3
starting, 5-11
tools, starting
Database Configuration Assistant, 5-8
DBVERIFY, 5-10
Event Viewer, 5-16
Export Utility, 5-10
Microsoft Management Console, 5-16
Microsoft ODBC Administration, 5-8

Migration Utility, 5-10
OCOPY, 5-10
OPEFCFG, 5-10
Oracle Administration Assistant for Windows
NT, 5-8
Oracle Data Upgrade Assistant, 5-8
Oracle Directory Manager, 5-9
Oracle Enterprise Login Assistant, 5-8
Oracle Enterprise Manager Configuration
Assistant, 5-8
Oracle Enterprise Manager Console, 5-8
Oracle INTYPE File Assistant, 5-8
Oracle Locale Builder, 5-8
Oracle Migration Workbench, 5-8
Oracle Net Configuration Assistant, 5-8
Oracle Net Manager, 5-9
Oracle Performance Monitor, 5-9, 5-16
Oracle Wallet Manager, 5-9
Pro C-C++, 5-9
Recovery Manager, 5-11
SQL*Plus, 5-9
SQL*Plus Worksheet, 5-9
Start HTTP Server, 5-9
Stop HTTP Server, 5-9
Task Manager, 5-16
TKPROF, 5-11
User Manager, 5-16
troubleshooting
ORA-12560 error, A-26
ORA-28575 error, A-26
TNS-12203 error, A-26

U
UNIX
and Optimal Flexible Architecture, 6-24
and Windows, Oracle9i differences, 2-1
User Manager
defined, 5-23
integration with Oracle9i database, 5-23
preferred tools, 5-5
starting, 5-16
usernames
changing, 8-3
of administrative accounts, 8-5
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UTL_HTTP.REQUEST, Intercartridge
Exchange, 10-17
UTL_HTTP.REQUEST_PIECES, Intercartridge
Exchange, 10-17

W
Web browser
running Oracle Enterprise Manager, 5-13
Web data, Intercartridge Exchange, 10-14
Windows
and UNIX, Oracle9i differences, 2-1
diagnostic and tuning utilities, 5-24
extensions for internet development, 10-5
tools operating system compatibility, 5-4
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